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Abstract

Since the World War II, researchers have tended to develop methodologies and tools to
build and control the development of more and more complex systems and projects. This
inter-disciplinary research area has been called Systems Engineering (SE) and continues to
be developed nowadays. In 1990, the fall of USSR led the US Department of Defense (DoD)
to re-think its defense doctrine and to switch from a one opponent confrontation to a glob-
alization of conflicts with a huge variety of scenarios. Its idea was to re-use and join its
defense systems by producing a huge, decentralized and adaptive defense system that is
composed of existing and independents (complex) systems. This is the apparition of the
System of Systems (SoS) concept. After 2000’s, this concept spreads in civil domains such
as crisis management or logistic systems. More precisely, a SoS is a complex system charac-
terized by the particular nature of its components: these latter, which are systems, tend to
be managerially and operationally independent as well as geographically distributed. This
specific characterization led to re-think research areas of classic SE such as definition, tax-
onomy, modeling, architecting and so on. SoS architecting focuses on the way independent
components of a SoS can be dynamically structured and can change autonomously their
interactions in an efficient manner to fulfill the goal of the SoS and to cope with the high
dynamics of the environment. This PhD thesis mainly focuses on two SoS research areas: 1)
SoS modeling and 2) SoS architecting. To achieve the first point, we propose a new model
called SApHESIA (SoS Architecting HEuriStlc based on Agent). We have used set theory
and ABM (Agent-Based Model) paradigm to define this model that takes into account the
characteristics of SoS. Secondly, we propose a new SoS architecting procedure based on the
Adaptive Multi-Agent System (AMAS) approach that advocates full cooperation between
all the components of the SoS through the concept of criticality. This criticality is a metric
that represents the distance between the current state of a component and its goals. In this
procedure, the SoS architecture evolves over time to self-adapt to the dynamics of the en-
vironment in which it is plunged, while taking into account the respective local goals of its
components. Finally we instantiate this model and this procedure through 4 examples from
different domains (military, logistics and exploratory missions) and validate the feasibility,
the efficiency, the effectiveness and the robustness of the SoS architecting procedure we have
developed and proposed.
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Résumé

Depuis la seconde guerre mondiale, 'ingénierie des systémes a permis le développement de
méthodologies pour controler le développement de systemes et de projets de plus en plus
complexes. En 1990, la chute de I'URSS a provoqué un changement de doctrine militaire
aux Etats-Unis en passant d"une confrontation bipolaire & une mondialisation des conflits
comportant une grande variété de menaces. Sa nouvelle doctrine était de faire collaborer
ses systemes de défense existants pour produire un systeme de défense de haut niveau,
décentralisé, adaptable et composé de systemes indépendants. C’est 1’apparition du concept
de Systeme de Systemes (SdS).

Cette these de doctorat propose un nouveau modele de SdS appelé SApHESIA (SoS Ar-
chitecting HEuriStlc based on Agent), ainsi quune nouvelle méthodologie d’architecture.
Cette nouvelle méthodologie est basée sur une coopération complete entre tous les com-
posants du SdS, lui permettant d’évoluer de lui-méme afin de faire face a des événements
inattendus de son environnement tels que des menaces. Enfin, ce travail est testé a travers 4
exemples issus de différents domaines (militaire, logistique et exploratoire).
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Introduction

Problems to solve have never been so complex. To design useful systems in this context,
designers use more and more often a combination and/or an aggregation of heterogeneous
systems that have been independently designed but are interdependent. The work of this
thesis fits in the intersection between the area of Systems of Systems (S0S) and Adaptive
Multi-Agent Systems (AMAS) and proposes to study what these two fields can mutually
provide to each other.

Context of Study

Modern societies have never been so complex. We experience this complexity more and
more often by the apparition of international issues that are huge threats for mankind: Eco-
nomic crisis as 2008 sub-primes, global response to health threats such as Ebola, global
warming and ethnic violence are a few but modern concrete examples. In "The collapse
of complex societies’ [Tainter, 1988], the author explains a possible consequence of these
threats called "The doom and gloom scenario”. This scenario explains that a society having
reached a certain level of complexity will collapse if it faces huge economic and/or envi-
ronmental changes as the Maya and the Roman civilizations. The author argues that the
complexity of these societies leads to an inflexibility of their structures and consequently an
unsuitability to changes. This "non-adaptation to changes" leads to the collapse of these civ-
ilizations. This inflexibility seems to come from the sophistication that conducts to a huge,
interlocking dependent network of roles and responsibilities unable to change. The author
finishes by writing that the state of our occidental societies is the same that Romans and
Maya ones. The aim is then to avoid this scenario. As [Henshaw et al., 2013] explains, our
societies have two resources that the previous ones did not have: Information Technology
and better knowledge about our world, especially in engineering science. To cope with
and solve these complex problems, science tends to deal with complex systems. As a first
approximation, the difficulty of "understanding" complex systems comes from their own
nature: the interconnections and the mutual influences between heterogeneous parts of the
systems (physical, biological, social, economic and technological) lead to what seem to be
unpredictable phenomena. Research seeks to answer global questions like how to analyze,
design, develop, manage, simulate and use complex systems for the good of our societies
[Baldwin and Sauser, 2009]. One part of this research area is focused on human-made com-
plex systems giving rise to the research area of System Engineering (SE).
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Managing Complexity through System Engineering (SE)

System Engineering (SE) appeared nearly after the World War II, as the academic and
industrial response to the increasing complexity of engineering issues. This complexity
leads to the needs of new methodologies to realize and conceptualize complex systems in
a rational way. The adjective complex (for a system in SE) has the following definitions
(ISO/IEC/IEEE 2010):

(a) An adjective describing a system’s design or code that is difficult to understand because of
numerous components or relationships among components.

(b) An adjective describing a system or component that has a design or implementation that is
difficult to understand and verify.

As an example (of complex systems), military and astronomy science began to think
about huge projects as the Apollo program. In this program, the realization of the lunar
module is a good example of complex system because of the numerous components and in-
terrelations. Its construction led to budget overruns, project management and testing prob-
lems. Then, from the early 50’s to nowadays, researchers from various areas proposed new
methodologies to realize systems in a controlled and efficient way (for example to control
cost and quality of a project or a system). As a result of 50 years of research, SE is well doc-
umented and the creation of the International Council on Systems Engineering (INCOSE) is
nowadays the responsible of its evolution. INCOSE still proposes new processes, models,
methodologies to realize more and more complex systems. Finally, during the last 50 years,
SE has enabled to analyze, manage, realize, and simulate systems by giving interdisciplinary
tools such as processes and methodologies. For INCOSE [BKCASE Editorial Board, 2014], ”
Systems Engineering is an interdisciplinary approach and means to enable the realization of success-
ful systems. It focuses on defining customer needs and required functionality early in the development
cycle, documenting requirements, then proceeding with design synthesis and system validation while
considering the complete problem.”

From Classical Systems Engineering to Systems of Systems Engineering (SoSE)

Early in the SE history, the term system of systems was used but through a theoretical point
of view. The first was [Boulding, 1956] whose idea is to obtain a “spectrum of theories” greater
than the sum of its parts by imagining a “gestalt” in theoretical construction. It is only in 1989
that the Strategic Defense Initiative uses the term System of Systems in its modern sense:
the integration of several existing complex systems to obtain a huge system owning capabili-
ties that are not in the subsystems. The main idea is to switch the point of view of complexity
(in the sense of SE) from the study of one complex system to a network of integrated com-
plex systems. In the 90’s, this change of paradigm in system engineering is confirmed in the
literature: The objective was to address “[...] shortcomings in the ability to deal with difficulties
generated by increasingly complex and interrelated system of systems” [Gorod et al., 2008]. More-
over, [Jamshidi, 2008b] argues that there was “a growing interest in a class of complex systems
whose constituents are themselves complex”. The aim is to “achieve synergy between these inde-
pendent systems to achieve the desired overall system performance”. This change of paradigm in
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Figure 1 — Search And Rescue SoS Example

SE leads to re-think about all its methodologies, tools and processes: this is the beginning of
SoS Engineering (SoSE). SoS Engineering is believed to implement and analyze more effec-
tively large, complex, independent, and heterogeneous systems working (or made to work)
cooperatively. Finally in the early 2000, numerous projects of SoS have proposed to study
different research areas (COMPASS, T-AREA-SoS and so on). As a first example, figure 1
shows a SoS for Search And Rescue (SAR) missions and shows the use of heterogeneous
systems such as commercial vessels, aircraft and satellites integrated together to fulfill SAR
missions. Each individual system has not the ability to do alone its own SAR mission be-
cause of its limited perceptions and action fields, which is the reason why the integration of
these systems in a SoS is important.

Importance of SoS Research

Scientists have already begun to work on new theoretical foundations, new methodologies
and engineering tools to face the complexity of designing in a good way this kind of sys-
tems. After 20 years of research, the study of SoS and all research areas in SoS are still widely
open. In 2008, [Jamshidi, 2008b] argues that “No engineering field is more urgently needed in
tackling SoS problems than SE. On top of the list of engineering issues in SoS is the engineering
of SoS, leading to a new field of SoOSE. How does one extend SE concepts like analysis, control, es-
timation, design, modeling, controllability, observability, stability, filtering, simulation and so on.”
More recently, [Henshaw et al., 2013] referenced 113 research areas: Concept, definition, tax-
onomy, model, methodology of implementation, simulation and so on. They argue that
"The highly, and increasingly, connected nature of modern society means that the existence of SoS
is an unavoidable factor of modern life, driving the need for better techniques to analyze, design for,
manage, and retire SoS and the individual systems that contribute to SoS”. Indeed, all classical

3



Introduction

SE concepts are re-thought to match with new challenges of SoSE. Furthermore, in 2015,
[Axelsson, 2015] argued that even after 3000 papers and 20 years of research: ” [...] there are
signs of immaturity within the research area, with only limited use of systematic empirical methods
those are common in other domains, and also that new research results are not building systematically
on previous research.” Then, current research on SoS focuses on a large variety of problems
[Selberg and Austin, 2008] to develop new methods of engineering or architecting the parts
of the SoS (called component systems).

Generic SoS Model and Dynamic Architecture

Generic SoS models exist but have some limitations concerning their definition of the SoS
environment and the interactions of the component systems.

Concerning [BKCASE Editorial Board, 2014], the challenges in architecting SoS come
from the managerial and operational independence of component systems of the SoS. These
inherited component systems are not designed to fulfill the global goal of the SoS but the
combination of individual component systems can lead to the emergence of unexpected be-
havior. The independence of the component systems leads to re-think the methodologies of
architecting: contrary to SE where the architecting of a system was mostly static, in a SoS
this one is dynamic.

As a first definition, SoS architecting research focuses on how, in an efficient manner, a
SoS can have a dynamic, network-centric and collaborative architecture [Jamshidi, 2008a]
and how the dynamic architecture can lead to the emergence of new capabilities. SoS liter-
ature shows that Agent-Based Modeling (ABM) is a natural way to develop this new kind
of architecture [Azani, 2008] [Caffall and Michael, 2009]. More precisely, ABM and Agent-
Based Simulation (ABS) enable to describe and test new architecture dynamics by varying
the behavior of component systems in the SoS. [Azani, 2008] proposes a set of principles for
efficient SoS Architecting based on open systems such as the Open interface principle stat-
ing that "Open systems have permeable boundaries that allow them to exchange mass, energy, and
information with other systems” or the Synergism principle stating that “that the cooperative
interaction between component systems has a greater effect in their combined efforts than the sum
of their individual parts. Essentially, this is what gives rise to emergence”. Several architecting
methodologies exist but to our knowledge none respects all of these principles.

Contribution

We propose to contribute to the SoS research area by proposing a new generic SoS model
called SApHESIA (SoS Architecting HEurIStlc based on Agent) based on set theory which
takes into account the SoS main characteristics found in literature and extend the notion of
environment and interactions between component systems. We also propose to contribute
to SoS architecting by developing a new SoS architecting heuristic respecting the principles
for efficient SoS Architecting based on open systems such as the Open interface principle
and the Synergism principle and where the interoperability between component systems
is supposed to be achieved. This heuristic, based on a multi-agent approach called AMAS
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(Adaptive Multi-Agent System), uses cooperation between agents enabling them to self-
organize and self-adapt to the dynamics of the environment and where the adequate func-
tionality of the system emerges from the interactions of the agents. Another contribution is
a set of architecting tools based on SApHESIA enabling to test our architecting heuristic on
several applications. As our work is focused on SoS architecting, we evaluated our work on
SoS architecting problems found in literature and self-made problems because no real case
studies with usable data have been found.

Organization of the Document

This thesis is divided in three main parts:

o the first one, related to the state of the art, focuses in a first time on SoS definitions
and existing generic SoS models. We propose a working SoS definition and highlight
limitations about existing generic SoS models. Existing SoS architecting heuristics as
well as their limitations are also presented. Then, a differentiation between classical SoS
simulations and SoS Architecting Heuristic Simulations (SAHS) and existing paradigms
of simulation for SAHS are introduced. Finally, The AMAS approach is presented.

o the second one, related to the contribution, presents in a first time the new generic
SoS model (called the SApHESIA model) we have defined to fulfill the limitations ad-
dressed in the state of the art. Then, our new SoS architecting heuristic based on coop-
eration between component systems is exposed. Finally, the SApHESIA procedure we
implemented for SAHS is presented.

o the last one, related to the evaluation of our contribution, first presents the simulation
of a SoS problem called the Missouri Toy Problem to evaluate if our heuristic is able
to solve it. Then, an experimentation concerning an UAV obstacle avoidance system
is exposed to compare our approach with satisficing games that are the basis of the
SoS collaboration formation (another SoS architecting heuristic presented in the state
of the art). Experimentation about SoS coupling is introduced through the coupling
of the two first experimentations. Finally, the last chapter presents the problem of the
criticality adaptation and proposes an algorithm to solve this issue.

Finally, we end this document by concluding our work and presenting perspectives.







Part I

State of the Art






SoS Definitions and Existing
Generic SoS Models

This first chapter presents the foundations as well as the concepts used in this thesis. More
precisely, the aim of this chapter is triple: (i) to enable the reader to understand what a SoS
is; (ii) to propose a SoS definition useful for our work; (iii) to present and discuss about
existing generic SoS models.

In this way, we will focus in a first part on SoS literature concerning definitions and char-
acterizations. This part is needed because a lot of different SoS definitions have been given
during the last 20 years and at this time no definition of SoS is widely accepted. After the
presentation of existing summaries and reviews of these definitions, we propose a working
definition of SoS that will be a basis for this thesis work. During this first part, several other
concepts that have not consensual accepted definitions are also presented.

Then, this chapter proposes a state of the art about generic SoS models and their lim-
itations. The presentation of generic SoS models is needed because they are the basis of
SoS architecting heuristics. The limitations are exposed through evaluation criteria we de-
fined thanks to the proposed definition of SoS of the first part. These limitations serve as
arguments to propose a new generic SoS model introduced in chapter 5 of this document.

1.1 Main Characteristics, Classifications and Definitions of SoS

As written in the introduction, concepts of SoS and SoSE (SoS Engineering) appeared when
Systems Engineering (SE) focused on how to interconnect a group of more or less indepen-
dent complex systems to fulfill a higher goal. Then, first research works have consisted in
collecting real cases of SoS and trying to find a general definition as well as a taxonomy
attached to this concept. Unfortunately, no consensual definition of SoS exists nowadays.
Indeed, a lot of definitions has been given by many authors coming from different areas
[Jamshidi, 2008b], [DoD, 2006], [CARLOCK and FENTON, 2001], [Manthorpe, 1996]. Some
of them are not coherent with each other and sometimes too domain specific or unclear.
Then, these definitions do not enable to propose a generic definition and common char-
acteristics of SoS. Thus, research efforts have been put on SoS taxonomy and theoretical
foundations for finding a generic definition by:

o analyzing case studies and trying to sum up what are the SoS main characteristics
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[Maier, 1998];

o collecting and trying to generalize existing definitions [Jamshidi, 2008a];

o analyzing SoS literature and finding generic SoS  properties
[Boardman and Sauser, 2006].

In this section we propose an overview of the main research about definitions and charac-
teristics of SoS.

1.1.1 Main Characteristics of SoS

Maier in [Maier, 1998] was the first to characterize SoS by giving five main characteris-
tics, accepted by researchers working on SoS ([Jamshidi, 2008a],[Selberg and Austin, 2008]),
whose distinguish a SoS from a traditional complex system. The first two characteristics are
expressed in this definition: "A system-of-systems is an assemblage of components which indi-
vidually may be regarded as systems, and which possesses two additional properties: (1) manage-
rial independence of the components and (2) operational independence of the components.”
Then, through some examples, Maier finishes by giving the last three characteristics : the
geographical distribution, the emergent behavior and the evolutionary development pro-
cesses.

The operational independence means that a component system removed from the SoS con-
tinues to operate independently (i.e., it can continue to work even if it does not belong
anymore to the SoS).

The managerial independence means that the component systems are managed by inde-
pendent users: “ [...] the component systems not only can operate independently, they do operate
independently” [Maier, 1998]. In other words, a component system takes its own decisions
concerning what it has to do.

The geographical distribution, has no strict definition in literature. But this characteristic
exists because the nature of the interfaces between components is not the same in a SoS than
in a classical system. In a classical system, components are less geographically distributed
enabling a tight coupling through “power, material as well as communication interfaces with lim-
ited bandwidth and delay issues” [Maier, 1998]. In a SoS, the geographical distribution disables
material and power interfaces between component systems.

The emergent behavior of the SoS is defined as the production (at the SoS level) of an over-
all behavior which was not implemented (and so not predicted) in the component systems.
As an example, Maier gives the Internet : "The Internet exhibits a rich set of emergent behaviors
represented by the complex distributed applications that run on top” [Maier, 1998].

Finally, the evolutionary development is defined as a dynamic development that takes care
and integrates the changes (of structure, of use and so on) that occur within the SoS during
time. For example, it can be the change of communication processes such as, with the same
example of the Internet, the change from the IPV4 protocol to the IPV6 one.
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1.1.2 SoS Classification

Maier also proposes a classification of SoS [Maier, 1998] that has been extended by Dahmann
and Baldwin in [Dahmann et al., 2009]. This classification lays on the existence and the coer-
cive power of a central management. If this one exists, it is presented as "the head" of a SoS.
The term coercive power represents the degree of subordination of a component system in
a SoS: a strong management power means a strong subordination of component systems.
Generally, when a central management exists, it defines the SoS objectives and component
systems have to fulfill them. This classification is explained in the following paragraphs,
going from the one with the most centralized management to the less one.

Directed SoS: The SoS has been created to fulfill a clearly established goal and component
systems are totally subordinated to the SoS. A directed SoS is fully centrally managed by the
stakeholders of the SoS (i.e., persons who own the SoS). Component systems have always
the possibility to operate independently, but their normal operational mode is subordinated
to the central managed purpose, even if the stakeholders of the component systems have
their own objectives. It implies that component systems can operate for the SoS at their own
detriment (i.e., against their own objectives).

Acknowledged SoS: The component systems and the SoS have their own objectives and
their own defined resources (human, raw materials,...). SoS tends to fulfill its objectives by
leveraging functionalities of component systems or changes that may be, for example, the
addition of a new functionality. The participation of a component system to the SoS is based
on cooperative agreements between the SoS and the component system. These cooperative
agreements can be based, for example, on resource sharing. Modern military operations are
often instantiated with this type of SoS.

Collaborative SoS: The collaborative SoS has no centralized objective but component sys-
tems share a common interest and are voluntarily governed to support this interest. If a
central management organization exists, this one has no coercive power on component sys-
tems. Finally, the belonging of a component system to the SoS is often negotiated between
the component system and the SoS. For example, the IETF (Internet Engineering Task Force)
is a group of scientists, industrialists, academics having a common interest: to build an effi-
cient structure to develop their activity (the Internet). In this way, they work on and propose
standards but IETF has no power to enforce these standards.

Virtual SoS: The SoS has neither central management nor central purpose. A large scale
behavior can emerge (and may be desired) and the SoS must rely on shared mechanisms
between component systems to maintain it. As an example, Maier [Maier, 1998] gives the
World Wide Web: “the control has been exerted only through the publication of standards for re-
source naming, navigation, and document structure. Web sites choose to obey the standards or not
at their own discretion”.

It appears that this classification is related to the degree of component systems inde-
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Directed | Acknowledged | Collaborative | Virtual
Central management existence ++ ++ + --
Central management power ++ + - -
Component systems autonomy - + ++ ++
Clear objective at SoS level ++ + - -
Large-Scale behavior emergence - - + ++

Table 1.1 — Classification summarization of SoS

pendence (also called autonomy) from SoS. In a directed SoS, component systems have less
autonomy than in a virtual one. More generally, the classification of SoS types can be char-
acterized with the following properties:

o the existence of a central management for the SoS;
o the subordination of component systems to this central management;

o the component systems autonomy which is the capacity for a component system to
decide itself for itself;

o the definition of a clear objective at the SoS level;

o the emergence of a large-scale behavior.

Table 1.1 summarizes the types of SoS according to the presented properties. The legend
means that the evaluation criterion for the type is totally present (++), almost totally present
(+), almost totally absent (-), totally absent (- -).

This classification is important for the study or the creation of SoS architecting heuris-
tic. The notion of SoS architecting heuristic, developed in chapter 2, can be briefly defined
here as finding how component systems can work together by changing their interactions to
tulfill the SoS goals with effectiveness (i.e., adequate to accomplish the SoS goals) and effi-
ciency (i.e., functioning in the best possible manner with the least waste of time and effort).
Proposing an architecting heuristic for a directed SoS is not the same work than for a collab-
orative one, because the existence of a central management between a directed SoS seems to
forbid the use of a total decentralized decision heuristic. As another example, [Maier, 1998]
presents the consequences of a misclassification of a directed SoS into a collaborative one:
the persons representing the central management of the SoS can take decisions that may not
have the expected effects because of a lack of coercive power.

This classification shows that the SoS study is a difficult issue: a SoS can (or not) have a
central management, the component systems are managerially and operationally indepen-
dents but at the same time they can be subordinated to the SoS central management. This
classification makes harder the choice of a SoS model and a SoS architecting heuristic.
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1.1.3 Existing Definitions of SoS

In 2010, Crossley [Crossley and Professor, 2004] distinguished the notion of SoS from the no-
tion of Family Of Systems (FoS) found in Department Of Defense (DoD) documents. A SoS
is “a set or arrangement of interdependent systems that are related or connected to provide a given
capability.” A family of systems is “a set or arrangement of independent (not interdependent) sys-
tems that can be arranged or interconnected in various ways to provide different capabilities.” But
this distinction is not really applied in the main literature of SoS. For example, in another
DoD document of 2006 [DoD, 2006]: “Finally, this study did not include Family of Systems (FoS)
because these too are not well defined, and have their own varying characteristics to that of a SoS”.
In the same document, 32 definitions of SoS are given. These definitions come from differ-
ent sources: journals, conference proceedings, academic studies, industry studies and so on.
We will not give here all of them but this consequent number leads to an important conclu-
sion: SoS definition depends on the current needs of the person who gives the definition.
Jamshidi has the same conclusion after a survey and a discussion on the 6 following defini-
tions in [Jamshidi, 2008a]. These definitions concerns SoS, SOSE and Enterprise SoS, which
are strong related notions. In his paper, he argues that “the field has a large vacuum from basic
definition, to theory, to management and implementation”. This work enables to have a large
view of the SoS paradigm.

Definition1 Systems of Systems exist when there is a presence of a majority of the follow-
ing five characteristics: operational and managerial independence, geographic distribution,
emergent behavior, and evolutionary development [Jamshidi, 2008a].

Definition 2 Systems of Systems are large-scale concurrent and distributed systems that
are comprised in the class of complex systems [CARLOCK and FENTON, 2001].

Definition 3 Enterprise Systems of Systems Engineering is focused on coupling traditional
systems engineering activities with enterprise activities of strategic planning and invest-
ment analysis [CARLOCK and FENTON, 2001].

Definition 4 System of Systems Integration is a method to pursue development, integra-
tion, interoperability, and optimization of systems to enhance performance in future battle-
field scenarios [R.S, 2000].

Definition 5 SoSE (SoS Engineering) involves the integration of systems into sys-
tems of systems that ultimately contribute to the evolution of the social infrastructure
[Lukasik, 1998].

Definition 6 In relation to joint war-fighting, system of systems is concerned with
interoperability and synergism of Command, Control, Computers, Communications,
and Information (C4l) and Intelligence, Surveillance, and Reconnaissance (ISR) Systems
[Manthorpe, 1996].

13



SoS Definitions and Existing Generic SoS Models

Definition 1, the most generic among the six, is based on Maier characteristics, but is
very poor: it gives little information about component systems and the environment. Are
the component systems tends to be complex or not? What about the dynamics of the envi-
ronment?

Definition 2 considers a SoS as a complex system. In this context, complex has to be under-
stood as “an adjective describing a system or component that has a design or implementation that
is difficult to understand and verify (ISO/IEC/IEEE 2010)”. But once again, component systems
complexity is not addressed and he describes component systems as concurrent systems.
Concurrent is not used in the SoS literature. For example, Maier in [Maier, 1998] defines
component systems behavior as cooperative. Even if the term cooperation is not defined,
this behavior seems semantically far from the notion of concurrence.

Definitions 3, 4 and 5 do not directly concern SoS. Definition 3 only deals with Enterprise
SoSE, it is then a really domain specific definition. Definition 4 mentions the SoS integration
which is a phase of SoS development applied in military area. Definition 5 concerns the
already presented notion of SoSE. Definition 6 is a military oriented SoS definition contex-
tualized by joint war-fighting that is a problematic of the 90’s of the US defense focusing on
how to use efficiently different independent systems in a global joint force.

Each definition has its own specificity, but all of them are too domain specific and do not
enable to generalize SoS. Thus, Jamshidi proposes a definition that received a substantial
attention: "A SoS is an integration of a finite number of component systems which are independent
and operable, and which are networked together for a period of time to achieve a certain higher goal.”

This definition is generic because there is no reference to any particular domain. Nev-
ertheless, this definition seems to be incomplete: there are few details about component
systems and the environment the SoS evolves in. The next sections analyzes the characteri-
zation of SoS in order to improve this last definition.

1.2 Characterization of SoS

Another approach to define SoS is to find their generic characteristics. Indeed,
Gorod in [Gorod et al., 2008] argued that a characterization is more optimal to under-
stand, study and model SoS. But, as for SoS definitions, different authors as Sauser
[Boardman and Sauser, 2006] and Bjelkemyr [Bjelkemyr et al., 2007] argued that there is no
consensus of what the main characteristics of SoS are: some authors use and expand
the characteristics of Maier, some others do not. Nevertheless, there have been some
convergences between these characterizations. In this way, [Boardman and Sauser, 2006],
[Baldwin et al., 2015] and [Bjelkemyr et al., 2007] propose a review of SoS literature and pro-
pose characteristics to distinguish SoS from classic systems.

1.2.1 ABCDE Characteristics

In [Boardman and Sauser, 2006], authors extract from analysis of the SoS literature five main
characteristics used to reason about the differences between classical systems (composed of
parts) and SoS (composed of component systems) through these characteristics. These are
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the ABCDE ( Autonomy, Belonging, Connectivity, Diversity and Emergence) characteris-
tics:

Autonomy is a characteristic derived from the operational and managerial independence
of Maier. It refers to the independence of the systems from each other and from the SoS itself.
Authors argue that most of the time parts of classical systems do not have autonomy on their
own, or if they have, they do not use it and fully serve the autonomy of the classical system.
For example, a brake in a car has no autonomy by itself. The specificity of a SoS, concerning
autonomy, is that the component systems are autonomous and use their autonomy in order
to fulfill the goal of the SoS.

Belonging of a component system is a characteristic representing the balance between
its Autonomy and the loss of a part of its independence for the benefit of the SoS goals.
It is also the ability to accept assistance from others component systems and the need
to make a valued contribution to the goals of another component system. Then, the
parts of a classical system belong totally to it as “family members belong to the same family”
[Boardman and Sauser, 2006]. Once again, a car brake belongs to a given car and cannot be
used in another one. In SoS, component systems have the choice to belong or not to a SoS
by negotiating and evaluating what the belonging can give to fulfill their own purpose. The
existence of belonging negotiation depends on the SoS type. For example, a directed SoS
directly decides the belonging of a component system (i.e., the SoS central management).

Connectivity is the “capability to form connections as needed to benefit the entity” (meaning
here a component system) [Boardman and Sauser, 2006]. In classical SE (Software Engineer-
ing), it is a golden rule to hide huge connectivity between parts by merging them to reduce
connectivity between major parts of the classical systems. In SoS, connectivity is chosen by
component systems and evolves during time contrary to classical systems that have static
connectivities between parts.

Diversity references the notion of variety in a system. Variety is a direct reference to the
law of requisite variety of Ashby [Ashby, 1956]: to maintain its stability, a system must have
a level of variety as least equals to the variety of the environment (the outside of the system)
it evolves in. This variety enables to respond to “rampant uncertainty, persistent surprise and
disruptive innovation” [Boardman and Sauser, 2006] (i.e., the changes in the environment).
Diversity is related to the notion of heterogeneity. In classical systems, a good practice in SE
consists in reducing it through the principle of parsimony, also called Occam’s razor. The
aim is to reduce as much as possible diversity in a system in order to reduce redundancies,
ambiguities and inconsistencies. In SoS, this diversity is a desired characteristic because
the more diversity in a SoS the more it can cope with the dynamics of the environment.
Diversity can be increased for example, by adding new component systems into the SoS.

Emergence means the apparition of phenomena or sophistication in a system that is not
issued from the simple sum of its parts. Steve Johnson in [Johnson, 2001] reports emergence
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Element Classical System System of Systems

Autonomy | Parts of the system have no auton- | Autonomy is exercised by compo-
omy or have ceded it in order to | nent systems in order to fulfill the
grant autonomy to the system. purpose of the SoS.

Belonging Parts are akin to family members; | Component systems choose to be-
they did not choose themselves but | long on a cost/benefits basis; also
came from parents. Belonging of | in order to cause greater fulfillment
parts is in their nature. of their own purposes, and because

of belief in the SoS purpose.

Connectivity | Prescient design, along with parts, | Dynamically supplied by compo-
with high connectivity hiddeninel- | nent systems with every possibil-
ements, and minimum connectivity | ity of myriad connections between
among major subsystems. component systems, possibly via a

net-centric architecture, to enhance
SoS capability.

Diversity Managed, ie., reduced or mini- | Increased diversity in SoS capabil-
mized by modular hierarchy; parts” | ity achieved by released autonomy,
diversity encapsulated to create a | committed belonging, and open
known discrete module whose na- | connectivity.
ture is to project simplicity into the
next level of the hierarchy.

Emergence | Foreseen, both good and bad be- | Enhanced by deliberately not being
havior, and designed in or tested | foreseen, though its crucial impor-
out as appropriate. tance is, and by creating an emer-

gence capability climate, that will
support early detection and elimi-
nation of bad behaviors.

Table 1.2 — Classical systems vs SoS [Boardman and Sauser, 2006], [Baldwin et al., 2015]

to be “the movement from low-level rules to higher-level sophistication”. Classical systems tend
to show foreseen emergent behaviors (i.e., behaviors that can be determined by specifying
interactions among constituent systems [Benites Gongalves, 2016]). In SoS, the aim is to cre-
ate conditions where both foreseen and unforeseen emergent behaviors (i.e., behaviors that
are unplanned and can dynamically appear during SoS operation [Benites Gongalves, 2016])
appear to cope with the dynamics of the environment.

This characterization enables to strongly distinguish classical systems from SoS. Table
1.2 from [Boardman and Sauser, 2006] and [Baldwin et al., 2015] sums up this distinction be-
tween classical systems and SoS through these ABCDE characteristics. The SoS literature
analysis and the definition of the five characteristics are a huge effort to propose a generic
vision of what a SoS is. Nevertheless, little information addresses the environment the SoS
evolves in: how it can be defined? What are the characteristics of this one? Concerning the
component system, what is the level of complexity of this one compared to the SoS?
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1.2.2 Characterization through SoS Concept Maps

To improve understanding of SoS, [Bjelkemyr et al., 2007] proposed a concept map showing
to discriminate: Complex Systems, Non-Complex Systems, Non-SoS Complex Systems
and SoS.

According to his opinion, these four classes enable to classify any system. The main
criterion for this classification is “the degree of exhibition of complex properties”. These com-
plex properties are composed of the 5 Maier’s criteria defined in section 1.1.1 (Managerial
and operational independence of component systems, geographical distribution, emergent
behavior and evolutionary development of the SoS) and completed by the notions of het-
erogeneity of the component systems, networking and trans-domain. Concerning hetero-
geneity, author defines it as component systems that are “of significantly different nature,
different elementary dynamics that operate on different time scales.” Concerning networking, au-
thor writes that “networks define the connectivity between independent systems in the SoS through
rules of interaction.” Trans-domain property means that an effective study of SoS requires
unifying knowledge across fields of study: engineering, economy, policy, and operations.

These properties enable to distinguish Complex Systems from Non-Complex Systems: a
Non-Complex System does not exhibit complex properties, has clear boundary and purpose,
instead of a Complex System that must display some of these properties. Then, Complex
Systems can be divided into Non-SoS Complex Systems and SoS Complex Systems (or
simply SoS). A Non-SoS Complex Systems exhibits a few of complex properties and a SoS
exhibits most of them. Finally, a SoS is composed of Non-S0S Complex Systems (i.e., not
recursively composed of SoS). Authors argue that component systems can show complex
properties but have not the same level of complexity than the SoS. Once again, we can point
out that the SoS environment is not defined, not even addressed.

Finally, Gongalves in [Gongalves et al., 2014] extends the concept map by developing no-
tions contained in the concept map of [Bjelkemyr et al., 2007] and adding new ones com-
ing from the definitions presented before. The emergent behavior (that is not developed
in [Bjelkemyr et al., 2007]) of the SoS comes from the cooperation between the component
systems through their ability to connect with each other thanks to their operational inde-
pendence. The environment of the SoS exists but is not developed. Gonzales introduces
also the concept of Software-Intensive System of Systems (5iSoS) that is a subclass of SoS
where component systems are strongly composed of software. This notion of SiSoS will not
be reused in the rest of the document because we want to propose the most generic SoS
model as possible.

1.3 Working Definition of SoS

Up to the end of this document, we propose the following working SoS definition which
sums up what we found in the literature. We try to be as close as possible to existing defini-

17



SoS Definitions and Existing Generic SoS Models

/( Nodes

; connecfed_with
/ ‘
System | .
! hasiw  Links —{ Operational Independence ‘

has

has_clear_ 4 >
boundary .
( -y B2 is_a —— Managerial Independence |
1 ™~
Non-Complex Complex P ——
\ﬂ Sater g 4‘ Geographic Distribution ‘
exhibits T N —{ Heterogeneity \
Y is_a Is_a
lL / E P
Clear k Non-SoS p—y | Trans-Domain |
Purpose \ Complex Systems
\ System (SoS) ) : :
\_\ ~ L is_a —{ Evolutionary Behavior |
\ exhibit_some ; .
s [ e Boundary —{ Emergent Behavior |
exhibit_no|  exhibit most | complex
4 ‘ ' /_/JS—a Property —{ Network |
Complex S Internal is_an
Property —1s_a Complex - !
Property
Figure 1.1 — Concept map of a SoS [Bjelkemyr et al., 2007]
|'I _________________________________________________________
|
I P ISO/NEC/IEEE 42010 !
Architecture :
:: Raliposs International Standard |
il Stakeholder AN I
|
I
|
: —mquum34)| Evolutionary development |
: Cnnsti'l.ulent system h 31[ SoS category Collaborative |
: stakeholder ‘ ’ 808 stakeholder ‘ ACCor inﬁu:nces Acknowledged
| E .
(= -
: has interests in has interests in
|
| | individual mission | | Global mission i
| 1 . ; Software o
: ; dominance uﬂmesj enauies
| . g Software
: contributes to 5 influences T drives
i z
| accomplist : O’F:\siliuent |systen:|r s influences
: is gelogfaphimﬂ enables
: Ope! | ind dence ||< pakizes has Connectivity SiSos
[ - i Conceptual
: Managerial independence Il’ ha: 5 a3 fovel Model
|

Figure 1.2 — Concept map of a SiSoS [Gongalves et al., 2014]

18 Teddy Bouziat



1.4. Existing Generic SoS Models

tions and characterizations:

A SoS is a system composed of systems (called component systems) that tends to be complex
and tend to evolve in a dynamic environment. A SoS can have a central management with
its own objectives and can use subordination to force component systems to act as desired.
Component systems and SoS have the Maier characteristics:

o operational and managerial independence of the component systems (also called the
autonomy of a component system);

o geographical distribution of the SoS;

o interactions and cooperation of component systems tend to provoke emergent behavior
at the SoS level;

o evolution of the SoS during time: interactions are dynamics and enable openness (com-
ponent systems can join or leave the SoS at runtime).

Component systems tend to be less complex than the SoS they evolve in, but can show com-
plex properties such as operational and managerial independences. Component systems
tend to be heterogeneous in terms of capabilities (i.e., actions) from each other and interact
with each other through their capabilities or their environment. The belonging of a compo-
nent system to the SoS depends on the type of the SoS. In a directed SoS, the central man-
agement chooses if the component system belongs to the SoS. In an acknowledged SoS, this
is a mutual agreement. In collaborative and virtual SoS, the existence of interactions defines
the belonging of a component system to the SoS. The SoS tends to show emergent behaviors
that can be foreseen or not. The emergent behavior is enabled by the cooperation of the
component systems through their interactions. The environment in which the SoS evolves
is dynamic and composed of systems (not own by the SoS) that work independently from
the SoS and may have concurrent objectives from the SoS ones. If a SoS represents a firm
and its suppliers, the environment can be, for example, composed of concurrent firms.

1.4 Existing Generic SoS Models

As explained in the introduction, finding a generic SoS model is the basis to propose a new
SoS architecting heuristic. Firstly, this section enumerates and justifies the evaluation criteria
chosen from literature to evaluate generic SoS models. Secondly, it presents two generic SoS
models found in the literature and discusses their limitations.

1.4.1 Evaluation Criteria for SoS Model

We propose nine criteria to model SoS to evaluate existing generic SoS models and show
their limitations. The five first criteria concern the ability to model the following character-
istics of a component system (that represent the Maier’s criteria):

1. Heterogeneity;
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2. Managerial independence;
3. Operational independence;
4. Geographical distribution;

5. Interactions between component systems.

Finally, the following criteria concern the ability to model the SoS and the environment:

6. SoS model: it concerns the ability to model SoS as an autonomous entity with its own
goals. Indeed in Directed or Acknowledged SoS, a central management exists and has to
be modeled.

7. Dynamic environment model: it concerns the ability to model a dynamic environment.
It has been chosen because a SoS evolves in a dynamic environment.

8. Global expressiveness: it concerns the ability to express interesting problems. It has
been chosen because a model has to be expressive enough to model interesting SoS. For
instance, it is better if a model allows to model precise examples. In other words, a too
simple model will fail to model concrete and interesting examples.

9. Metric definitions: it concerns the ability to define useful metrics such as for example,
the global cost or the performance of the SoS. A model has to enable the evaluations of
instances created with it.

1.4.2 The Basis of Generic SoS Model: Agent-Based Model Paradigm

As existing generic SoS models are based on Agent-Based Model, this section introduces
this paradigm. [Bonabeau, 2002] defines ABM as a kind of model uses to describe the sys-
tem as a collection of entities called agents. In [Gilbert, 2008], an ABM can be defined as
a computational method that enables a researcher to create, analyze, and experiment with models
composed of agents that interact within an environment. In [Squazzoni, 2012], agents can contain
heterogeneous variables, parameters, and behavior. Agents could interact by exchanging informa-
tion and via communication protocols, and can react to the environment, learn, adapt, and change
rules of behavior. Modelers can therefore equip computational agents with cognitive and behavioral
properties typical of human agents, while the environment (i.e., social structures and institutions)
can be programmed to mimic the real social world in varying degrees of detail. Then, each of these
agents is able to make its own decision from its behavior, the knowing of its situation and
its environment. The decision of an agent leads to interactions with other agents or with its
environment. The behavior ranges from simply reactive behavior to cognitive one.

The natural vision of SoS as a set of component systems linked to fulfill a higher goal is
close to the ABM paradigm. For example, the notion of managerial independence of a com-
ponent system is really close to the decision autonomy of an agent. The notion of operational
independence of component system is close to the autonomy of action of an agent. Finally,
interactions between component systems (such as information or resources exchanges, pro-
viding services and so on) can be modeled by interactions between agents. Indeed, in ABM,
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SoS ABM
Parts Component systems Agents
Autonomy of the parts X (Managerial and operational) X
Dynamic interactions between parts X X
Complexity of the parts X X
Heterogeneity of the parts X X
Important notion of environment X X

Table 1.3 — Concepts similitude between SoS and ABM paradigm

an agent has the ability to perceive, to communicate and to exchange information with other
agents. It is clear that ABM paradigm is a natural way to model SoS. These similarities of
concepts (summed up in table 1.3) explain why ABM has been used to study SoS and pro-
pose new ways to architecture them. The following sections focus on 2 generic models based
on ABM.

1.4.3 Existing Generic Model for SoS

There are a few generic SoS models in literature. Based on set theory and ABM, the following
models enable to have formal definitions of what is a SoS. Nevertheless, we discuss their
limitations through the evaluation criteria defined in section 1.4.1.

a) Generic Model of SoS Based on Set Theory

This model, introduced in [Baldwin and Sauser, 2009], uses set theory and first or-
der logic. It has been created to model the five keys characteristics developed in
[Boardman and Sauser, 2006] (see section 1.2.1) that are Autonomy, Belonging, Connectiv-
ity, Diversity and Emergence. In this model, a component system S; is defined as a tuple:

Si - {Ai/ Gi/ El}
with:

o A;, asetof actions;
o G;, aset of goals;

o E;, a set of non-defined elements.

Aj, G; are sets of atomic elements. There is no detail about what are exactly these el-
ements but they represent respectively the available actions and the goals of a component
system. E; is a set of undeclared elements where a subset C; C E; (called the set of connectiv-
ities and composed of couples of component systems) represents the connections between
component systems.

Finally, a system of systems Sx is defined as a set of sets:
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Sk ={S1,...,5,Gx},n € N,Gx # QD
With :

o G is the set of the SoS goals;

o S1,.., Sy are component systems.

With this model, some metrics [Baldwin and Sauser, 2009] are used to proportion the
level of the main characteristics presented in section 1.2.1: Autonomy, Belonging, Connec-
tivity, Diversity of each system (Emergence and Connectivity being not represented). The
level of autonomy of S; is defined as :

Autonomy; = | A

The justification of this definition is that if a system wants to fulfill its own goals, a system
has to have the most actions as possible (i.e., the more actions a component system has, the
more autonomy it has).
Belonging of a component system in a SoS represents the balance between autonomy and
the loss of a part of its independence for the benefit of the SoS Goal (section 1.2.1). Then, the
belonging of a component S; to the SoS S is defined as:

— [f(A)NG+|

Belonging; = STAT

Where:
f:A = Gx|(Vge Gx)(3A; € S;)(Fa e A)(f(a) =g)

f(A;) represents the goals of Sk for which S; is able to contribute with its actions A;.
Belonging is then represented by the proportion of what the component system can do for
the SoS. More the component system can achieve SoS goals through its actions, the more it
belongs to the SoS. Then, this result is normalized with the number of actions of S; (| 4;|).
Finally, the level of belonging is high when actions of S; tends to fulfill SoS goals.

Thus, authors define a metric on the Diversity of a SoS with all the different sets of available
actions A; of each component system i (i € Z*). This following definition ensures that the
A; have multiple elements and they are different from each other:

Diversity = A; # QN |Aj| > 1,i € Z*

b) Agent-Based Wave Model

In [Acheson et al., 2012], authors propose a generic SoS model based on ABM, which enables
the use of a formation heuristic based on a genetic algorithm. In this model, each component
system S; is defined as a set of sets:
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S: = {ci, pi, willingness;, ability;}
With :

& ¢;, a capability, which is similar to an action;
o pi, a performance on the capability c;;
o willingness;, a metric representing the willingness of S; to cooperate with the SoS ;

o ability;, a metric representing the ability of S; to cooperate with the SoS.

willingness; and ability; are used in a function f that is not described but that enables to
know if S; will cooperate with the SoS (i.e., if the component system will belong to the SoS
or not). Then, a component system with a high ability; tends to be more cooperative with
the SoS.

A SoS is represented by :
SoS ={C, W, P}
With:

o C, a set of desired capabilities c;;
o W, a set of weights concerning the set of desired capabilities C;

o P, a set of desired performances on capabilities in the set C.

Desired capabilities are the capabilities that designer wants the SoS to achieve. It is com-
posed of a subset of component systems capabilities. The P set enables to express a certain
level of desired performance on desired capabilities C for the SoS. As an example, let’s pre-
tend that one of the SoS objectives is to have the capability c3 with a performance of 80%.
Then, it can be modeled by adding c3 in C and p3 = 0.8 in P. W contains weight w; on
capabilities modeling the willingness for the SoS to have a capability c; (i.e., if w; is high, c;
is highly wanted by the SoS).

The environment is slightly addressed and detailed by a set of external factors such as SoS
funding, Threats and National priorities. These factors do not have formal descriptions. Even if
it is not explicitly written in [Acheson et al., 2012], SoS funding seems to model the amount
of funds allowed by stakeholders for the SoS functioning. This fund is used to be compared
with the global cost of the SoS, which seems to be the sum of component systems costs (the
information of how these costs are modeled is not given). Finally, there is no example of use
of threats and national priorities factors.

¢) Discussion

The first generic model enables to model a component system through the set S;. The con-
cept of heterogeneity is represented thanks to the set of actions A; that can be different
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from component systems. Operational and managerial independences are respectively rep-
resented by A; and G;. But, the concept of action is not used and not really described to be
used in an example. An action is presented as being just an "object” without a clear defini-
tion on how to use it. The set of connections C; enables to model interactions. Nevertheless,
connections are only links with another component system and are never used, for example,
in metric definitions. Moreover, it is a totally generic model and it enables to calculate met-
rics as autonomy, belonging, and diversity of a component system. It is useful to know the
level of diversity of a SoS because the most a SoS shows diversity, the most it can cope with
the dynamics of the environment. Then, a SoS model is presented but there is no environ-
ment model and this is a strong limitation because a SoS evolves in a dynamic environment.
Concerning global expressiveness, the model is poor because the action is represented with-
out the notions of preconditions and/or effects of an action. Then, there is no possibility to
model action dependence between component systems.

Concerning the Agent-Based Wave model, it enables to model component system through
its operational independence (through capability) but fails with managerial independence
because goals are not defined for component systems. Nevertheless, the model may use
metrics to evaluate SoS like the performance to reach (through P;). Concerning global ex-
pressiveness, each component system is reduced to only one capability, which seems far
from the reality of the SoS where each component system has several capabilities. This
model does not enable to model interactions between component systems. Even if an envi-
ronment is defined, it is not possible to express its dynamics. Indeed, there is no possibility
of expressing dependencies between the actions of the component systems.

Finally, Table 1.4 sums the whole criteria for both models. The legend is the following: the
evaluation criterion for the model is totally filled (++), almost partially filled (+), almost
partially absent (-), totally absent (- -).

The two SoS models presented here have a lack concerning their realism and overall fail
concerning our evaluation criteria. Especially the set theory model seems hard to use to
study real cases of SoS because of a lack of expressiveness. Furthermore, the interactions
between component systems in both models are not used and the notion of environment is
not mentioned (or not dynamic). This analysis leads us to propose a new generic SoS model
to fill these lacks.
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Generic set theory model | Based Waved Model

Component system heterogeneity ++ +
Managerial independence ++ -
Operational independence ++ ++

Geographical distribution -- --

Interactions between component systems - --

SoS model ++ ++

Dynamic environment model -- -

Global expressiveness - -

Metric definitions + +

Table 1.4 — Evaluation of existing generic SoS model
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Existing Architecting Heuristics
and Simulation Tools for SoS

In the previous chapter, we have presented the notion of SoS through existing definitions
and characteristics with a focus on two generic SoS models. This chapter introduces the
notion of architecting heuristics for SoS and how to simulate them. In this way, this chapter
focuses on:

o enabling the reader to understand what the notion of SoS architecting is;
o presenting chosen criteria to evaluate existing SoS architecting heuristics;
o studying the existing SoS architecting heuristics through evaluation criteria we define;

o presenting the notion of SoS Architecting Heuristic Simulation (SAHS).

In this way, the first part focuses on the definition of SoS architecting. Then, a selection
of SoS architecting evaluation criteria are presented and justified. Then, two architecting
heuristics are presented and discussed, chosen because they rely on generic SoS models.

Concerning SAHS, after a general introduction to simulation in computer science, the
main challenges about SoS simulation are discussed. Then, the chapter focuses on SAHS
and evaluation criteria will be extracted from this analysis. At a first time, these criteria
are classified in two classes: according to their usefulness for SoS simulation and for SAHS.
Then, these chosen SAHS criteria are used to evaluate existing tools for SAHS. Finally, a
discussion highlights the scientific limitations that will be handled in the contribution of
this document.

2.1 Architecture & Architecting of SoS

In the area of SoSE (SoS Engineering), SoS architecture refers to the set of component sys-
tems of the SoS and their interactions. [Wang et al., 2014] defines SoS architecture as “an
arrangement for the set of constituent systems, rules and behaviors that govern an individual sys-
tem’s functions. Architecture also describes how these systems’ capabilities contribute to a larger
goal.”

As previously said, a SoS evolves in a dynamic environment and its goals can change
during time whose cause the SoS to change the set of the component systems and the inter-

27



Existing Architecting Heuristics and Simulation Tools for SoS

actions between them. For example, a satellite (being a component system) used to transmit
a signal between a radar station and a combat unit (both considered as component systems)
can be periodically out of range because of its displacement. Thus, to overcome this dif-
ficulty, the radar and the combat unit have to find a new component system to relay the
signal, implying a modification of the architecture. To sum up, a SoS cannot have a static
architecture during time, it has to adapt its architecture during time.

The process to propose dynamically SoS architectures during time is called in this doc-
ument SoS architecting. In [Azani, 2008], "SoS architecting will develop executable architectures
with dynamic representation and reconfiguration capability enabling continuing SoS performance
and effectiveness analysis under various conditions and procedures. Static architecture representa-
tions and products are not effective tools for analysis of SoS evolving structure and emerging be-
havior.” To drive the development of SoS Architecting, [Azani, 2008] propose to use six core
principles:

o Open interface principle - Open systems have permeable boundaries that allow them
to exchange mass, energy, and information with other systems;

o Synergism principle — The notion that designates that the co-operative interaction be-
tween component systems has a greater effect in their combined efforts than the sum of
their individual parts. Essentially, this is what gives rise to emergence;

o Self-government principle - This implies that the SoS maintains and develops its inter-
nal order without interference from external sources. This could be through cybernetic
control, homeostasis, or self-organization;

o Emergence principle - In this case, this refers to the occurrence of novel and coherent
structures, patterns, and properties during the self-organization of the SoS;

o Conservation principle — This principle states that energy and mass (material) are con-
served within the SoS;

o Reconfiguration principle — This refers to the SoS reconfiguring and adapting itself to
sustain against changes in its environment.

Finally, SoS Architecting heuristic consists in finding how component systems can work
together and change their interactions to fulfill the SoS goals efficiently and effectively. Due
to the dynamics of the environment and the large set of solutions area, finding the optimal
architecture during time for a SoS is nearly impossible. In other words, the time of resolu-
tion can be higher than the time of a change in the environment. Thus, the use of heuristics
in SoS architecting has been proposed in literature in order to find a satisfactory architec-
ture for a given state of the environment. To find such an architecture, designers can use
the managerial and operational independence of component systems to propose decision
strategy (like collaboration) at the component system level. For directed and acknowledged
SoS, designers use central management to coordinate and/or use directly component sys-
tems resources. For example, central management can decide to add or remove component
systems during functioning. Based on and using classical Al tools, we present two existing
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architecting heuristics for SoS and their limitations; they have been chosen because they are
the most developed and documented.

2.2 Criteria for the Characterization of Architecting Heuristics

We define six evaluation criteria to evaluate the overall quality of SoS architecting heuristics.
They are inspired from literature and from the six core principles of [Azani, 2008]. First, a
SoS architecting heuristic has to be tested and simulated through different scenarios based
on a model that can be easily computed and should be as much as generic as possible to
be used in various domains as possible. As we study systems evolving in a dynamic envi-
ronment, the dynamicity of the architecting heuristic is important. From the open interface
principle, a SoS has to have an open architecture (i.e., component systems can be added or
removed at runtime), then the openness of the heuristic is important. As a huge amount of
component systems can be involved, the computational cost of the heuristic is important.
From the self-government principle, SoS may or not be modeled with a central control (i.e.,
a SoS can be directed, acknowledged, collaborative or virtual). Then, the heuristic should
have the ability to work in a decentralized manner. Finally, from the synergism principle,
the use of cooperation between component systems in an efficient SoS architecting heuristic
seems important. These criteria cover characteristics of SoS architecting and will be used to
evaluate properly existing heuristics. We describe each one of the criteria we have defined
in the following paragraph:

Computationality: The computationality of an architecting heuristic is the ability to be im-
plemented on a computer. If a heuristic describes in a too much literal way its functioning,
it becomes a hard task to implement it on a computer and may lead to mistakes or misun-
derstanding during implementations.

Genericity: The genericity of an architecting heuristic is its ability to be used in various
domains. An architecting heuristic is not generic if it uses domain specific information to
work. For example, if a heuristic architecting can be used only for the military domain, this
one is not considered as a generic heuristic.

Dynamicity: The dynamicity of an architecting heuristic is its ability to enable the SoS to
adapt to the changes occurring in the environment and the SoS goals. Thus, the architecting
heuristic should take into account parameters and objects related to the environment.

Openness: The openness of an architecting heuristic is its ability to add and remove com-
ponent systems within the SoS during its functioning.

Computational cost: Computational cost is a metric representing the amount of computa-
tional resources the architecting heuristic needs to work.
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Decentralization: It is the ability to propose architecture without the need of a central
management to work. Managing is not equal to have a coercive power on component sys-
tems. For example, in acknowledged SoS, a central management exists but has no coercive
power. Finally, a decentralized architecting heuristic enables to architecture collaborative
and virtual SoS because these types of SoS have no central management.

Cooperation: It is the ability to design a SoS where component systems can use coopera-
tion with each other. This ability is important because it drives the emergent behavior of the
SoS [Gongalves et al., 2014] and respects the synergism principle.

The following sections introduce two existing SoS architecting heuristics.

2.3 SoS Architecting Heuristic Based on a Collaborative Approach
[Caffall and Michael, 2009]

In some types of SoS (like acknowledged and collaborative ones), component systems are
free to participate (or not) to the SoS goals. As they are managerially independent, they have
their own goals and it can happen that they are in part contradictory or incompatible with
the SoS ones or with other component systems. In this case, game theory explains that a
rational agent (here a component system) will evaluate the advantages and the constraints
of the collaboration (i.e., the participation to the SoS goals) and if the choice of collaboration
leads to few advantages or too much constraints, the component can decide to quit the
SoS. Thus, authors propose in [Caffall and Michael, 2009] an architecting heuristic where
component systems:

1. act collaboratively with each other to avoid counter-productive actions between each
other;

2. are able to negotiate the gain and the constraints of collaboration with the SoS.

To reach (1), this architecting heuristic uses satisficing games theory (described in section
2.3.1) and to reach (2), mechanism design and Multi-Criteria Decision Analysis (MCDA)
are used [Caffall and Michael, 2009]. The following sections detail these notions and their
articulation around this architecting heuristic.

2.3.1 Satisficing Games

Satisficing games are used in this heuristic to enable collaboration between component sys-
tems. The notion of satisficing introduced by [Simon, 1956] comes from the combination
of satisfy and suffice. Based on game theory, satisficing games are multi-agents games cre-
ated to take decision with multiple agents dealing with rationality and enabling cooperation
[Stirling, 2005]. As authors explain, in game theory, rationality with only one agent consists
in choosing the preferred action for itself. These preferences are often ordered thanks to a
utility, creating a utility function. But, in a multi-agent context, doing the best for an agent
can be harmful to other agents because having concurrent objectives or concurrent access
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to resources. Then, choosing the action that maximizes the utility function of an agent is
not necessarily the best solution for the group. In other words, agents influence each other
because the action of an agent can (or not) helps another agent to fulfill its goals.

To overcome this shortcoming, authors propose a new notion of rationality where prefer-
ence (of an action) is conditioned by preferences of others. It enables to take into account
both the preferences of an agent (its own rationality in terms of classic game theory) and the
preferences of other agents. The following sections introduce the formalism of satisficing
game theory and show its limitations concerning our evaluation criteria.

2.3.2 Interdependence Function and Satisficing Solution Set

Each agent computes its preferences taking into account the preferences of other agents.
The preferences of an agent are constructed with two "personas” or ‘'roles’ that evaluates its
own options (or actions): the first persona, called selectability, is based on the effectiveness
of an option (i.e., how the option is close to the agent goal). The second called rejectability
is based on resources consumption or cost, called inefficiency of an option. These two
contradictory roles are mathematically represented by classical utilities having the same
mathematical structure as a probability mass function [Hill et al., 2005].

Thanks to these functions, interdependencies between agents are represented through
an interdependence function called joint selectability and rejectability mass function.
This function is computed in the same manner as a joint probability function. The only
difference is that conditioning has not the same semantic than the classical probability
conditioning. In satisficing semantic, conditioning represents option dependence (in term
of rejectability and selectability) for an agent with regard to other agents’ options. The
details of the interdependence function construction are explained hereafter.

For a n—multi-agent system, the interdependence function is mathematically a joint
mass function and expressed as:

Pint = PS;..S,,Ry...R, (Uis oo Un, Viy ooy V)
with Vi € [1,n]:
o u; € U;, an available option (or action) of agent a;;
o v; € U;, an available option (or action) of agent a;;

o Uj; the set of all the options of 4;.

Interdependencies between agents are graphically represented with a praxeic network.
In a praxeic network, each node represents how the agents” personas will influence others
agents personas. Figure 2.1 shows a simple example of a praxeic network for a SoS com-
posed of 3 agents. In this network, links show interdependence between agents” personas
S; (selectability of agent i) and R; (rejectability of agent i). The figure 2.1 has to be read like
this:
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Figure 2.1 — Praxeic network for a SoS with three agents a1, a5, a3

o Selectability S; of agent a; influences rejectability R; of agent a; and rejectability R, of
agent ap;

o Rejectability R, of agent a, influences selectability S3 and rejectability R3 of agent a3;
o Rejectability R; of agent a; influences selectability S3 and rejectability R3 of agent a3.
o Selectability S, has no influence on a; and a3.
Then, the interdependence function can be expressed as following;:
PS15255R, RoRs (U1, U2, U3, V1, V2, V3) =
pSg\R1R2(u3/ v1,02) - PR3|R1R2(7)3r01/7)2) ' PR1|sl(Ulr”1) : pR2|51(7)2r”1) - ps, (u1) - ps, (u2)

Where:

o 1y, Uy, uz are respectively the options chosen by a1, a3, a3;
o v1, 02,03 are respectively the options rejected by a1, a3, a3;

S Ps|r Rz(ug, v1,02), for example, is the mass function giving the selectablity value of
option u3 chosen by a3 conditioned by the choice of 4; to reject option v; and the choice
of a; to reject option vy.

In the general case, the selectability and rejectability functions are marginal functions (in
terms of probability function) of the interdependence function:

Psl...sn(ull---,un) = Z Z pSl.,.S”Rl...Rn<u1/---/unrvlz---zvn)

vl v, eUy,
and
PRy..R, (01, -y On) = Z Z Psl...san...Rn(ull---,vall---,Un)

urelly u,ely,

Finally, the jointly satisficing solutions at caution level q is defined as:
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Sqg=A{u€U:ps(u) > qpr(u)}
where:

o g € IN+ represents the caution level;

o U = {uy,..un0v1,.0n} € Uy X ... x Uy, X V] X ... XV, is the vector of the n chosen
options in terms of selectability and rejectability.

The set S; contains all option vectors u such as the value of the joint selectability ps is at least
as great as g times the joint rejectability pr. The use of a caution level g enables to modulate
the set of satisficing solutions. Indeed, a caution level equal to g gives a set of satisficing
solutions that are g times better in terms of selectability compared to the rejectability. Then,
the higher the caution level is, the more satisficing the solutions are. This approach is used to
model UAV formation flight with obstacle avoidance [Stirling and Frost, 2005] and aircraft
collision avoidance [Hill et al., 2005].

2.3.3 Mechanism Design as a Basis for SoS Collaborative Formation

As explained before, in some types of SoS (like acknowledge or virtual ones), component
systems do not have the obligation to collaborate with the SoS. This is a classic statement
of game theory: each component system (seen as a player) is considered as rational when
it chooses action with the highest gain (also called utility) for itself. But at the same time,
it is also known that the optimization (maximization) of component system utility does
not lead to the optimization of the global system (here the SoS) [Caffall and Michael, 2009].
But, it exists a game theory concept enabling the construction of a game where the highest
collective benefit may be reached and where at the same time each player chooses an action
that maximizes its own utility. This concept is called mechanism design.

More precisely, mechanism design is a concept of game theory created to solve a particular
kind of Bayesian game (a game under private information between players). Sometimes, in
a context of bargaining between players, a player called the "principal” would like to adapt
his behavior according to private information owned by other players called "subordinates"
that have the ability to lie about it. The "principal” has the whole bargaining ability and the
idea is to find rules (more formally called mechanism) that lead other players to reveal their
private information without forcing them. In this kind of game, the goal of the principal is
generally to maximize the common interest. In this asymmetric game, the principal (which
has its own objectives) defines the rules of the game in a way that agents will act as it wants.
We propose the purchase of a used car as the informal example. To be satisfied, the buyer
would like to have the good at the lower price as possible depending of the real state of
the car (good, used, very used...) which is a private information of the salesman. Indeed,
the buyer cannot have this information by asking the salesman, as he wants to get the
higher price for his good and has the ability to distort the reality. Nevertheless, the best
solution for the group is that the sell occurs. As the buyer can decide of some rules of
the game, he will influence the salesman to reveal his private information. He can, for
example, ask to subscribe to an insurance for the car. The response of the salesman will give
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some information about the real state of the good. This kind of games can be solved with
mechanism design.

Mechanism design is well formalized in some papers like [Jackson,2003] and
[Myerson, 1983] and the main important result is the revelation principle stating that
"To every Bayesian Nash equilibrium there is a corresponding Bayesian game with the same
equilibrium outcome but in which players truthfully report type.” In other words, it is always
possible for the principal of a game to find a mechanism (also called the social function)
where players trustfully give their private information and at the same time, respect their
own incentives.

To sum wup, the mechanism design in Collaborative SoS Formation
([Caffall and Michael, 2009]) enables the architecting heuristic to design a social func-
tion (by finding rules as presented above) where SoS goals (through the role of principal)
and where component systems (the subordinates) will participate for the good of the SoS
and their own objectives (represented by their utilities) at the same time even if they own
private information and [...] may be autonomous and of self-interest [Caffall and Michael, 2009].

This social function is based on the social utility function (in terms of satisficing games)
as described in [Stirling and Frost, 2005]. As we previously presented, the social utility
gives the satisficing solutions for a group of agents (here component systems) by taking
into account interdependencies between them (i.e., component systems act collaboratively
with each other). Moreover, each component system owns a private utility (also called "ex-
pected utility") function that is represented by the individual selectability and rejectability
marginal functions presented above. To take into account the goals of the SoS, this one
uses mechanism design to re-design the social function. Finally, as component systems
can choose to leave the SoS, they are able to negotiate their expected utility (utility func-
tion of a component system) with other component systems and the SoS. This mechanism
enables the SoS to keep component systems if they are, for example, really valuable. In
[Archibald et al., 2006a], authors argue that it can happen if the satisficing set is empty. In
this case, there is a number of negotiation protocols that could be implemented, with one of the
simpler being a round-robin procedure of decrementing the negotiation indices of the participants.
In Collaborative SoS Formation, the negotiation protocol is the Analytic Hierarchy Process
(AHP) presented in the next section.

2.3.4 Multi-Criteria Decision Analysis and AHP Solving

MCDA (Multi-Criteria Decision Analysis) is a method enabling to take a decision between
some alternatives by rating them with criteria to fulfill a given goal. To find solutions (i.e., to
find the best alternative or to classify them), authors propose in [Baldwin and Sauser, 2009]
to use AHP. Developed by Saaty in [Saaty, 1980] and as shown in figure 2.2, a hierarchy is
created to evaluate choices by a set of criteria. These criteria are chosen by the decision-
maker according to what he wants to evaluate. As an example, for choosing a car (figure
2.2), criteria can be the Type, the Consumption, the Appearance and the Engine. Each alter-
native is pair-compared with others according to a particular criterion. The pair-comparison
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Choose a car

Y

Type Consumption Appearance Engine
Car 2 Car1 Car 3

Figure 2.2 — AHP structure

is scored with an intensity of importance defined by the modeler of the AHP. As an exam-
ple, Car 2 and Car 1 are compared with respect to Consumption: If Car 1 is two times better,
then score of Car 1 is, for example, 2 and score of Car 2 is 1. After this process, the alter-
natives are classified according to a score computed as the average of all the criteria score
attached to them. In Collaborative SoS Formation, the defined criteria are the Autonomy,
Belonging, Connectivity, Diversity and Emergence. Unfortunately, authors do not explain
in details how these negotiations between SoS and component systems are made.

Finally, Figure 2.3 sums up the global process of the method with three component systems:
component systems X,Y and Z began the process (state SO on the figure 2.3) by giving their
Local Utility to the SoS to compute the Social Utility Function thanks to satisficing games.
Then, the SoS will negotiate its preferences (thanks to its own goals and mechanism design)
with X,Y and Z. Then, X, Y and Z will negotiate and change their expected utility (thanks
to MCDA process). Once the negotiation is over (state S1 on the figure 2.3), X, Y and Z give
their new Local Utility to the SoS to compute a new Social Utility Function and so on.

2.3.5 Discussion

This Collaborative SoS formation heuristic uses a combination of different Al technologies.
We will evaluate this heuristic through the evaluation criteria defined in section 2.2.
Concerning computationality, the method uses satisficing games which is extremely formal
and can be easily instantiated on a computer. But the paper lacks of details concerning the
implementation of the whole heuristic. The articulation of mechanism design and MCDA
(through AHP) is not well explained.

Concerning genericity, this method uses a model based on set theory model presented
in chapter 1. This one is generic to model all kind of problems but has a lack in term
of environment model. Moreover, the resolution of a satisficing game (i.e. find the sat-
isficing set in a given environment) is based on Bayesian network resolution technique
[Stirling and Frost, 2005] dealing only with acyclic graph. Then, if a dependence cycle ex-
ists, no solution can be found.

Concerning dynamicity, the method enables a re-computation of a new solution if changes
appear in the environment. But the computation is heavy because it is based on satisfic-
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Figure 2.3 — Social utility function negotiation

ing games. Moreover, modelers must know a priori all direct interdependencies between
agents, which is not always the case.

Concerning openness, there is no visible limitations about adding or removing component
systems during functioning of the SoS. But once again, the use of satisficing leads to a certain
complexity because of the use of the praxeic network: adding or removing an agent leads to
a change, so a re-computation of the interdependence function that may be costly in time in
a real time environment. Then, the openness of the method is costly.

Concerning decentralization, the use of mechanism design implies the existence of the "Prin-
cipal” role. It implies the existence of a central management that disables to architect virtual
and collaborative SoS.

Concerning computational cost, the method uses satisficing games that are costly be-
cause of the computation of the social and expected utility functions. As authors explain
in [Archibald et al., 2006b]: “Computational complexity arises because of the calculation of the
marginal of the interdependence function. This complexity can be mitigated [...] using, for example,
Pearl’s Belief Propagation Algorithm [...]. Even so, it is well known that even these approaches are
NP hard, and the computational burden for a tightly interconnected, high dimensional multi-agent
system may become intractable.” Thus, the computational cost of this method may be high.
Concerning cooperation between component systems, the use of mechanism design enables
to use the game theory formalism. But in order to use it, a global goal has to be well defined
before the instantiation of the system.
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External Environment

Continue Continue. Continue
So5 Analysis 508 Analysis 505 Analysis

Figure 2.4 — Wave model

24 SoS Architecting Heuristic Based on Agent-Based Wave Model

SoS architecting heuristic based on an agent-based wave model developed in
[Acheson et al., 2012] and [Edward Pape II, 2016] aims at proposing a generic method to
find a satisfying architecture of a SoS constrained by an external environment (SoS total
cost, development time, threats and so on). To reach this objective, the method is composed
of several steps that are repeated through waves until a satisfying architecture is found. The
different steps of this heuristic are explained in the following sections.

2.4.1 Step 0: SoS Formal Description through Interviews

The inputs of the method are the global needs of the stakeholders of the SoS and the stake-
holders of the component systems that are collected and summed up thanks to interviews
documents. The main objectives of these documents are :

o to establish a common lexicography between SoS stakeholders (i.e., the owners of the
SoS) and SoS engineers;

o to extract the global goals (or objectives) of the SoS;

o to express these goals in terms of desired capabilities;

o to compose these desired capabilities with capabilities of component systems;
o to identify the component systems;

o to formally describe the SoS and component systems with the agent-based wave model
(see section 1.4.3);

o to define Key Performance Attributes (KPAs) to evaluate SoS architecture.

The term capability is used in the agent-based wave model to describe a kind of activity
made by a component system. For instance, considering an UAV (Unmanned Aerial Vehicle)
as a component system, a capability may be the detection of threats on the ground.
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Figure 2.5 — S0S architecture chromosome example

2.4.2 Step 1: Initiate SoS

The formal description made in step 0 with the agent-based wave model enables to define
the desired capabilities of the SoS. As a reminder, a SoS is represented by:

SoS = {C,W, P}
With:

o C, a set of desired capabilities c;;
o W, a set of weight concerning the set of desired capabilities C;

o P, a set of desired performances on capabilities in the set C.

Once the formal description is finished (step 0), a first SoS architecture is proposed by choos-
ing a set of component systems that fulfill the desired capabilities. Indeed, each component
system is described with a capability and performance on it. Then, this architecture is mod-
eled through a chromosome (one example is presented in figure 2.5) composed of two parts.
The first part represents the component systems that will participate to the SoS (1 for partic-
ipating, else 0) and the second one represents the existing connections between component
systems (1 for linked, O for not). This chromosome is used as an input of the step 2 presented
below.

2.4.3 Step 2: SoS Architecture Evaluation through KPAs and FIS

A fitness function based on KPAs (defined in step 0) is used to evaluate the architecture.
Generally, the KPAs are the following: Performance, Robustness, Funding (or Affordability)
and Flexibility. The formulation used to compute these attributes depends on the stakehold-
ers. Generally, the overall SoS performance on an attribute is a linear combination of com-
ponent systems’ performance on this attribute. Then, all of these KPAs are used as inputs of
a Fuzzy Inference System (FIS) that is a fuzzy logic tool used to compute a fuzzy variable
output with a set of fuzzy variable inputs and a set of fuzzy rules. A fuzzy rule is an asso-
ciation of fuzzy output values with a set of fuzzy input values. Table 2.1 shows an example
of fuzzy rules based on three fuzzy variable inputs and one fuzzy variable output. As an ex-
ample of rule, when the SoS has a high performance gap (between the desired performances
and the current performances given by the component systems), the third rule (correspond-
ing to the third line of the table 2.1) gives a little increase to the funding enabling the SoS to
have more funds to negotiate with component systems. The main advantage of a FIS is to
compute variables that are not expressed in the same unity. As Funding and Performance
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Inputs Outputs
Performance Gap | Weight | Funding Gap Funding
none none none decrease little
low none none do nothing
high none none increase little
none low none do nothing
none high none increase little

Table 2.1 — An example of set of fuzzy rules

may be expressed respectively in currency and up-time duration, they are not directly com-
parable. Then, the FIS enables to go through this kind of problem by translating (or fuzzing)
attributes from their original value to fuzzy value. A FIS used to fuzzy the KPAs is de-
scribed in [Dagli and Acheson, 2012]. Basically, the values are fuzzyfied and defuzzyfied
with an algorithm called Enhanced-Karnik-Mendel algorithm [Dagli and Acheson, 2012].

2.4.4 Step 3: Propositions of Alternative SoS Architectures with Genetic Algo-
rithm

For the genetic algorithm part, the SoS architecture modeled by a chromosome (presented
in figure 2.5) is used as an input. The chromosome has two main parts: the first one repre-
sents the component systems involved in the SoS, the second one represents the set of links
between the component systems. Then, the genetic algorithm computes new SoS chromo-
somes that are close from the first one. Finally, the fitness function (presented in the section
2.4.3) rates the new chromosomes and are presented as alternative architectures that can be
used as the new SoS architecture. Then, an architecture is chosen (for example, the best rated
by the fitness function) and a last step of negotiation between SoS and component systems
is executed. The next section explains this negotiation step.

2.4.5 Step 4: Component System Model and Negotiation

When the architecture is chosen, SoS sends negotiation requests to component systems in-
volved in the new architecture. As they are managerially independent, component systems
can choose to participate to the SoS or not. A component system decides to negotiate with
the SoS with the help of a Fuzzy Inference Engine (FIE) [Paredis et al., 2013] that has the
following inputs:

o Willingness to cooperate, which is related to the degree of selfishness of the component
system;

o Ability (in terms of resources) to cooperate depending on component system’s re-
sources that will allow it to be part of the SoS.

These variables represent the propensity for a component system to collaborate with the
SoS. Because it is domain-dependent, FIE has to be defined for all component systems. This
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negotiation enables to simulate the managerial independence of component systems. At the
end of this step, stakeholders analyze the new architectures and choose the preferred one
based on their expertise. Finally, the whole process may be repeated again to find better SoS
architectures.

2.4.6 Discussion

This generic SoS architecting heuristic, divided on several steps, is based on interviews with
stakeholders, fuzzy logic and a genetic algorithm. This method uses the concept of SoS as an
autonomous entity that negotiates with component systems: it is not a decentralized heuris-
tic. All communications are going through the SoS and component systems cannot directly
communicate between them. Moreover, this SoS decides to send collaboration request to
component systems, which cannot choose to contact the SoS or other component systems.
This method uses a model that is generic enough to model all kind of problems.
Concerning dynamicity, the SoS agent makes its goals evolving according to the changing
environment. For example, the process can update the SoS if the global funds for the SoS
are changed (through, for example, the KPA concerning the affordability).

Concerning openness, the SoS is able to negotiate with other component systems to join the
SoS. But component systems cannot quit the SoS by themselves.

Concerning computationality, the fuzzy assessor needs a set of fuzzy inference rules. In the
papet, an example for 4 variable inputs that can take 4 values leads to a set of (4*) 256 rules
that have to be defined by the SoS designers. Moreover, the fuzzyfication of all the variables
(funding, performance, robustness and so on) are made and chosen in an informal manner
by the designers and stakeholders. Then, there is no insurance that the fuzzy methodology
used will product the best collaborative architecture. Moreover, if they are not well defined,
they may introduce bias : “"Some KPAs of the SoS remain ambiguous even after extensive discus-
sions among the stakeholders” [Edward Pape II, 2016].

Concerning computational cost, no study is available on the different papers found for this
method. Concerning cooperation, this method enables collaboration between SoS and com-
ponent systems but does not deal with direct collaboration between components.

2.5 Simulation of Systems

For [Banks et al., 2005], “a simulation is the imitation of the operation of a real-world process or
system over time”. A simulation of a system can have several goals:

o to predict and/or understand a real phenomenon that, at first glance, is difficult to
predict and/or understand;

o to evaluate the effects of potential changes in a system structure or inputs;
o to test hypothesis on the functioning of a phenomena or a system;

o toserve as a pedagogical device for training and learning;
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o to deal with about internal interactions of complex system (factory, water fabrication
plant, service organization, etc.) [Banks et al., 2005].

The simulation of a system requires the creation of a simulation model: it takes the form
of assumptions concerning the functioning of the system. These assumptions are expressed
in terms of mathematical, logical and symbolic relationships between the entities of inter-
ests of the system [Banks et al., 2005]. The development of such a simulation model is not
an easy task because of several problematics. As an example, creating a simulation model is
a simplification of the real system in order to be able to run numerically an experiment. The
choice of the right level of simplification may be difficult: a too simple simulation model
can lead to an irrelevant simulation and at the contrary, a too complex simulation may lead
to results that are difficult to understand. Another problematic is the choice of the type of
simulation model: it can be static or dynamic, deterministic or stochastic and discrete or
continuous. A static simulation model, also called a Monte Carlo simulation, represents a
system at a particular point in time. On the other hand, a dynamic simulation model rep-
resents a system as it changes over time [Banks et al., 2005]. Deterministic means that the
simulation model does not contain random variables in it. Discrete means that variables
may change only at discrete values of times. On the other hand, in a continuous simulation
model, variables change continuously. The choice between a continuous or discrete simula-
tion depends on the type of studied phenomena. To drive the choice and the creation of a
simulation model, the objectives of the simulation have to be defined:

o What are the characteristics or properties of the real system to be studied?
o What is the right level of abstraction (or simplification) needed?

o What are the relevant inputs or outputs?

Finally, this variety of simulation choices may lead to a problematic of coherence between
simulations: for a given problem, using different simulation models may lead to different
simulations, and consequently conclusions.

To help simulation designers, the research on simulation of systems focuses on the de-
velopment of tools, methodology, standards and so on. This area of research involves sev-
eral application domains (transport, defense, logistics and so on). In classical System En-
gineering (SE), Modeling and Simulation (M&S) methodologies give a scientific framework
to guide designers to create simulation models. But as explained in the introduction of this
document, the oncoming of SoS Engineering (SoSE) leads to "re-open" classical SE research
areas because systems under studies have changed: the characteristics of a SoS and its com-
ponent systems (heterogeneity, openness, independence of elements and so on) explain the
limits for applying M&S to SoS simulation. This point is developed in the following section.

2.6 Challenges and Issues of ""SoS Simulation"

As classical simulation, SoS simulation concentrates on reproducing SoS as close as possi-
ble to the reality [Zeigler et al., 2000]. But, as highlighted in the previous section, one main
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issue is to find models that lead to interesting results close to the reality. For classical sys-
tem simulations, M&S proposes methodologies to realize these simulation models, but they
do not fit for SoS simulations because of the huge complexity of SoS. The complexity of its
component systems and its dynamics conduct to non-linearity effects between them. Repro-
ducing this non-linearity is important because it can be the source of desired emergence in
the SoS. But, simplifications may entail the loss of this non-linearity [Henshaw et al., 2013].
That is why getting the correct level of abstraction for a component system is important:
in one hand, a too simple model and simulation can be too simple and unrealistic and in
the other hand, a too complex model and simulation may lead to a huge computational cost
or simply becomes incomprehensible. Additional issues due to the SoS characteristics have
been highlighted in [Henshaw et al., 2013].

Being composed of heterogeneous and complex systems implies that heterogeneous sim-
ulation models (of different types) work together. Moreover, modeling and simulating these
components require expertise on specific domains and, for simulation tools, the need to
model or to use existing models that can be heterogeneous in terms of types (static or dy-
namic, discrete or continuous and so on). Then the ability to simulate heterogeneous models
is an important criterion.

Moreover, SoS is often composed of legacy systems having their own models and/or
simulation tools that can be incompatible because of their different types. For example,
plunging a time discrete simulation model with a continuous simulation model is gener-
ally difficult (but still possible). It leads to a choice of a simulation paradigm that enables
interoperability.

Furthermore, as several SoSs integrate the "human in the loop", it is important to be
able to model human behavior, which is not an easy task. Finally, as a huge number of
component systems and interactions can be involved, simulation has to be efficient to avoid
computational cost. Thus, the last criterion is the simulation performance.

2.7 Challenges and Issues of SAHS (SoS Architecting Heuristic
Simulation)

SAHS and classical SoS Simulation presented before have different goals. The main idea of
SAHS is to study at a high level of abstraction how management of the SoS and social be-
havior of the component systems can be used to propose good SoS architecting heuristics.
As explained in chapter 2, SoS architecting heuristics focus on finding the right behavior
and management of component systems to propose a dynamic architecture, in order to
cope with changes of the SoS and its environment. SAHS must take into account the evo-
lution of the SoS architecture to cope with the dynamics of the environment. Moreover as
we explained in chapter 1, the dynamic architecture leads to the ability of a SoS to produce
a large-scale emergent behavior and a social behavior the ability to self-organize. These
criteria are also called meta-requirements in SoS literature [Ceccarelli et al., 2015]. Further-
more, a SoS architecting heuristic is more valuable if it is generic enough to be applied to a
large variety of domains. This genericity leads to focus on component system model where
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SoS Simulation SAHS
Component system level of abstraction - +
Interoperability Technical Pragmatic

Heterogeneous simulation models + -
Human models + -

Dynamic architecture - ++

Dynamic Component social behavior - ++
Simulation performance ++ +

Table 2.2 — Criteria for SoS Simulation and SAHS discrimination

the level of abstraction is less important than in classic SoS simulations.

Nevertheless, there are some common points to both simulation approaches: interoper-

ability is an important issue concerning classical and heuristic simulations but not studied at
the same level. In [Mittal et al., 2014], authors argue that in classical SoS simulations, efforts
are put on technical interoperability (i.e., focused on data exchange between heterogeneous
simulations). For example, the interoperability of an aircraft model developed in JAVA and
a control tower in C++ consists in making them able to exchange data. In SAHS, interoper-
ability is studied at a pragmatic level (i.e., how the information in the data are used). As a
huge number of component systems and interactions can be involved in SAHS, the simula-
tion performance is also an important criterion.
This analysis shows that the evaluation criteria are not the same to evaluate classical SoS
simulation and SAHS. Thus, we choose the evaluation criteria that seem the most important
for SAHS: the ability to deals with pragmatic interoperability, heterogeneous models, a dy-
namic architecture, a dynamic component social behavior and simulation performances.
Then, the following sections focus on finding simulation paradigm that fulfills these crite-
ria. Table 2.2 presents the whole criteria for both SoS simulation and SAHS. The legend is
the following: (++) means that the evaluation criterion is mandatory, (+) means that is im-
portant but not mandatory, (-) means that the criteria can be used but is not important (- -)
means that the criterion is not important.

2.8 Evaluation of Existing Paradigms for SoS Simulation

In literature, the two main paradigms for SoS simulation are Agent-Based Simulation and
Discrete Event System Specification (DEVS). Both are not focused on the same needs con-
cerning SoS simulations. The next sections explain in more details these differences and an-
alyze their adequation for SAHS through the prism of the criteria addressed and summed
up in table 2.2.
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2.8.1 DEVS and DEVS Variants

Introduced by [Zeigler et al., 2000], DEVS is a formalism used to model and simulate system
called DEDS (Discrete Event Dynamic System). A DEDS is defined in [Banks et al., 2005]
as a "system where state space is discrete and where state can only change as a result of asyn-
chronously occurring instantaneous events over time”. So basically, DEVS models systems in
which the state variable changes only when events occur during time. This separation and
the attached formalism (presented below) of DEVS enable to bring interesting mathemati-
cal proofs about correctness of simulation algorithms. The aim is to have a formal verified
simulator. This is the main reason of the great interests of DEVS in simulation area. In
[Mittal and Luis Risco Matin, 2013], authors present DEVS and its extensions (also called
variants) for simulating SoS and argue that they suit for SoS simulations. The following
paragraphs present the basis of DEVS and how its variants can be used to suit SoS simula-
tions. In DEVS, the simplest system is called an atomic-DEVS.

An atomic-DEVS is defined by the 7-tuple M = {X,Y, S, 8it, dext, A, ta} where:
o X is the set of input events;
o Y is the set of output events;
o Sis the set of sequential states;

o Jipt © S — S is the internal transition function which defines how a state of the system
changes internally;

o Jext ¢ Q X X is the external transition function which defines how an input changes the
state of a system;

o> Q={(s,e):s€S,ec|0ta(s)]} is the total state set, and e is the elapsed time since the
last transition;

o A: S — Yis the output function used to generate output events;

o ta: S — T is the time advance function which is used to determine the lifespan of a
state.

At the beginning of the simulation, M is in state 5o € S. Then, there is only two ways for
M to change its current state:

1. if an event occurs in one of its inputs in X;

2. if the elapsed time f, reaches the lifespan of s (given by ¢,(so))

Then, .yt and 6, are respectively used in case (1) and (2) to change the state of M. Finally,
A is used to generate output events due to the new state of M.

The second main model enabling interactions between atomic-DEVS is the coupled
model. It is defined as an 8-tuple: N = {X,Y, D, {M;}, Cyx, Cyy, Cyy, Signal } where:
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o X is the input set;
o Yis the output set;
o D is the name set of sub-components;

o {M;||i € D} is the set of sub-components, each M; can be an atomic-DEVS or a coupled
one;

& Cyx C Y; X Ujep X; is the set of internal coupling. It contains couples of output and
input where outputs of sub-components are connected to inputs of sub-components;

& Cyx C X X Ujep X; is the set of external input coupling. It contains all the inputs of
sub-components minus the ones contained in Cyx (i.e., the ones that "go in" M);

> Cyy C Y; — Y? is the external output coupling function. It contains all the outputs of
sub-components minus the ones contained in Cy, (i.e., the ones that "go out" from M);

o Select : 2P — D is the tie-breaking function which defines how to select the event from
the set of simultaneous events.

This coupled model N enables to put together atomic-DEVS or other coupled mod-
els. Finally, the notion of atomic and coupled DEVS enable to simulate entities that are
close to the notion of component system of a SoS. An atomic-DEVS can model a compo-
nent system and a coupled-DEVS can model interactions between component systems with
the set of internal coupling C,,. But the first limitation of classical DEVS concerns the dy-
namicity of the SoS architecture: it is not possible to change the connections (representing
the interactions) at runtime. To fulfill this need (i.e., to simulate architecture dynamicity),
an extension called pDEVS is presented in [Hu et al., 2005] which introduces a new set in
the atomic-DEVS enabling the change of the connections at runtime. Moreover, authors in
[Mittal and Luis Risco Matin, 2013] propose an entire net-centric and client-server oriented
platform based on DEVS formalism to simulate distributed models described with a com-
mon language (DEVSML).

2.8.2 Agent-Based Simulation

Agent-Based Simulation (ABS) uses to simulate ABM (Agent-Based Model). It is
a paradigm of simulation that is really developed ([Bonabeau,2002], [Behdani, 2012],
[Mour et al., 2013]). It does not own a concrete formalism and is a flexible simulation
paradigm: it is used to simulate systems according to a particular point of view that is the in-
dividual social behaviors and interactions of autonomous entities (also called agents). More
precisely, it enables to implement specific agent behaviors and interaction rules between
each other. This behavior is often based on the Perceive-Decide-Act cycle. [Bonabeau, 2002]
argues that ABS (also called Agent-Based Modeling) is powerful simulation modeling technique
that is useful when:

o "the interactions between agents are complex, nonlinear, discontinuous or discrete [...J;
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o space is crucial [...];
o the population is heterogeneous [...];

o agents exhibit complex behavior [...]".

Furthermore, ABS is used to exhibit emergent phenomena resulting from interactions be-
tween entities. [Behdani, 2012] argues that ABS is useful when the system to simulate:

o is "individual-oriented; focus is on modeling the entities and interactions between them”;
o is composed of "heterogeneous entities";

o is composed of micro-level entities that are active and interact with each other and
evolves in an environment;

o is a system where the dynamic behavior comes from "agents” decisions and interactions.

In [Mour et al., 2013], authors propose a comparison of ABS and Discrete Event Simulation
and conclude that ABS is more suited to represent “individual entities that drive the discrete
events and allow for possible emergent behavior”.

2.9 Discussion

Table 2.3 sums up the different evaluations of DEVS and ABS for SAHS. The legend is the
following: the evaluation criterion for the heuristic is totally filled (++), partially filled (+),
partially absent (-), totally absent (- -). Concerning our evaluations criteria, because DEVS
models exchange only data of the same type (events), it enables pragmatic interoperability
and pDEVS enables dynamic architecture. Moreover, DEVS enables to produce heteroge-
neous models by simulating, for example, atomic-DEVS with different set of states S. But,
authors argue that DEVS and its variants are not expressive enough at this time to model so-
cial behavior of component systems: in [Mittal and Luis Risco Matin, 2013], they argue that
as the representation of cognitive capacities and negotiations protocols (such as collabora-
tion, cooperation and so on) are future work.

As ABM paradigm enables to model SoS (see section 1.4.2) and as ABS concerns the
simulation of ABM, ABS is well suited to simulate SoS. In ABM, there is no precise rule
for defining the behavior or the rule of interactions of agents [Bonabeau, 2002]. It gives a
huge flexibility to ABS to implement heterogeneous agents” models and dynamicity of the
system architecture. Moreover, there is a flexibility concerning communication between
agents enabling pragmatic interoperability. Finally, concerning simulation performance,
[Bonabeau, 2002] argues that “Simulating the behavior of all of the units can be extremely compu-
tation intensive and therefore time consuming”.

We conclude that ABS paradigm is more suited to study SAHS. The main advantage is
the possibility to study how the social behavior of component systems will influence the ar-
chitecture. DEVS is an important and formal paradigm that brings advantages to study SoS,
but it fails concerning implementing social behavior (such as cooperation) of component
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DEVS and variants | ABS

Pragmatic Interoperability +
Heterogeneous Models +
Dynamic Architecture +

Dynamic Component Behavior --

+ |+ |+ |+ [+

Simulation Performance ++

Table 2.3 — DEVS & variants vs ABS for SAHS

systems and this is an important lack for SAHS because, for example, cooperation between
component systems are the basis of SoS emergent behavior [Gongalves et al., 2014]. This
limitation does not enable to use it for SAHS. It is better to simplify the model of the com-
ponent system to focus on social component behaviors. DEVS will not be used to simulate
the works of this thesis. That is why the following sections will focus on existing tools for
ABS and if they are usable for SAHS.

210 Existing Tools for SAHS

To be able to analyze SoS architecture, we propose a small review about existing tools con-
cerning SAHS. Concerning evaluation of these tools, we think that the main need is to have
the ability to implement a new generic SoS model. This need is important because we
conclude in chapter 1 that existing generic models have some limitations we want to go
through by proposing a new generic model. As there is a few works about SAHS, there
are a few tools for testing existing SoS architecting heuristics. Main contributions are in
[Edward Pape II, 2016] and [Caffall and Michael, 2009]. [Caffall and Michael, 2009] has al-
ready been presented through its heuristic in chapter 2. Authors test their heuristic on an
Auto Battle Management Aid SoS. Unfortunately, there are not enough details to present
properly tools they used. [Edward Pape II, 2016] chooses to implement their heuristic based
on Agent-Based Wave model presented in chapter 2. The author tests it on a variety of prob-
lems like Search And Rescue SoS and Operation Other Than War (OOTW) scenarios and
decides to develop its own tools to analyze, visualize and run his models.

Few tools exist and they have strong limitation: there is no concrete method to imple-
ment a new generic SoS model as we proposed to develop in the conclusion of the chapter 1.
Furthermore, these tools are not in the public domain so are not reusable. For these reasons,
the development of a dedicated tool for SAHS will be proposed. This tool is detailed in the
chapter 8 of this document.

2.11 Conclusion

The two SoS architecting heuristics presented in this chapter have been presented and eval-
uated through chosen criteria. Table 2.4 sums the whole criteria for both models. The legend
is the following: the evaluation criterion for the heuristic is totally filled (++), partially filled
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Collaborative Formation | Based Waved Model
Computationality - +
Genericity + +
Dynamic - -
Openness -- -
Computational cost - +
Decentralization -- --
Cooperation - +

Table 2.4 — Evaluation of existing SoS architecting heuristics

(+), partially absent (-), totally absent (- -). We can notice that both fail concerning the to-
tal decentralization of the process disabling to architecting collaborative and virtual SoS.
Moreover, both are based on a heavy process that leads to difficulties concerning the dy-
namicity and the openness. Finally, cooperation between component systems is not totally
represented in both of them that are the basis for the SoS emergent behavior. For these
reasons, we propose as a second contribution of this thesis a fully decentralized, open SoS
architecting heuristic based on cooperation between component systems.

This chapter proposes a state of the art concerning SoS simulation and SAHS. By compar-
ing both, evaluation criteria for SAHS are highlighted and used to evaluate two simulation
paradigms that are DEVS and ABS. The result of this evaluation is that ABS is more suited to
study SAHS especially because the easiness to study social behavior of component systems
of a SoS. Then, existing tools are presented and limits are highlighted: they do not enable
to implements easily a new generic SoS model. Finally, this thesis will propose to use ABS
through a self-made tool called SoS Architecting HEurIStlc based on Agent (SApHESIA) to
test a new SoS architecting heuristic based on cooperation.
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System (AMAS) Approach

After addressing SoS paradigm, this chapter focus on a MAS paradigm called the AMAS
approach that will be the basis of our proposition of SoS architecting heuristic. Indeed, as
explained in chapter 1, the MAS paradigm is a natural way to model SoS. Then, we think
that AMAS approach is close enough to generic SoS paradigm to be able to propose a new
heuristic formation based on cooperation. Thus, after presenting general definitions about
MAS, this chapter introduces the AMAS approach to justify that it can be used to propose a
new SoS architecting heuristic.

3.1 Multi-Agent Systems

Multi-Agent Systems (MAS) are generally defined as systems composed of interconnected
autonomous parts called agents. MAS are mainly used to propose solutions to complex
problems and to simulate biological phenomena or behaviors such as social insects. The
following sections propose basic definitions about MAS.

3.1.1 MAS Definition

A MAS is made of parts that are called agents situated in an environment and interacting
with each other. Ferber in [Ferber, 1995] defines a multi-agent system as a system composed
of the following elements:

o textit"An environment E, which is a space with a metric" (he does not define the concept
of metric);

o "A set of objects O that are located” (i.e., they can have a position in E at a given time);

o "A set of agents A that are particular objects (A C O that represents the active entities of the
system”;

o "A set of relations R that link objects”;

o "A set of operations Op enabling to agents of A to perceive, produce, consume, transform and
manipulate objects of O”;
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o "Operators being responsible to represent the application of these operations and the reaction of
the world to a modification”.

3.1.2 Agent Definition

An agent is an autonomous piece of software which tries to fulfill its own goal by using
its own reasoning and actions [Ferber, 1995]. It can communicate with other agents to help
them or ask for services.

In order to complete the previous definition, [Ferber, 1995] defines an agent as a software
entity that:

o evolves in an open computer system;

o can communicate with other agents;

o has its own goals;

o possesses its own resources;

o has only a partial representation of the other agents;

o has capabilities (services) that it can offer to other agents;

o has a behavior that tends to satisfy its own goals, taking into account its resources, the
representations and the communications it receives.

To explain the functioning of an agent, the representation through the
Perception, Decision, Action cycle is often used:

o the Perception phase, where the agent updates its representation of what it locally per-
ceives of its outside (its environment and the agents around it);

o the Decision phase, where the agent uses its behavior to bind the available actions that
will fulfill the most its goals considering its new representations (or perceptions);

o the Action phase, where the agent actually performs the chosen action, that implies
changes in its environment and the agents around it.

This representation has led to define two types of agents: the reactive agent and the
cognitive agent. On one hand, a reactive agent chooses its action depending only on
the perceived events of the environment. Its behavior is represented through a set of
if < perception > then < action > with no goals explanation nor plan mechanism. In
the Perceive — Decide — Act cycle representation, this kind of agents is represented with an
empty Decision phase: perceptions are directly bound to actions. The well-known example
of collective reactive agents is the ant colony. Each ant reacts to a perceived event such as
the presence of pheromone or food without reasoning.

On the other hand, a cognitive agent has a non-empty Decision set: it has a base of knowl-
edge concerning information about other agents (such as their available resources, services
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or even their emotional states [Rincon et al., 2016]), an expertise concerning the realization
of its task, the interactions management with others agents and its environment. We also
speak about "intentional" agents: they own goals they try to achieve.

3.1.3 Environment

[Weyns et al., 2005] argues that in MAS, the environment of a MAS is an important notion
but does not have a formal definition. Nevertheless, [Di Marzo Serugendo et al., 2011] pro-
poses a general definition through set theory by defining the world W = ESU S, S being the
MAS and ES the environment is plunged into. ES can be described as being all what is out-
side the MAS (ES = W/S). Another definition is the one from [Russell and Norvig, 2002].
They define the environment as the problem where the MAS evolves and where the MAS
is the solution of that problem. They propose to characterize the environment through four
criteria:

o Deterministic/Stochastic: an environment is deterministic if its next state depends only
on its current state and the action we apply on it (i.e., there is no stochastic variable that
influences its state);

o Fully observable/Partially observable: an environment is fully observable if one agent
is able to perceive the complete environment’s state;

o Static/Dynamic: an environment is static if its state does not change over time by itself;

o Discrete/Continuous: an environment is discrete if its number of states is finite.

This characterization helps the MAS designer to choose the right agent design. As an ex-
ample, in a partially observable environment, an agent is designed with limited perceptions.
The composition of the environment depends on what the designers would like to focus. In
the ant colony example, the environment can be in a first time represented by pheromones,
obstacles, terrain, the nest and food. And in a second time, if a focus on the ability of ants to
defend themselves against other insects needs to be studied, then other insects can be added
to the environment.

These previous characterizations can be defined as the physical environment of the
MAS. But the notion of environment exists also for an agent and can be defined as the union
of the environment plus the other agents of the MAS. Finally it also exists the notion of so-
cial environment of an agent that is defined in [Di Marzo Serugendo et al., 2011] as “the set
of known agents”. This social environment is important because it enables an agent to have a
representation of skills or available resources of other agents that it needs to achieve its own
objectives.

3.1.4 Organization

[Morin, 1977] defines an organization as “an agency of relations between components or individ-
uals that produces a unity (or system) owning qualities that are unknown from the components or
the individuals. The organization binds together elements, events or individuals in an interrelation
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manner that become the parts of a whole. It enables solidarity and relative solidity and then enables
a time duration of the system in despite of random perturbations”. In a MAS, there are a lot of
interrelations between agents through information exchanges, actions synchronization and
so on. Moreover, the term organization defines the process of a structure elaboration and
the result of this process. This duality shows that there is always a dynamic aspect attached
to an organization: the organization is necessarily dynamic and always in a reorganization
process of the entities and the links that bind these entities.

3.2 The Adaptive Multi-Agent System (AMAS) Approach

In computer science, user’s needs and usages are never been so sophisticated, diversified
and changing over time. Some examples such as smart cities [Paz et al., 2016], Web of
Thing (IoT) [Mrissa et al., 2015] and the use of Big data show that this assertion will
become truer in the future. Then, to fulfill these complex and heterogeneous user’s needs,
system designers have to build systems using heterogeneous and strongly interconnected
parts. For example, a system of air-ballistic defense leads to different people (engineers,
ballistic experts, military and so on) to work together with heterogeneous systems. System
designers need to cope with a strong dynamic environment where unpredictable and
heterogeneous events may occur: in the air-ballistic example, it can be cyber and physical
attacks, critical system failure and so on. Another constraint of modern systems is the need
to be up and running 100% of the time: this constraint makes more and more difficult
to wait a human intervention for repairing the system. These two facts lead to design
systems having the ability to repair, to change, to adapt itself or to self-adapt continuously
[Di Marzo Serugendo et al., 2011]. Moreover, user’s needs can also be under-specified; in
that case designers have to build systems where the desired functionality is not known a
priori.

AMAS approach has been developed to build these types of self-adaptive and under-
specified systems. To enable self-adaptation, AMAS approach uses the concept of self-
organization. To cope with under-specification, AMAS approach also uses the concept
of self-organization enabling the emergence of the adequate functionality. These general
notions are presented in the following sections.

3.2.1 Self-Adaptation

The justification of using the property of self-adaptation to cope with a dynamic environ-
ment comes from the following assertion derived from the law of requisite variety Ashby
[Ashby, 1956]: controlling a system with a level of variety needs a system with at least
more variety. The variety is the number of states a system can be. Indeed, the role of the
controller is to lead and maintain the system to a desired state. Then, each state of the
system has to be related to a state of the controller to manage it. But systems evolve in
more and more complex and dynamic environments where a huge variety of events can
occur. The construction of this external controller becomes more and more complex. Then,
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a solution can be to build a system that is able to cope itself with unexpected situations
with no need for external control: it is called a self-adaptive system.

The AMAS approach has been developed to design self-adaptive MAS
[Caperaetal., 2003], [Lemouzy, 2011], [DiMarzo Serugendo et al., 2011]. Moreover,
AMAS approach is also used to design systems when the problem is under-specified
and/or where no algorithmic solution is known a priori. It uses the principle of emergence
of the adequate functionality of the system; this is the topic of the next section.

3.2.2 Under-Specification

In the AMAS approach, the adequate functionality of a system is defined as the functional-
ity that solves the problem a system has been made for, regarding to the satisfaction of an
exterior observer. To produce it, the AMAS approach uses the concept of emergence of the
adequate functionality. It is used to help the system to cope with an under-specified prob-
lem. We propose to develop these notions of emergence and adequate functionality in the
following sections.

a) Emergence...

Many definitions of emergence exist but no real consensus exists. Emergence in computer
science [Di Marzo Serugendo et al., 2011], inspired by biological study, is a phenomenon ob-
served in a system that may be the apparition of a pattern or a structure, a behavior, a prop-
erty that is not present in the parts of the system. The emergent phenomenon is derived
from the simple interactions of the parts and appears without any central control. Emer-
gence is often presented as " The whole is more than the sum of the parts" [Bonabeau, 2002],
[Di Marzo Serugendo et al., 2011]. This concept exists in the nature like, for example, the
emergence of flocking behavior in group of birds or fishes. For [De Wolf and Holvoet, 2005],
an emergent phenomenon, is produced when coherent macro level properties can be ob-
served as a result of micro level interactions of the parts. Finally, an emergent phenomenon
is characterized as [Georgé, 2004] :

o an ostensible phenomenon, meaning that it is self-evident for the observer at the macro
level;

o a radically new phenomenon, meaning that it is neither observable nor explicable at
the micro level;

o a coherent and correlated phenomenon, meaning that it has its own identity but is
strongly related to the parts that produce it;

o a phenomenon that produces a particular dynamic, meaning that it is not predefined,
it is self-created and self-maintained.
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b) ...of the Functional Adequacy

The justification of using the concept of emergence in AMAS comes from the under-
specification of the problem to solve. It leads to design system that is under-specified. The
under-specification of a system means that the complexity of the problem to cope with does
not enable to define the desired functionality of the system. To tackle this kind of problems,
the AMAS approach enables to build systems that produce the adequate functionality (i.e.,
the function that solves the problem, regarding to the satisfaction of an exterior observer)
by using emergence when classical top-down approaches cannot be used. A top-down
approach is used by dividing the problem in simpler sub-problems to solve and then
re-assembling the sub-solutions to solve the global problem. This kind of classical approach
is not adapted for complex problems: dividing a complex problem into sub-parts leads
to lose the complexity of the problem because the complexity may come from the strong
interrelations of the sub-parts. For example, a problem can be complex to solve because of
retro-acting loops produced by parts. If parts are solved independently, solutions do not
take into account retro-acting loops effects. Reassembling these solutions does not solve
the overall complex problem. This kind of approach cannot be used when the desired
functionality of the system is not known a priori.

At the contrary, the AMAS approach is a bottom-up approach: the design is concen-
trated on the parts of the system that use self-organization for the emergence of the ade-
quate functionality and for the self-adaptation to a dynamic environment. The next sections
present how the notion of self-organization enables the self-adaptation and the emergence
of the adequate functionality.

3.2.3 Self-Adaptation through Self-Organization

To enable self-adaptation, the AMAS approach uses the notion of self-organization. Authors
in [Di Marzo Serugendo et al., 2011] defines self-organization as the process of a system that
leads to the apparition of a global structure from interactions of its parts. In others words, it
is the ability to change its internal structure or organization without explicit control or con-
straints from the outside of the system. Self-organization brings to the system properties like
resilience and robustness. Resilience is the ability to continue to operate when a failure oc-
curs. Robustness is the ability to stay efficient when an unexpected event in the environment
occurs. As said previously, an organization enables the MAS to have a relative solidity to
environment pressures (section 3.1.4). As self-organizing systems are resilient, they are able
to cope with environment dynamics by changing their organization and continue to func-
tion. This is a desired property for systems that need to cope with a dynamic environment:
self-organizing systems are able to change their organization to adapt themselves.

3.2.4 Functional Adequacy through Self-Organization

To enable emergence, the AMAS approach uses self-organization by only focusing on the
local behavior of the agents until the apparition of the organization that produces the over-
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Figure 3.1 — Emergence of the function by self-organization [Picard, 2004]

all function (that seems satisficing for an exterior observer) of the system. The aim is to
produce an organization that is an adequate response to the dynamics of the environment.
In other words, the overall function, which is not implemented in any agents of the system
(because this overall function is under-specified), will emerge from the self-organization of
the agents. Figure 3.1 sums up this idea: an AMAS is a multi-agent system S that realizes
a function f; and where agents are interacting parts. Each agent a; of S realizes a partial
function f,, # fs. The function of the system f; results from the combination of the f,
(fs = fp © fp © ... o fp,) and the current organization of the system. As generally
for © foa # frn © fpi, by transforming the organization, the combination of the partial
functions is changed and therefore the global function f; is changed. In other words, by
changing the agents interactions, the system self-organizes and as a result changes its func-
tion f; to self-adapt to the changes of the environment and to find itself its adequate func-
tionality. Then, an AMAS has to reach what is called the functional adequacy: to find the
right organization to produce the right functionality f; in a given environment. To drive
the self-organization of the agents, the AMAS approach uses the cooperation as a social
behavior.

3.2.5 Self-Organization through Cooperation

Figure 3.2 presents the philosophical view of cooperation: considering a group where de-
pendencies exist between individuals, it is more valuable to work cooperatively than in-
dividually. The notion of cooperation is used in the MAS research area. It enables, for
example, to allow group of agents to exploit the collective intelligence of other groups instead
of only exploiting individual skills of each other [Bessadi et al., 2016]. In AMAS approach,
[Picard, 2004] defines cooperation as the behavior at equal distance between selfishness and
altruism. Thus, a cooperative agent tends to reach its own goals and at the same time helps
its neighborhood to reach their own. Then, the cooperation is defined as a social behavior
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that each agent does not depart from.

To justify that the cooperation between agents can lead to the functional adequacy, the
theorem of functional adequacy is presented in [Glize, 2001] and [Camps, 1998]. In an infor-
mal manner, this theorem states that for each system S designed to achieve a particular task
fs, it exists a system having all its parts in a cooperative state achieving an equivalent task.
This theorem is important because it justifies the use of cooperation as a social behavior to
make systems that tend to the functional adequacy. Furthermore, doing a monolithic system
that solves a particular complex problem is barely impossible, mainly because of the valida-
tion and the under-specification of this one. Thus, the main idea is to build systems able to
self-organize to tend to reach the right functionality and then to self-adapt to the dynamics
of the environment.

In AMAS approach, the cooperation is implemented through two mechanisms: the res-
olutions of Non-Cooperative-Situations (NCS) or the calculation of the criticality.

a) Cooperation through NCS Detections

If an agent detects that it is not cooperative with its neighborhood, it has to solve this situ-
ation called a Non-Cooperative-Situation (NCS). To classify NCS, the AMAS approach de-
fines three meta-rules to instantiate depending on the problem to solve and based on the
Perceive — Decide — Act cycle. An agent is in a "cooperative state" if these three meta-rules
are verified:

& Cper: a perceived signal has to be understood and not ambiguous; here, signal is a gen-
eral term to point out something received or perceived by the agent (like a message, a
video feed and so on);

C Cgec: @ perceived information (i.e., an understand signal) has to be useful to produce a
new decision of action in the environment;

o cqet: the consequences of its action have to be useful to other agents.

When at least one of these meta-rules is not verified (—cper V —Cgec V —1C4et) by an agent,
this one is faced to a non-cooperative situation. Seven generic non-cooperative situations
have been highlighted:

o incomprehension (—cper): the agent cannot extract the semantic contents of a received
signal;

o ambiguity (-cper): the agent extracts several interpretations from a same signal;

o incompetence (—cdec): the agent cannot benefit from the current knowledge state dur-
ing the decision;

o unproductiveness (—cdec): the agent cannot propose an action to do during the deci-
sion;
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o concurrency (—cact): the agent perceives another agent which is acting to reach the same
world state;

o conflict (—cact): the agent believes that the transformation it is going to operate on the
world is incompatible with the activity of another agent;

o uselessness (—cact): the agent believes that its action cannot change the world state or it
believes that the results for its action are not interesting for the other.

When an agent has to cope with a, it has to apply counter-actions also called cooperative
mechanisms to go back on a cooperative state:

1. Tuning: the agent realizes limited changes in its internal state in order to modify its
partial function f),. For example, changing the values of parameters that influence its
partial function;

2. Reorganization: if tuning mechanisms failed, the agent tries to change its interactions
with its neighborhood. It can change its neighborhood and then the organization of the
system,;

3. Evolution: if tuning and reorganization mechanisms failed, the agent uses an evolu-
tion mechanism enabling to create or delete agents. An agent creation occurs when
any agent is able to fulfill a partial function f, that seems necessary for one of existing
agents. The suppression of an agent occurs when the functionality of an agent is not
useful anymore.

b) Cooperation through Criticality

Another way for an agent to be cooperative is to use the notion of criticality. Indeed, an-
other vision of being cooperative for an agent may that to help in priority the other agents
(including itself) of its neighborhood that are more critical than it. To compute this notion
of level of cooperation, each agent computes and uses a metric called "criticality". The no-
tion of criticality is then introduced to enable the agent to take locally the best decision for
itself and its neighborhood. Basically, the criticality represents the distance between the
agent’s current state and its goal. If its current state is far from its goal, then the criticality
is high. If it is close, then the criticality is low. Then, when an agent has to decide, it locally
compares its criticality with the criticalities of its neighbor agents. As it is cooperative, it
has to choose the action that helps its most critical neighbor (itself included) even if this
action increases its own criticality except if it becomes the most critical one. This metric is
already used in developed AMAS ([Kaddoum, 2011], [Lemouzy, 2011]) but as its definition
is problem-dependent, it is not reusable for other problems. One contribution of this thesis
is to propose a formal and generic definition of the criticality, which will be explained in
chapter 5.
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"THE TWO MUEESE

A fable for the Nations

CO-OPERATION

IS BETTER THAN CONFLICT

Figure 3.2 — The “Two mules’ cooperation metaphor

3.2.6 Adequation of AMAS Approach for SoS Architecting

The AMAS approach is based on Agent-Based Model (ABM) paradigm and as seen in chap-
ter 1, ABM is well-suited for modeling SoS. As a reminder, the agent paradigm can be natu-
rally used to model a component system of a SoS because of the similarities between the two
paradigms (see chapter 1 for more details). Furthermore, chapter 2 defines the following
evaluation criteria for SoS architecting heuristic: computationality, genericity, dynamicity,
openness, computational cost, decentralization and cooperation.

The AMAS approach is easily computational and is generic enough because it has been im-
plemented by a consequent number of authors and in a huge variety of areas such as infor-
mation access customization [Lemouzy, 2011], control systems[Boes, 2014], ambient systems
[Guivarch, 2014] and mechanisms design [Capera, 2005].

It is a dynamic heuristic because by self-organizing, it enables to self-adapt to unpredicted
changes in the environment.

It enables to add or remove agent (through the cooperation mechanisms) during function-
ing so it is an open approach.

As an AMAS agent has a limited perception of its environment: it enables to limit the com-
putational cost of the approach.

The AMAS approach is fully decentralized: there is no central management and the overall
functionality emerges only from the self-organization of the agents.

The approach is cooperative because each agent uses the cooperation as a social behavior
and cannot depart from this behavior.

Finally, the characteristics of the AMAS approach fulfill the evaluation criteria for SoS ar-
chitecting heuristic. Then, a SoS architecting heuristic based on the AMAS approach is pro-
posed in chapter 5 of this document.
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This first part presents a state of the art concerning a particular kind of complex systems
called System of Systems (SoS) through existing definitions, models and simulations
paradigms. In a first time, it presents the notion of System Of System through a wide
overview of existing definitions, characterizations and classifications. They introduce the
idea that SoS is a relatively recent research area where efforts have to be made concerning
a wide variety of fields like taxonomy, modeling, simulation, architecting heuristics and so
on. They also enable to extract the main characteristics of a SoS with regards to classical
systems and a working definition about SoS used in the rest of this document. Then, an
overview of generic SoS models is presented. Mainly based on set theory and Agent-Based
Model (ABM), they are evaluated through defined criteria issued from SoS definitions and
characteristics such as the ability to model component systems heterogeneity, operational
and managerial independences and so on. This overview brings forwards limitations
concerning the ability to model a dynamic environment and a more expressive notion of
interactions.

After defining SoS architecting, an overview of generic SoS architecting heuristic is
presented. Then, they are evaluated through criteria derived from the core principles for
efficient SoS Architecting by [Azani, 2008] and from general thinking about SoS architec-
ture such as the ability to be computational and to architect fully decentralized SoS like
collaborative SoS, to cope with a dynamic environment and so on. This overview brings
forwards limitations concerning the ability to cope with a dynamic environment and to
architect fully decentralized SoS such as collaborative SoS. Then, a presentation and a
differentiation between classical systems, SoS and SoS Architecting simulations through
criteria we propose are made. They enable to present and evaluate simulation paradigms
like DEVS and ABS and to choose ABS for doing SAHS because it enables to simulate
dynamic component behaviors. An overview of existing tools for SAHS is then presented
as well as their limitations ( such as their problem-dependence).

Finally we proposed to introduce the reader to the Adaptive Multi-Agent System
(AMAS) approach that enables to design self-adaptive and under-specified Multi-Agent
Systems (MAS) through self-organization of the agents. This self-organization also drives
the emergence of the adequate function of the system. This self-organization is driven by
the notion of cooperation between agents. This cooperation is a social attitude that can be

59



State of the Art: Conclusion

modeled by Non-Cooperatives-Situations (NCS) or level of criticality. Finally, for these all
the limitations presented above, we propose in the following part to go further these limita-
tions:

o a new generic SoS model called SApHESIA model that is agent-based and where the
notion of environment is more developed;

o a new SoS architecting heuristic based on cooperation between parts that enables to
architect decentralized SoS such as collaborative SoS;

o a generic tool enabling to experiment generic SoS through SApHESIA model.

Then, these contributions are validated through experimentations available in the third part
of this document.
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Contribution to SoS Modeling
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SApHESIA Model

SoS literature does not propose a huge quantity of generic SoS models. Moreover, ex-
isting ones are not expressive enough, do not enable to model a dynamic environment
and interactions between component systems. In this chapter, we propose a new SoS
model called SoS Architecting HEuriStlc based on Agents (SApHESIA) model enabling
to model more expressive problems than existing SoS models ([Acheson et al., 2012] and
[Baldwin and Sauser, 2009]), to compute them and to use cooperation as a heuristic of SoS
architecting. This chapter presents in details the different parts of the SoS generic model we
propose. Throughout the chapter, this model is exemplified through the Missouri Toy Prob-
lem ([Edward Pape II, 2016]) to evaluate the adequacy of the model with SoS paradigm. The
Missouri Toy Problem has been chosen for its representativeness of a SoS problem and also
because of its simplicity of explanation.

4.1 Presentation of the Missouri Toy Problem

The Missouri Toy Problem is a scenario initially presented by [DeLaurentis et al., 2012]. The
aim of this SoS is to relay commands and ISR data from ground station to a Carrier Battle Group
via Unmanned Aerial Vehicles (UAVs) and Satellites and to check if a communication link is al-
ways up between the ground station and the carrier. The ground station needs the UAVs and

FILA-505 Toy Problem Operational View 1

Sati - Ground Station — 2 Sat Links, 1 UAV link
% - Carrier — 1 UAV link, 1 Sat link
Sat 52}‘ - UAV — 1 Ground link, 2 Sat links, 1 Carrier link
- Choice of 1 of 6 UAVs
v - Choice of 1 of 8 Type A Satellites
- Choice of 1 of & Type B Satellites

2
E

ey

ﬁ 8 ; | U 2

Ground Station :
.-/

Carrier

Figure 4.1 — The Missouri Toy Problem
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satellites because it cannot send signals directly to the carrier battle group. Then, this prob-
lem has been extended by [Edward Pape II, 2016] “for purposes of having a few more systems
to choose from”. More precisely, the following types of component systems can be interfaced
with each other:

o the ground station Ground; its functionality is to send a signal to satellites and UAV;
o the UAV UAV; its functionality is to relay a signal to UAV and other satellites;

o the satellite of type A Sat 4; its functionality is to relay a signal to UAV and other satellites
of type A;

o the satellite of type B Satp; its functionality is to relay a signal to UAV and other satellites
of type B;

o the carrier battle group Carrier; its functionality is to receive a signal from other compo-
nent systems except the ground station;

Every of them can communicate with each other except:

o Ground that cannot interface with Carrier;

o Sat 4 that cannot interface with Satg and vice versa.

Events like cyber-attacks, weather issues, jamming of communication links are unex-
pected events occuring in the environment. Furthermore, the availability of component
systems can perturb interactions between component systems.

The solution proposed in [Edward Pape II, 2016] consists in using an approach based on
a genetic algorithm close to the agent-based wave model presented in chapter 2. As a re-
minder, to compute and evaluate new chromosomes, the global function of this method uses
Key Performance Attributes (KPAs) that are chosen by stakeholders of the SoS depending
on what they want to evaluate such as performance, robustness and affordability.

4.2 General Structure of the SoS Architecting HEuriStlc based on
Agents (SApHESIA) Model

As existing generic SoS models are not expressive enough, do not enable to model a dy-
namic environment and interactions between component systems. We propose the SApH-
ESIA model composed of the main following components: the SoS and the environment.
The SoS is composed of component systems and goals. The environment (containing the
objects and constraints that are not parts of the SoS) is composed of entities and rules. These
components are illustrated in figure 4.2 and detailed in the following sections.

4.3 SoS and Component System Models

This section presents the SoS model and the component system model.
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SoS model Environment model
component entity
system | el
~~~~~ | ‘ rule
component |
system | Y- entity

llFuncIiunnality ll Resource |.|.Funcﬁ0nnality ll Resource
ll Goal |_ Link Goal ‘ Link

Figure 4.2 — Components overview of SApHESIA model

4.3.1 Component System Model

A component system is the smallest part of a SoS, it represents the second S of SoS. Formally,
a component system S is defined as:

S={T,R,Acq,L,F,G,Cost}
where:

o Tis the type of S;

o R ={Ry,..,R,} is a set of resources;

o Acqg = {Acqi, ..., Acqn } is a set of acquaintances with other component systems;
> L= {Ly,..., Ly} is a set of links with other component systems;

> F = {F, ..., F;} is a set of functionalities;

o G = {Gy,..., G} is a set of goals;

o Cost € R is the cost of the component system.
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a) Type

The type enables to model the different types of the component systems in the
SoS. For example, a component system u of type UAV is represented by u =
{UAV/ Ru/ AC”]u/ Lu/ Pu/ Gu/ COStu}-

b) Resource

A resource R; is a structure R; = {type : String, quantity : Float} which represents passive
elements in the SoS (i.e. which has no effector on the SoS itself).

For example, if a component system a is of type Sat 4 in the Missouri Toy Problem, a resource
can be R = {Signal, 1}. It means that a owns one Signal resource.

¢) Acquaintance

An acquaintance is an oriented association between two component systems. It enables to
model the knowledge of a component system by another component system but does not
enable the exchanges of resources between these two component systems. An acquaintance
is associated with a component system and is modeled by a singleton representing the
acquainted component system.

For instance, if an UAV (modeled through a component system u =
{UAV,Ry, Acqu, Ly, Fy, Gy, Cost, } of type UAV) knows a satellite b of type Satp, this
acquaintance ag € Acq, is represented by aq = {b}.

d) Link

A link is an oriented association between two component systems. A link enables to model
of exchange channels between two component systems such as communication channels or
channels of resource exchange. A link owns also a strength of association enabling to repre-
sent that two component systems can be more or less linked together. To create a link with
another component system, a component system must have this one in its acquaintances.
Then, the acquaintance of a component system is a precondition for link creation. Then,
when a component system decides to destruct a link with another one, it may keep it in its
acquaintances, enabling to recreate this link at another time.

For a component system S = {T, R, Acq, L, F, G,Cost}, alink I € L representing the associa-
tion from S to S’ is defined as:

1 = (S, s0a)

where soa €]0,1] is the strength of this association. For instance, in our example if a satellite
(modeled through a component system a = {Sat, R;, Acqa, La, Fa, Ga, Cost, } of type Sat )
has a bad communication channel with a UAV (modeled as a component system u of type
UAV), the link I € L, is represented by I = (u,0.3).
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e) Functionality
A functionality is an effector on the SoS itself. The functionality can affect :
o the resources of component systems;

o the links of component systems.

A functionality F is defined as a triplet :

F:{f.t,p}

where:

o tis the execution time of F;
o p € [0,1] is the performance of F. It represents the probability of F to success.

o f is the function of F. It is defined as:
f : Conditions — Ef fects

Conditions and Ef fects are sets that respectively represent the conditions for the function to
be executed and the effects applied on the SoS or the environment once the functionality is
executed. Conditions may represent:

o a certain quantity of resources;
o the existence of a link between two component systems;

o the existence of a component system.
Effects may represent the change of:

o a certain quantity of resources;

o the existence of a link between two component systems.

To present the different kinds of Conditions and Ef fects, we consider a functional-
ity F; = {fj,tj,pj} € F, with F the set of functionalities of a component system S =
{T,R, Acq,L,F,G,Cost} and f; = {Conditions — Effects}. The next paragraphs present
the different kinds of conditions and different kinds of effects.
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A resource condition Co € Conditions concerns the comparison of a certain kind of re-
source owned by a certain component system and is represented by :

Co = {Sys.R(Re) 0p Qu}
Where:

o Sys € {Self, T’} is the type of component system involved in the condition Co. If the
resource condition concerns the component system S that executes the functionality,
then Sys = Self. It can be also a component system of type T’ linked with S (then,
3l = (S;,s0a) € L|S.T =T');

o Reis a type of resource;

o Sys.R(Re) is the quantity of resource Re in R (the set of resources of the component
system of type Sys);

o Qu € Ris the involved quantity of resource of type Re owned by Sys;

o Op € {=,<,>,<, >} is the comparison operator.

To make the formulas easier to read, when the condition has to apply on the component
system which executes the functionality (Sys = Sel f), the condition will be written as follow
Co = {Re Op Qu}.

For example, Co = {UAV.R(Signal) > 1} is true if S has a link with a component system
of type UAV that owns at least one Signal resource. Co = {Signal > 1} is true if S owns at
least one Signal resource.

A link condition represents the existence of a link between the component system S and
another component system of type T'. It is defined by:

Co = {3l = (5;,s0a) € L|S.T =T'}

Co = {31 = (S;,s0a) € L|S;.T = Satg} is true if the component system S has a link with a
component system of type Satp.

An existence condition represents the knowledge of the existence of a component system
of type T' by S. It is defined by:

Co = {3Ss € Acq|Se. T =T'}

Co = {3S¢ € Acq|Sco.T = Carrier} is true if the component system S knows one component
system of type Carrier.
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A resource effect Ef € Effects represents the generation or the consumption of a given
quantity of resource. It is represented by:

Ef = {Sys.R(Re) Op Qu}
where:

o Sys € {Self,T'} is the type of component system involved in the effect Ef. It can
be the component system that executes the functionality (Self). It can also be another
component system of type T’ that is linked to S (then, 3] = (S;,s0a) € L|S,.T = T');

o Reis a type of resource;

o Sys.R(Re) is the quantity of resource Re in R that is the set of resources of S; or S (de-
pending on Sys);

o Qu € Ris the involved quantity of resource of type Re owned by S; or S (depending on
Sys);

> Op € {=,+=, —=} the operator applied on Sys.R(Re).

Ef = {Signal += —3} means that the component system S will consume three Signal
resources.

A link effect corresponds to the creation of a link from the component system S to another
component system of type T’. It is represented by:

Ef ={T',s0a}

Then, Ef = {UAV,0.7} means that the component system S will create a link towards a
component system of type UAV with a soa = 0.7.

As an example, the component system Ground from the Missouri Toy Problem owns
functionality Fg,,  as:

Fsend : {{Signal > 1} — {{Signal += —1},{Sat,.R(Signal) +=1}},0.01,0.99}

{Signal > 1} is a condition resource. To clarify the syntax, we remind that the compo-
nent system involved is not written when a condition is applied on itself. This is the same
rule for effects. This condition means that the component system needs at least 1 resource of
type Signal to execute f. {Sat4.R(Signal) += 1} is an effect resource. Finally, 7 models that
the ground station is able to send a signal to a system of type SatA. It represents its ability to
produce one signal (this signal is also consumed by the second effect resource) provided that
it has one signal to send. The duration of the process is 0.01 unit of time and the probability
to success is 99 %.
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f) Goal

A goal is the special state a component system tries to reach with a given priority. This state
can be:

o to own of a certain quantity of a type of resource;

o the existence of a link between this considered component system and another one.

A goal can be defined in two different ways.
The first one is to express that a component system tries to own a certain quantity resource:

Gr = {Re Op Qu, Pr}
where:
o Reis a type of resource;

o Qu € R is the quantity of resource of type Re the component system wants to own;

o Op € {=,#, <, >, <, >} is the comparison operator in order to compare Qu to the cur-
rent quantity of Re;

o Pr € IN" is the priority of the goal enabling to model the relative importance of a goal.
The higher the priority is, the more important the goal is.

As an example, a Carrier component system whose goal is to receive signals (that are repre-
sented with the Signal resource) with a priority of 1 is defined as :

Gsignar = {Signal > 0,1}

The second one is used to express that a component system tries to add a link with
another component system of type T'.

G =A{T'}
where :

o T’ is the type of a component system;

o Pr € INT is the priority of the goal.

As an example, a component system of type S trying to add a link with a component
system of type Carrier with a priority of 3 is defined as:

Gr = {Carrier,3}
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44 SoS Model

A SoS is represented by a set of sets:
SoS ={S,G}
where:

o §is a set of component systems ;

o @ is a set of goals; these goals are a subset of the goals of the component systems in S.

As an example, the Missouri Toy Problem is instantiated with the following component
systems:

o 1 ground station Ground (noted g);
> 5 UAV (noted u;,i € [1,5]);

o 8 Sat, (noted a;,i € [1,8]);

o 6 Satp (noted b;,i € [1,6]);

o 1 carrier battle group (noted c).

SoS = {{g, u1, ua, us, us, us, a1,az,as, as, as, as, az,as, by, b, bz, by, bs, bg, c}, G}

The global goal of the SoS is to be able to relay as much as possible the signals from the
ground station to the carrier battle group. Then, the global goals of the SoS can be defined as:
G = {Gcarrier = {Signal > 0,1}, Ggrouna = {Signal ==0,1}}

Gcarrier means that ¢ wants the most Signal resources as possible with a priority of 1.
GGround means that ¢ want zero Signal resource a priority of 1. Gegrrier and Ggroyng are goals
that will be respectively defined in the carrier ¢ and the ground g in the following sections.

4.5 Environment Model

This section contains the model of the environment in which the considered SoS evolves.
The environment contains two mains objects:

o Rules that represent the frame in which the SoS evolves. They enable to model external
constraints that affect the SoS;

o Entities that represent active independent objects that are able to affect the environ-
ment or the SoS itself but which are not parts of the SoS. It is close from the notion of
component system in a SoS.

Formally, an environment is defined as a set of entities and rules:
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& = {E,Rules}
where:

o E is a set of entities;

o Rules is a set of rules.

4.5.1 Entity Model

An entity is an active independent object that is not a part of the SoS. It is defined as a set of
sets :

E;={T,R,Acq, L, F,G}

where:

o T is the type of E;

e R ={Ry,...,R,} is a set of resources;

o Acqg = {Acq, ..., Acqm } is a set of acquaintance;
> L= {Ly,.., Ly} is a set of links;

> F = {F, .., F;} is a set of functionalities;

o G ={Gy,..., G} is a set of goals;

o n,m,p,q,r are natural numbers.

The notions of type, resource, acquaintance, link, functionality and goal are the same as
the one defined in a component system. Nevertheless, an entity can be linked to another
entity or a component system. This is not the case with component systems : they can only
be linked to other component systems.

As an example, in the Missouri Toy Problem, an entity may be a spy satellite able
to cyber-attack the SoS by destructing existing signals of UAV component systems:
Fpestructsignat = {{UAV.Re(Signal) > 0} — {{UAV.Re(Signal) = 0},0.3,0.99}. It can
be also other battle elements such as ships or airplanes that are not in the SoS because they
are owned by another army.

4.5.2 Rule Model

A rule is a set of conditions and effects that enables to model how the environment reacts,
evolves and interact with the SoS:

Rule = {Conditions — Ef fects}

72 Teddy Bouziat



4.5. Environment Model

A rule needs to fulfill its Conditions to apply its Ef fects. A rule affects all the entities in the
environment or all component systems in the SoS that fulfill the Conditions.

As an example, in the Missouri Toy Problem, the resource Signal of the ground g is
generated from the following rule:

Rulesigna = {g-R(Signal) < 10 — g.R(Signal) += g.R(RcGenerationRate) }

Rules;¢uq represents a rule applied on g (which is ground station) on its resource Signal.
When its resource Signal is lower than 10 then Rgeperationrate 1S added to ¢.R(Signal).
RGenerationRate 15 @ resource of g representing the generation rate of signal to send.

4.5.3 SApHESIA Model with SoS Characteristics

To evaluate the compatibility of SApHESIA model with SoS paradigm, Table 4.1 shows
the main components of SApHESIA with regards to the evaluation criteria we defined in
chapter 1 in section 1.4.1 to evaluate generic SoS model.

We remind that, in our working definition, component systems tend to be heterogeneous
in terms of capabilities (i.e., actions). Then, heterogeneity of component systems are given
in SApHESIA thanks to the concept of functionality, resource, goal and cost: Component
systems with different functionalities represent component systems that have different pos-
sibilities of action. Operational independence is also given with functionalities: they enable
the component system to act. Managerial independence is modeled through the concept
of goals: each component system may act by itself for itself. Geographic distribution is
modeled through resource. As an example, an UAV can have Ry, Ry and Rz resources that
represent a position in a space. Component systems can interact with each other through
functionalities, acquaintances and links.

SoS is modeled through its own goal G (enabling to model Directed SoS) and its set of com-
ponent systems S. Metric of evaluation can be defined through the concepts of resources,
goals and cost. As an example, in the Missouri Toy Problem, an interesting metric concern-
ing the efficiency of the SoS can be the ratio between the number of generated signals by
the ground ¢ and the number of signals received by the carrier c. This two numbers can be
given by the resources sets of ¢ and c.

The environment model is dynamic because composed of independent and active entities
as well as rules. Moreover, rules enable to express a non trivial behavior of the environment:
creation of threats such as spy satellite, failure of links through the concept of rule. Finally,
the model has a higher global expressiveness than models presented in chapter 1 because
of a more expressive model of environment and actions (through preconditions and effects
of functionalities).
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Component system ‘ SoS Env

T‘R‘Acq‘P‘L‘G‘CostHQ‘S‘Rules‘Entities

Component system evaluation criteria

Heterogeneity X | X X X X
Operational independence X X

Managerial independence X
Geographic distribution X

Interactions X | x| X

SoS evaluation criteria

SoS model X

Metric definitions X X X

Dynamic environment model X X
Global expressiveness X | X | X | xX]|x]|x X X

Table 4.1 — Adequation of SApHESIA elements to SoS paradigm through evaluation criteria

4.6 Instantiation of the SApHESIA Model to the Missouri Toy
Problem

This section presents the entire model of the Missouri Toy Problem. First, we remind the
SoS composition in terms of component systems and its goals. Then, we remind the differ-
ent component systems involved in the model by presenting the 5 different types of com-
ponent systems: Ground, UAV, Sat,, Satg and Carrier. The different components of the
environment such as rules are then defined.

4.6.1 SoS Model Definition

The SoS is composed of 1 ground station, 5 UAVs, 8 satellites of type A, 6 satellites of type B
and 1 carrier. The main goals of the SoS are that the ground sends all its signals and that all
these signals are received by the carrier:

SoS = {{g/ ui, Uz, Uz, ug,Uus,aq,4a2,43,44,4s5,4¢,47,048, bl/ bZI b3/ b4/ b5/ b6r C}I {GGroundr GCarrier}}

With G = {GCarrier = {Signal > 0,1}, GGround = {Signal == 0,1}}.

4.6.2 Component Systems Definitions

All the component systems as well as their functionalities and goals are defined hereafter.
The different numerical values for resources and cost are given as example:

Ground = {TGroundr RGroundr ACQGround/ LGroundr FGround/ GGround/ COStGround}
With:

& Tground = Ground
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& RGround = {{Signﬂl, 20}; {RLinkResourcez 5}/ {RTurn; O}r {RFinalTurn/ 500}/ {RGenemtionRater 03}}

& ACqGround =0

& LGround =0

& Feround = {Frinkuav, Frinksata, Frinksat, Fsends Funtink }

& GGround = {GLz'nkz GLinkResourcez GSend}

o Costground = 100

Rty is a resource used in the rule Ruler,,, (given in the section describing the environ-
ment) to keep the current simulation cycle. Rrinaiurn and RienerationRate are resources used in
the rule Rulegeneratesignal (given in the section describing the environment). Rpinal Turn rep-
resents the cycle number when Signal is no more generated and Renerationrate the generation
rate of Signal. Gs,,q = {Signal == 0,1} concerns the sending of signals. It enables to model
the objective for Ground to send Signal to other component systems. Gp;,x = {Link > 0,1}
concerns the creation of links with other component systems. It enables to model the objec-
tive for Ground to link with other component systems.

We assume that each component system has limited number of available connections. To
model this constraint, the goal Gprinkresource = {RLinkResource > 0,1} concerning the preser-
vation of the Ry kresource 1S defined to limit the number of link. Then, Ry ;ukRresource 1S iNCre-
mented in the different functionalities of link creation (here Fy;cuav, FLinksata and FrinksaiB)-
As all of these functionalities concerning link creation are similar, we propose this common
definition :

FLinkSyS = {{{Sys € ACC]}} — {{Link,l}, {SyS'R(RLinkResource) += _1}1 tLink/ PLink}

With Sys € {UAV, Sat,, Satp, Carrier}.

Funiink is the functionality used for removing a link:

FUnlink - {{{Sys € L}} — {{Link, _1}/ {SyS-R(RLinkResource) += 1}/ tllnlink/ pUnlink}

With Sys € {UAV, Sat, Satg, Carrier}.

Fseng is the functionality used for sending signal:

FSend = {{Slgnal 2 1} - {{Slgnal += _1}/ {SySR(Szgnal) += 1}}/ tSend/ pSend}

With Sys € {UAV, Sat 4, Satp, Carrier}.

UAV = {Tuav, Ruav, Acquav, Luav, Fuav, Guav, Costyav }
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With:
o Tyay = UAV
& Ruav = {{Signal,0}, {Rpinkresources 5} }
o Acquay = O
o Lyay =@
& Fuav = {Frinkuav, Frinksatas FLinksatB, FLinkCarriers Fsends Funtink }

& GUAV = {GLink/ GLinkResource/ GSend}

(2 COStUAV =100

Sata = {Tsat,, Rsat,» Acqsat 4, Lsat o, Fsat,» Gsat,» COStsat, }
With:

& Ty, = Saty

& Rgar, = {{Signal, 0}, {RpLinkResources 5} }

o Acqsg, =D

& Lsgt, =@

& Fsat, = {Frinkuav, FLinksatAs FLinkCarriers Fsend, Funtink }

& GSatA = {GLink/ GLinkResource/ GSend}

o Costgy, = 100

Satg = {Tsaty, Rsatys ACqsaty, Lsaty, Fsaty, Gsaty, COStsaty }
With:

o Tsu, = Satp

& Rsar, = {{Signal, 0}, { RpinkResources 5} }
o Acqsg, =@

& LSatB =0

& FSatB = {FLinkUAV/ FLz‘nkSath FLinkCarrier: PSend/ Fllnlink}
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& GSatB = {GLinkz GLinkResourcw GSend}

o Costgge, = 100

Carrier = {TCarrierr Rearriers ACﬂ]Carrierr Lcarriers Fcarriers Gearriers COStCarrier}
With:

& Tcarrier = Carrier

& Rcarrier = {{Signal, 0}, {{RLinkresource, 5} }
o Acqcarrier = D

& Legrrier = @

& Fearrier = O

& Gearrier = {{Signal > 0,1}}

o Costcgrrier = 100
we model the send of a signal by the following function :
Fsenatosys = {1Signal <1} — {{Signal += —1},{SyS.R(Signal) += 1}, tsend, Psend }

With Sys € {UAV, Sat, Satg, Carrier}.

As a reminder, Sat, and Satp component systems are not able to link together, and the
Carrier component system does not link with other component systems. Table 4.2 sums up
the different functionalities available for every type of component system.

Table 4.2 — Available link functionalities according to the type of component system

Ground | UAV | Saty | Satg | Carrier
Frinkuav X X X X
Flinksata X X X
FlinksatB X X X
FLinkCarrier X X X

4.6.3 Environment Definition

The environment of the Missouri Toy Problem contains two rules and no entities. The first
one, Ruler,, increments the resource Rr,,,, of ground g which contains the number of cycles
of the simulation. This information will be used in the next presented rule. The second
one, Rulegeneratesignal 1S used to generate signal in ground g. Here, we use Ry, to stop the
generation of signals at cycle Rrju 7. In this way, we can limit the number of generated
signals during a simulation.
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Rulety;n = @ — {Ground.R(Rryr,) += 1}

Rulegeneratesignat = {Ground.R(Ryyrn) < Ground.R(Rrinaiturn)} — {Ground.R(Signal)+ =
Ground.R (RGenemtionRate) }

4.7 Conclusion

We present a new generic SoS model and instantiate it to the Missouri Toy Problem. First,
we verify that SApHESIA model is adequate in regards of evaluation criteria we defined in
chapter 1 (table 4.1). From a SoS literature review, we highlight a lack on existing models
concerning the ability to model the dynamics of the environment, the interactions between
component systems and non-trivial problems. To fulfill these lacks, we extended the notion
of environment enabling to model more detailed and dynamic problems through the con-
cept of entities and rules. Then, we improve the model of interactions between component
systems through oriented links enabling interactions (by exchanges of resources) and the
strength enabling to model their intensity. Moreover, our model is more expressive than ex-
isting one because of the creation of the condition and effects of functionalities that enable to
model, for example, resource flows or object creations and a more detailed environment de-
scription. Furthermore, the model enables the creation of metrics through resources, goals
and the notion of cost. Metrics will be used in our experimentation to evaluate the archi-
tecture solution given by our formation heuristic proposed in chapter 7. Finally, to check
that our model is able to model SoS, we propose to model a well-known SoS problem which
is the Missouri Toy Problem. To solve SoS problem, we will propose in the next chapter a
generic algorithm for using cooperation between component systems in a SoS.
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Cooperative SoS Architecting
Heuristic Based on Criticality

This chapter presents a cooperative SoS Architecting Heuristic based on criticality. To pro-
vide this decentralized and generic SoS Architecting Heuristic, we propose a decentralized
decision algorithm based on the Adaptive Multi-Agent System (AMAS) approach that uses
cooperation as a social behavior between agents [Capera et al., 2003]. This approach enables
to develop complex systems where the global function emerges from the self-organization
of parts of the system. To drive self-organization, agents use the concept of cooperation
(see chapter 3) between each other and their environment. This chapter will present a way
to compute this cooperation through the concept of criticality as well as an algorithm of
cooperation for component system in a SoS.

5.1 Through a totally Decentralized SoS Behavior

Centralized heuristics are useful when architecting directed and acknowledged SoS: the SoS
entity is used to negotiate the services that the component systems can provide to the SoS.
But the use of the SoS entity disables the architecting of collaborative and virtual SoS because
they do not own a centralized entity (see chapter 1 for more details). Then, centralized SoS
architecting heuristics such as Agent Based Wave and Collaborative Model (presented in
chapter 2) cannot be used for all types of SoS. Moreover, we show that they cannot cope
with a dynamic environment and fails to respect the open interface principle (i.e., add/re-
move component systems during functioning). Then, we will propose an decentralized
architecting heuristic where the SoS will have the ability to cope with a dynamic environ-
ment, respecting the open principle interface and enabling to architect collaborative and
virtual SoS without the help of the SoS entity.

5.2 The Criticality: Metric of Cooperation

The criticality is a concept used in the AMAS approach; an agent helps the more critical
agents of its neighborhood (including itself). A first definition of the criticality is given by
[Lemouzy, 2011]: The criticality of an AMAS agent is a metric representing the distance between
its current state and the final state it tries to reach.
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The term distance has been chosen because it is generic enough to enable the designer to
instantiate it depending on his problem. Indeed, the designer can choose a temporal, spatial
or even logic distance. Nevertheless, this one is too generic: when AMAS designers create
their own metric of criticality for their systems, these ones are problem-dependents and
then are not reusable for other AMAS they develop. To fill these gaps, this section presents
works on formalization of the criticality. Our first work on criticality exclusively focuses on
the AMAS approach (but will be reused in our SoS architecting heuristic). Then, a formal
definition of the criticality is presented and its instantiation through a simple example of
resource transportation system is addressed.

5.2.1 Formal Definition of Criticality

To formalize the notion of criticality, we propose to formally define the two following sen-
tences: (1) the current state of an agent and (2) the final state it tries to reach.

As previously said, an AMAS agent pursues a Perception — Decision — Action cycle. Dur-
ing its perception cycle, the agent updates its perception on itself (i.e.; its internal state) and
its environment. We propose to define the current state S, of an agent a (1) as the result of
its perception phase. The perceptions of an agent are obtained thanks to a set of sensors given
by the AMAS designer. We propose to define the output of each of these sensors as a func-
tion p;(t) (i € IN). As an example, a sensor can be a temperature sensor where the output
function will be the numerical value of the temperature given by the sensor. We propose
to formally define the current state S,(t) at time ¢ of an agent as the set of its perceptions
(containing the set of perceptions of its internal state) at time ¢ :

where P(t) = {pi(t), ..., pu(t) } is the entire set of perceptions of the agent a at time ¢.

The final state an agent tries to reach (2) relies on the notion of objective or goal. Then,
to be coherent with (1) we propose to define the final state it tries to reach as a particular state
S¢oal the agent a tries to reach concerning a subset of its perceptions:

Sgoal = {plgonl’ e pmguﬂl}

where {plw, )
of the agent).

s Prgoq } CONCerns a subset of P (i.e., Sgp1 does not concern all the perceptions

From these definitions, we presented in [Bouziat et al., 2014] a first generic and com-
putable metric of criticality of an agent i defined as:

Ci(t) = F(pl (1), ..., Pm(t)/ Sgoul)
Where:

& Sgoal = {P1gyurs s Pmgoq } 18 the final state the agent i tries to reach.

o p1(t), ..., pm(t) is a subset of the current perceptions of the agent i;
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o Fis a mathematical function chosen by the designer of the AMAS.

Then, criticality of an agent is defined as a function taking a subset of perceptions and
its goals concerning these perceptions as inputs. Then, the work of the designer is to define
F as well as to choose rigorously the perceptions p;(t), ..., p(t) and the associated goals to
compute the criticality.

But, this metric is not useful if it is used alone. Indeed, the criticality is an instant metric
that only gives the level of difficulty of the agent at a time ¢. But according to the AMAS ap-
proach, to be cooperative, an agent must choose the action that helps the most critical agent
of its neighborhood (including itself) without making another agent more critical than the
most critical. In term of criticality, this sentence can be translated as follow: to be cooper-
ative means that the agent must choose the action that reduces the criticality of the agent
with the highest criticality without increasing another criticality above this one. To do that,
an agent has to know the result of each of its action in term of criticality. That is why, we
propose the notion of anticipated criticality to address this purpose.

5.2.2 One Step Further: The Anticipated Criticality

To be compliant with the AMAS theory, an agent action cannot lead intentionally to a future
Non-Cooperative Situation (NCS) with its neighborhood. Before performing an action, the
agent will ask to agents around it the effects (regarding to their criticality) of an action 4. That
is why the agents compute the anticipated criticality. Formally, the anticipated criticality
for an action a represents the next criticality an agent will have knowing the effect of its
next action a. It enables the agent to predict the effect of the action a on its own criticality.
Formally, the anticipated criticality of an agent i for an action a is defined as:

CAi(t,a) = Ci(t) + Eff(a)

with C;(f) the criticality of 4 at time t and Eff(a) a function giving the effect in term of
criticality for the action a. Finally, the anticipated criticality can be defined for a sequence of
actions A = {ay,ay,...,a,} as:

CAi(t,A) = Ci(t) + Zie[[lln]]Eff(al-)

5.2.3 Example of Criticality Instantiation

To give a concrete example of the concept of criticality, we present here a resource trans-
portation system that is a simplified version of CoCaRo described in the chapter 8. We only
introduce here the main elements of the system to give an understandable example of the
use of the criticality. The overall objective of the system is to transport resources dispersed
through the environment towards a main area called a nest. This system is composed of a
finite group of robots (that are agents) that can do the following actions :

o to move randomly on the environment;

o to deposit a resource on the environment;
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o to take a resource from the environment;

o to go to a particular point on the environment.

Moreover, each robot has an initial amount of energy (equals to Maxy;,) consumed at each
movement implying that each robot has a finite life time. However, each time a robot drops
a resource in the nest, it refills its energy level. This refill can be seen as a reward in the form
of energy allowing the robot to remain longer active. The defined perceptions of each robot
are the following:

o to detect a box around it;
o to detect other agents around it;

o to know its level of energy.

To make the robots surviving as long as possible, it seems natural to choose the following
objective for the robots: “Bring back as much as possible resources to the nest”. To fulfill this
objective, the robot owns a useful perception that is its own level of energy. Indeed, if its
level of energy is high, then it can move in the environment and find a lot of resources. On
the contrary, if the level of energy is low then it has strong chances to run out of energy
and to become not useful anymore. Then, the local objective of a robot which is to bring
back as much as resources as possible can be translated to "Maximize its level of energy”. The
criticality C;, of a robot agent r; is defined as:

Ci(t) = Maxy, — Ne,,(t)
With:

o Ne,,(t) the perception of energy level of the robot r; at time f;

o Maxy,, the possible maximum level of energy (i.e., the constant related to the goal of
maximizing its energy level).

Concerning the anticipated criticality, the effects of the different actions of r; is calculated

as follow.
conso if a = move
£ =0 Dt Seente)
0 if a = pickup(b;)
Where:

o conso the energy level units consumed during one time unit;
o move is the action to move randomly on the environment;

o dist(bj,7;) € R the distance between resource b; and robot i;
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o go(b;) is the action of moving to resource bj;

o deposit(b;) is the action of dropping the resource b; in the nest.

By noting the sequence of actions of bringing back a resource b; to the nest bback(b;) =
{go(bj), pickup(b;), go(nest), deposit(b;) } The anticipated criticality of bback(b;) is calculated
as follow:

CAl'(t, bback(b])) =
Ci(t) + Effi(go(by)) + Ef fi(pickup(b;)) + Ef fi(go(nest)) + Ef fi(deposit(b;))

Finally, figure 5.1 sums up how the criticality and the anticipated criticality can be used
during the Decision step of the agent. In this example, robot ; can choose between two
resources (b and V') to be rewarded. The anticipated criticality enables to know that bringing
back b is better for it because

CA;(t,bback(b)) < CA;(t,bback(l'))

Indeed, the total path to pick up b and bring it back to the nest is less long than b’ (d; + d;, <
dy +dv’).

Figure 5.1 shows also how the criticality and the anticipated criticality enable cooper-
ative decision: if robot r; perceives a robot r,, the idea is to communicate criticality and
anticipated criticality for the detected resources. If the two robots are in conflict on the same
resource, then the two robots have to choose the sequence of actions that will minimize in
priority the highest criticality without making another criticality higher than the highest one.
In this way, the behaviors of robots are totally cooperatives because it enables the most critical
agent to fulfill its goals in priority. In this example, the anticipated criticalities for bringing
back b and I’ are given by the numerical application of CA;(t, bback(b;)) (with reward = 100
for this example):

o CA;(t, bback(b)) = C1 +dq + dy, — reward = 20
o CA;(t,bback(V')) = C1 +d| + dy — reward = 50
o CAj(t, bback(b)) = Co +dy + dy — reward = 10
o CA;(t, bback(V')) = Co +d) + dyy — reward = 70
Then, even if r; is the most critical and b is better for it, it will choose b’ because if r; brings

back V', criticality of r, will be higher than the one of ;. For more details, the complete
cooperation algorithms and simulations are presented in the chapter 10.

5.3 Instantiation of Criticality for SApHESIA

In this section, our objective is to re-use the concept of criticality in SApHESIA to pro-
pose a generic cooperative decision algorithm for architecting SoS. In this aim, we pro-
pose a generic formulation of the concept of criticality for a component system based on
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dq4=30
b
C4 =60
d> =40
do =230
ry
Nest
dy =50
do' = 40
Cz=40
2
b’

Figure 5.1 — Agent cooperative decision through criticality

the SApHESIA model. Then, we propose a decision algorithm (that we have proposed in
[Bouziat et al., 2016] and extended in [Bouziat et al., 2017]) based on this criticality metric to
enable cooperation between component systems.

We propose to integrate the concept of criticality used in the AMAS approach within the
SApHESIA model. To do that, we define the criticality according to the resources and goals
of a component system. To represent the current state of a component system, we use the
perceptions it has on its current resources. To represent the state it tries to reach, we propose
to use its goals. In this way, the criticality for a component system is totally compatible with
the criticality definition we gave in section 5.2.1. We remind that the component system S is
defined as a set of sets such as (see chapter 6 for more details): S = {T, R, Acq, L, F, G, Cost}
and a goal ¢ € G is defined as a particular level of resources it tries to reach:

¢ = {Reop Qu,Pr}
where:
o Reis a type of resource;

o Qu € R is the quantity of resource of type Re the component system wants to own;

o Op € {=,#,<,>,<, >} is the comparison operator in order to compare Qu to the cur-
rent quantity of Re;
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o Pr € INT is the priority of the goal enabling to model the relative importance of a goal.
The higher the priority is, the more important the goal is.

Then, we define a criticality for each goal g contained in the set of goals G for the com-
ponent system S. This criticality has to represent the distance of fulfillment of this goal
g. For example, if the goal g concerning the resource Re is to reach a given quantity Qu
(g-0p € {=}), then the criticality of g has to be high if Re is ‘far’ from the objective and low
otherwise. In the same way;, if the goal g concerns a resource Re that has to be greater than a
given threshold quantity Qu (g.0p € {>,=>1}), then the criticality of ¢ has to be high if the
resource is smaller than the threshold and low if the resource is greater than the threshold.

To represent these different cases, we propose to use the following functions for the
calculation of the criticality of the goal g at time  Cq(#):

1
(1):1- oD (t)

(2): eaxig(t)
Cy(t) = I
5(t) atan((a x Ag(t)) + 5
(3):1— T

I1
@): atan((a xrAIg(t)) + 5

(1): if g.0p € {=}: the goal g is to reach a given quantity Qu of resource Re;

(2): if g.0p € {#}: the goal g is to be as far as possible from a given quantity Qu for the
resource Re;

(3): if g.0p € {<,=<}: the goal g is to be inferior or equal to a given quantity Qu for the
resource Re;

(4): if g.0p € {>,=>} the goal g is to be superior or equal to a given quantity Qu for the
resource Re .

With :

o> A¢(t) = g.Qu — S.R(g.Re)(t) is the difference between the given quantity Qu and the
current amount of resource Re of S;

o S.R(g.Re)(t) is the current amount of resource Re of component system S at time ;

o wais a coefficient value that influences the shape of the curve.

These sigmoid functions have been chosen because their shapes fit with the meaning
of each goal. Examples of these functions are given in the annex 2. Moreover, one issue
of [Lemouzy, 2011] was that the criticality of its different systems was not calculated in the
same norm: a first AMAS could have its criticality in an interval I; = [, 7] and another one
in I, = [B/,7/]. Then [Lemouzy, 2011] proposes, without developing it, to do a translation
of criticality values of I; from ;. To simplify and get out of this problematic, we choose
functions that give numerical values in the interval [0, 1].
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To calculate the criticality Cs(t) of a component system S from the criticalities of its goals
G (given by each Ci(t), with ¢ € G), we calculate the weighted average of all its goals
criticalities:

_ Teea(Cylt) x g.Pr)
ZgEG (g.PT)

Cs(t)

With ¢.Pr, the priority of goal g.

Finally, this formula of the criticality for component systems is adequate with the first
definition of the criticality (given in section 5.2): we compare the current state of a compo-
nent system (represented by its resources) with the state it wants to reach (represented by
its goals). This calculation is central in the cooperative decision algorithm presented in the
next section.

5.4 Cooperative Decision Algorithm for Component Systems (of a
SoS)

We present here a decision algorithm for component systems based on criticality and antic-
ipated criticality comparisons between component systems. Here, a component system is
modeled as an autonomous entity that pursues a Perceive — Decide — Act cycle. This deci-
sion algorithm is incorporated in the Decision phase of the component system and enables
it to choose the most cooperative action (here a functionality).

Algorithme 5.1 : Cooperative component system S; decision.

1 CoopTable As Dictionnary < Functionnality, Dictionnary < ComponentSystem, List <
Float >>>;

2 forall f € F; do

3 forall S; € L; U Acg; do

4 CoopTable(f)(S;) = CoopTable(f)(S;) U askAnticipatedCrit(S;, f) ;

5 forall Sy € (L; U Acg;) do

6 ‘ CoopTable(f)(S;) = CoopTable(f)(S;) UaskAnticipatedCrit(S;, Sk, f) ;

7 end

8 Sort CoopTable(f)(S;);

9 end

10 end
11 return minmaxFunc(CoopTable) *Choose f that minimize the max of criticality*;

Basically, each component system S; = {T;, R;, Acqg;, L, F;, G;, Cost;} does two important
actions: construct the cooperative table and choose the most cooperative functionality. These
two actions are presented in the two next paragraphs.
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Construction of the cooperative table: The aim of this procedure is to construct a table
where lines contains the anticipated criticalities for all the neighborhood of S; (given by
L; U Acg; ) depending on the potential execution of each functionality f of S;. For example,
the first line of the table 5.1 contains all the anticipated criticalities of the neighborhoods of
S; if this one apply its functionality F; on S;. The second line contains also all the anticipated
criticalities its neighborhoods but if it apply F; on S; and so on.

Then, each S; asks for the anticipated criticality of its neighborhood (in Acg; and L;)
for each functionality f € F; of its available functionalities. This request is made by the
function ask AnticipatedCrit(S;, f) (line 4 of algorithm 5.1). This function takes a component
system S; and a functionality f and returns the value of the anticipated criticality of S; if S;
apply f on S;. Then, this anticipated criticality is saved in a new line (identified by a cou-
ple (S;, f)) of the cooperative table (CoopTable in the algorithm 5.1). Then, the anticipated
criticalities of other component systems (including S;) are added to this line through the
function ask AnticipatedCrit(S;, Sy, f) that returns the anticipated criticality of Sy if S; apply
f on §; (line 6 of algorithm 5.1). Then, the lines contain the anticipated criticalities of its
entire neighborhood (including S;) if S; apply f on S;. Finally, all the lines are sorted from
the highest criticalities to the lower one (line 8 of algorithm 5.1).

This table is implemented through a dictionary. The term dictionary has to be un-
derstood as an abstract data type composed of a collection of (key, value) pairs, such
that each possible key appears at most once in the collection. Then, this table is imple-
mented through a dictionary where the keys are the functionalities and the values are
also dictionaries where the keys are component systems and the values are lists of floats
Dictionnary < Functionnality, Dictionnary < ComponentSystem, List < Float >>> in al-
gorithm 5.1).

Choose the most cooperative functionality: In the AMAS approach, when an agent has
several choices concerning its next action, it will choose the one that minimizes the max-
imum of the anticipated criticalities. We propose to use the same approach here. Then,
once the cooperative table is built, S; chooses the functionality that is the most cooperative
in terms of criticality: the one that minimizes the maximum of the anticipated criticalities
thanks to the minmaxFunc(CoopTable) function that return the function f to apply. The de-
tails of minmaxFunc(CoopTable) is given by the algorithm 5.2 and is explain more in details
here through the table 5.1:

Table 5.1 presents the anticipated criticality of the neighborhood of a component system
S; when applying the available functionalities F; on the component system S;. Knowing
the lists of all expected criticalities for all of these functionalities, S; will compare the first
float of each line (given by CoopTable(f,s)(currentLevel)) to choose the functionalities that
lead to the minimum of the maximum of the criticality. Indeed, the first float of each line
(i.e., the first column of the cooperative table) is the maximum of each line because the table
is already sorted. In the algorithm 5.2, this operation is made from line 8 to 22. If several
lines give the same minimum, then the variable currentLevel is incremented and the second
float of each line also given by CoopTable(f,s)(currentLevel) (i.e., the second column of the
cooperative table) is compared and so on.
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Anticipated criticalities of
S; neighborhood

511085 | 047 | 011 | 0.05
Fi appliedon | S, | 0.95 | 0.28 | 0.09 | 0.08
S3| 071 | 041 | 0.31 | 0.29
511099 | 080 | 074 | 0.65
F, appliedon | S, | 0.71 | 041 | 0.35 | 0.08
S3 1077 | 075 | 033 | 0.15
S1] 071 | 047 | 0.11 | 0.05
Fzappliedon | S, | 071 | 041 | 031 | 0.22
S3 1095 | 058 | 047 | 0.31

Table 5.1 - Example of sorted anticipated criticalities table for a component system S;

Detailed example with the table 5.1: In table 5.1, the functionalities that enable to choose
the minimum of the maximum of criticalities are F; on S3 , F, on S; and F; on S, (because
the minimums of the maximums of criticalities are 0.71). Here, three functionalities lead to
the same minimum of maximum (0.71), then the second elements of the lists (corresponding
to the second column of the cooperation table because the lines are sorted) is compared.
In this example, this second comparison does not eliminate any functionality (because the
three have the second criticality equals to 0.41). But the third comparison eliminates F, on 5,
(because F, on S, gives a third criticality of 0.35 and the two others 0.31). This algorithm is
repeated until only one functionality is remaining. If several functionalities are remaining,
a random choice is done because they are equivalent. Finally in this example, the last is F3
on Sy and will be the choice returned by minmaxFunc(CoopTable). This behavior leads to
minimize the maximum of neighborhood criticality. Indeed, each component system tends
to “help" his neighborhood by choosing the functionality that, in the worst case, causes the
minimum raise of criticality.

Let’s take a SoS SoS = {S;, ..., S, } where:
o Vien,S; = {T;,R;, Acg;, L, F;, G;, Cost;}
o Vi € n, Cg,(t) is the criticality of S; at time ¢
o currentLevel is the column index of the CoopTable that is being compared;

o minF,minS the functionality and the component system giving the minimum of criti-
cality.

5.5 Complexity Analysis of the Decision Algorithm

We propose to analysis the complexity of the proposed algorithms 5.1 and 5.2 to validate the
effectiveness in time execution of our approach.
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Algorithme 5.2 : minmax function applied on CoopTable

1 /*Find f and S; containing the min of the max of expected criticalities*/

2 (Functionality, ComponentSystem) minmaxFunc(CoopTable As
Dictionnary<Functionnality, Dictionnary<ComponentSystem, List<Float»>):

3 currentLevel <— 0 ;

4 minF,minS +— @ ;

5 while currentLevel < Length(CoopTable)) do

6 minCrit +— 1;

7 minF <— @ ;

8 for f € CoopTable do

9 minS +— @ ;

10 for S € CoopTable(f) do

11 current «<— CoopTable(f,s)(currentLevel) ;
12 if current < minCrit then

13 current +— minCrit ;

14 CoopTable(f).remove(minS) ;
15 minF <— f;

16 minS <—s;

17 end

18 else if current > minCrit then

19 CoopTable(f).remove(s) ;

20 end

21 end

22 end

23 currentLevel + +

24 end

25 return (minF, minS) ;

5.5.1 Complexity analysis of the algorithm 5.1

Let S; a component system such as S; = {T}, R;, Acq;, L, F;, G;, Cost;}. The size of a set A is
noted |A|. The complexity of this algorithm depends of the three for loops in line 2, 3 and
5 where the number of calls are respectively |F;|, |L; U Acg;| < |L;| + |Acq;| and |L; U Acg;.
During the simulation, S; does not have new functionalities, then |F;| is static. As previ-
ously said, a component system can have functionality to create link with other component
systems, then |L;| can vary during the simulation. Finally, the acquaintances are updated
through the perception phase of the component system (described in section 6.3.1) but this
set is bounded. Let B, the static upper bound of |Acq|. Then, we propose to analyze the
complexity of this algorithm with the variation of |L;|. Let ¢; the execution time of line i and
Cs.1(|L;|) the complexity in time of 5.1 in function of |L;|:

Cs.1(|Li|) = ca X |F| + |E| % (3 X (Bacg + |Lil) + (Bacg + |Li|) X (ca + 5 X (Bacg + | Lil) +

(Bacg + |Li|) x c6 +cg)) +c11
With:
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o cp = ¢4 = 5 = ¢ = O(1) because are simple operations;

o cgis asorting of a line of the CoopTable and as previously said, a line contains the antici-
pated criticalities for all the neighborhood (given by L; U Acg;). Finally our sorting func-
tion is implemented in JAVA that specifies that the sorting operation is implemented
as a modified mergesort, an algorithm offering a guaranteed n x log(n) performance.
Then cg = O((|Li| + Bacg) x log(|Li| + Bacg)) = O(|Li| x log(|L;i|));

o line 11 is a call to the algorithm 5.2, then cq; is equal to the complexity of the algorithm
5.2 presented hereafter.

By developing and replacing the different c;, the highest term is given by the multiplica-
tion of cg with (|L;| + Bac,). Then, excepting the complexity of c1; that is computed hereafter,
the highest term gives a complexity of O(|L;|> x log(|L;|)) for algorithm 5.1.

5.5.2 Complexity analysis of the algorithm 5.2

Let S a component system such as S; = {T;, R;, Acq;, L;, F;, G;, Cost; }. The complexity of this
algorithm depends of the while loop of line 5 and two for loops in line 8 and 10 where the
number of calls are respectively |L;| + |Acq;|, |Fi| and |L;| + |Acqi]-

Then , the complexity in time of the algorithm 5.2 is given by:
C5,2(‘Li’) = (3+C4+C5 X (‘Li’ + BAcq) + (|Li‘ + BAcq) X (C6 +c7 + ‘Fi’ X cg + |Fi‘ X (Cg +
|Fi| x c10 + |Li| % (c11 + Ci2 + c13 + €14 + €15 + €16 + C18 + €19)) + €21

o c14 and cq9 are guaranteed with a performance of O(1) because these lines concern
removing operations on a Dictionary;

o the remaining lines have a complexity of O(1) because they are simple operations.

Finally, the development of Cs»(|L;|) gives as a highest term of degree 2, then
Cs2(|Li]) = O(|Li]?). Then, in algorithm 5.1, c;; = O(|L;|?). Then, by replacing this com-
plexity in Cs1(|L;]), we conclude that Cs1(|L;|) = O(|L;|*> x log(|L;|)).

Then, our the complexity analysis of our approach shows a quasi-quadratic complexity
with the number of links for each component systems. Then, to guarantee a constant time
execution at the component system level, we propose to limit the number of links given by
|L;| for a component system S;. To do that, we propose to add a resource Rpjukresource € Ri
that :

o decreases when S; creates a link with another component system;
o increases when S; unlinks with a component system;

o is used as a condition of functionality of link creation in the following way:

FLinkSyS = {{5}/5 € ACQ} — {Link, 1}/ {SyS-R(RLinkResource) += _1}think/ PLink}
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In this way, if the component system is defined with Rpjkresource = 4, the maximum
number of links of the component system is 4. Then, the time execution of its cooperative
algorithm is bounded, guarantying a linear complexity of our approach with the number of
component systems.

5.6 Conclusion

We propose a formal definition and a calculation of the criticality concept used in the AMAS
approach. Then, after proposing an example of a transportation system, we propose a
cooperative decision algorithm for component systems based on criticality comparisons.
First, this heuristic is fully decentralized because decisions are only made by the compo-
nent systems. Then it enables to get ride off a centralized management for finding solu-
tions and model collaborative and virtual SoS. Using cooperation, this heuristic ensures
self-organization because of the theorem of functional adequacy (see chapter 4). By self-
organizing, this heuristic enables to architect SoS that self-adapt and where the adequate
functionality emerges from the parts. Then, our heuristic is open (component systems can
be added/removed during functioning from the SoS). It is able to cope with a dynamic en-
vironment and is robust to openness. Furthermore, based on our generic model of SoS, this
heuristic can be used on any kind of SoS problems (military, economics, science and so on).
Concerning computationality, the model as well as our algorithm can be can be easily in-
stantiated because it is based on a documented generic model and on precise and explained
algorithms. Then, the limited perception of a component system (through the upper bound
of the set of acquaintances) and the limitation of the number of links (thanks to Rpnkresource)
guarantee a linear complexity with the number of component systems. Finally, our heuristic
tulfills our evaluations criteria concerning the evaluation of SoS architecting heuristics (see
section 2.2). Chapters 7, 8, 9 and 10 propose experimentations to validate these points.
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SApHESIA tools for SoS
Architecting

The objective of this chapter is to present the tools that enable to run SoS architecting ex-
periments based on the cooperative decision algorithm for component systems presented
in the previous chapter. To make SoS architecting tests, we first searched existing platforms
that are able to model and run scenarios for SoS architecting. We conclude that they do not
enable to implement easily a new SoS language as SApHESIA Modeling Language (SML).
We decided to develop SApHESIA tools, a set of tools enabling to run experiment of SoS
architecting. This chapter presents in details the functioning of SApHESIA and its main
functionalities. This platform has been used for implementing the whole of our experiments
on SoS Architecting.

6.1 General Presentation

The SApHESIA tools consists of 2 components: SoS and Environment generator and the
core architecting. The main objective of the generator is to transforms the SML files to
binaries that are usable for the core architecting. Figure 6.1 shows that the generator is
composed of the SML parser and compiler and the GUI generator. The main objective of
the core architecting is to run and show the results of the experiment. Figure 6.1 shows that
this one is composed of two main components: the SApHESIA architecting engine and the
SApHESIA viewer. The next sections describe more in details these two components.

6.2 SoS and Environment Generator

The main objective of the generator (the blue part of figure 6.1) is to generate the binaries for
the tests. The inputs of this component are the description of the SoS and its environment.
This description is given to the SML Parser & Compiler through the GUI generator that
enables the user to manually create and/or modify a SoS and/or its environment. Figure
6.2 shows the main view of the SApHESIA tools enabling the modification of component
systems and figure 6.4 shows the main view of a functionality creation. Moreover, it enables
to add or remove component systems and entities during the experiment. All the different
properties of a component system can be changed (Resources, Links, Goals and so on). In
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Figure 6.2 — Main view of SApHESIA tools

this way, the designer can see in at runtime what the effects of his changes on the SoS are.
Nevertheless, this GUI generator can be fastidious for creating from scratch a huge SoS, that
is why the designer has the possibility to use the SML Parser & Compiler through SML files
containing a predefined SoS and environment. The result of the SML Parser & Compiler is
a fully loaded model ready to test. Once the model is loaded, the experiment is ready to run
by the core architecting (the red part of figure 6.1).
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Scenario S08 Environment Viewer

layComponentSystems| )

i

playEntities()

v

pla‘,rR.uIesn

Figure 6.3 — High level sequence diagram of SApHESIA Engine

6.3 SApHESIA Core Architecting

The main functionality of the core architecting of SApHESIA tools is to run step by step the
test defined by the SoS and environment generator. This one is composed of the SApHE-
SIA Engine and Viewer which respectively runs a loaded SApHESIA model and enables to
visualize results of the tests.

6.3.1 SApHESIA Engine

SApHESIA Engine is the core of our tools. This component runs the experiment by using the
components (SoS and environment) loaded with the SML Parser & Compiler. The sequence
diagram 6.3 (presenting one experiment cycle) shows that the engine is composed of several
modules detailed hereafter: the scenario, the SoS and the Environment modules.

a) Scenario Module

The scenario module is the main module of the SApHESIA engine. It enables to run the SoS
and the environment modules. Figure 6.3 shows the main sequence diagram of the SApH-
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Figure 6.4 — Example of a functionality creation

ESIA engine: at each step of the experiment, the SoS module is called to run the component
systems of its SoS. Then, the environment module is called to run the entities and the rules.
Finally, viewer module is called to update information the user wants to display (level of
resource of a component system and so on).

b) SoS Module

The SoS module contains the component system submodules. At the beginning of the ex-
periment, there is one component system module creation by component system in the SoS.
The component system module simulates the behavior of a component system in the SoS.
A component system module uses a Perception — Decision — Action cycle. The next para-
graphs detail theses three phases. Figure 6.5 details the behavior of a component system
during experiment.

Perception: The perception phase of a component system S = {T, R, Acq, L, F, G, Cost} en-
ables to update its acquaintances set Acq. More precisely, S adds new component systems
in its acquaintances and remove some others. In this way, this phase enables to simulate a
component system with changing perceptions. Initially, Acqg is empty for all the component
systems. At each turn of the experiment, S detects new component systems or entities. The
maximum number of new component systems detected can be set at the beginning of the
experiment in the SML file with the tag < AddPerception >. For example, for a maximum
number of 6 component systems detected, the following text has to be added to the com-
ponent system declaration:< AddPerception > 6 < /AddPerception >. Once a component
system or an entity is detected, this one is put in the Acg set of the component system. In
the same manner, a number of component systems in Acq will be removed. This number is
set at the beginning of the experiment in the SML file with the tag < removePerception >.
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Figure 6.5 — Perceive — Decide — Act cycle for three component systems 51,52 and S3
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Decision: The decision phase of a component system consists in the decision algorithm
based on cooperation presented in the chapter 5. As Acq has changed during the percep-
tion phase and because the anticipated criticality of all the component systems in L and Acg
have possibly changed, the algorithm constructs a new cooperation table. Then, it chooses
the functionality that helps the most critical component system (including itself) by min-
imizing the maximum of the anticipated criticality of its neighborhood (see chapter 5 for
more details).

Action: Once the component system has taken its decision, the functionality is executed.
As an example, let’s take a functionality F = {f,t, p} with f = Conditions — Effects. At
this action phase, the Conditions are applied. At the action phase t cycles after this one, a
random number r € [0,1] is compared with the probability p. If r <= p (F succeeds), the
ef fects are applied. If r > p (F fails), the effects are not applied and the conditions are
canceled. As an example, if S applies this functionality,

Fsenatosys = {1Signal <1} — {Signal += —1},{SyS.R(Signal) +=1},2,0.99}

Then, at this cycle, one Signal € R resource is consumed. Then, 2 cycles after this one
and if Fsenarosys succeeds, the effects are applied: the component system Sys get one Signal
resource. if Fseg1os5ys fails, the Signal resource is not consumed for S.

¢) Environment Module

The environment module executes the module representing the entities and the one repre-
senting the rules. In the same manner as the modules of the component systems, a mod-
ule is generated for each entity in the environment. The entity module works also on a
Perceive — Decide — Act cycle. Finally, the rule module that contains all the rules in the
environment is also executed.

6.3.2 SApHESIA Viewer

When a experiment is running, the SApHESIA Viewer automatically shows in another win-
dow the data that the user chooses to display. The data can be resources, criticality and so
on. In this way, the user can visualize the state of component systems. For example, in the
Missouri Toy Problem, user can easily display how many Signal has been sent and how
many Signal has been received. Links between component systems and entities can also be
visualized as showed in figure 6.2. Figure 6.7 shows an example of graph than can be dis-
played. This figure displays the number of Signal owned for each component system (the
graph to the left) and the number of links created by each component system (the graph to
the right). As shown in figure 6.3, the viewer is updated once the component systems of the
SoS and the entities in the environment have been executed.
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Use cooperative
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Figure 6.6 — SApHESIA component system behavior

6.3.3 Implementation of SApHESIA

SApHESIA has been implemented in JAVA language. JAVA has been used because it is a
well maintained programming language that is based on the Object paradigm close to the
agent paradigm. Indeed, the Object paradigm owns the concept of properties and methods
that are useful to represent the Perception — Decision — Action cycle of an agent. Figure 6.8
shows the main classes used to implement SApHESIA tools.

We propose concrete examples of each element of the SApHESIA model in the annex A.

6.4 SML: SApHESIA Modeling Language

SML is the XML based language used to save and load SoS experiments through the SML
Parser & Compiler. It enables to declare each type of element (component system, entity,
rule and so on) of the SApHESIA model. The following sections present in details the syn-
tax to declare the different elements of the model such as component system, SoS and the
environment. Each element of the model is presented through a hierarchical tree where
each node represents a XML keyword usable to declare a property of a SApHESIA element.
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<Child1>: Type
<Child2>: Type
<Child3>: Type

T: <Child3.1>: Type

6.4.1 SoS and Component Systems

This section presents the syntax for SoS and component systems.

a) Component System

This section describes how to declare a component system in SML. In SApHESIA model, a
component system S is declared as:

S={T,R, Acq,L,F,G,Cost}

Then, the associated SML for a component system is the following:

<System>

—{ <Name>: String

—{ <Type>: String

<Resource>

<Type>: String

<Quantity>: Float

—{ <Acquaintance>

L [<To>: String

<Intensity>: Float

<To>: String

— <Functionality>: String

% <Goal>

— <Object>: String

—{ <Type>: String
% <Value>: Float |

-—{ <Priority>: Float

4| <Cost>: Float |
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An example of component system described in SML is given in annex A.

b) Functionality

A functionality F in SApHESIA language is declared as follow:

Fi{f.tp}

where:

o f is the function of F defined as: f : Conditions — Ef fects;
o tis the execution time of F;

o p € [0,1] is the performance of F. It represents the probability of F to success.

Then, the associated SML for functionality is the following;:

<Functionality>

— <Name>: String

<Name>: String

<Quantity>: Float

T

<Name>: String

<Quantity>: Float
[

4 <Time>: Float |
—' <Performance>: Float |

An example of functionality described in SML is given in annex A.

¢) Conditions and Effects

Conditions can be used with the following structures concerning each type of conditions
(i-e., link, existence and resource conditions):
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<Type>: String

<Name>: String

This first definition can be used for link and existence conditions. For example, to define
a link condition to a SatA component system, the following syntax is used:

<Condition >
<Type> Link </Type>
<Name> SatA </Name>
</Condition>

Concerning resource condition, the definition is the following :

<Condition>

— <Type>: String

— <Name>: String

— <Quantity>: Float

L—{ <Operator>: ResourceOperator

With:
ResourceOperator € {==, SUP, SUPEQ, INF, INFEQ}

Conditions can be used with the following structures for the link and resource effects:

<Type>: String

<Name>: String

If a link effect is to create a link to an UAV component system, the following syntax is
used:

<Effect >
<Type> Link </Type>
<Name> UAV </Name>
</Effect>

Concerning resource effect, the definition is the following:

<Type>: String

<Name>: String

<Quantity>: Float
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d) Goals

Goals can be of one of both kinds: Link or Resource. For a link goal, the following structure

has to be used:

<Type>: String

<Object>: String

For example, if a goal is to create a link to the Carrier component system, it has to be
declared as:

<Goal>
<Type> Link </Type>
<Object> Carrier </Object>
</Goal>

For a resource goal, the following structure has to be used:

<Goal>

— <Type>: GoalOp

— <Object>: String

— <Quantity>: Float

L <Priority>: Float

With:

GoalOp € {EQ, NEQ, SUP, SUPEQ, INF, INFEQ}

For example, if a goal is to get zero resource of type Signal, it has to be declared as:

<Goal>
<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority > 1 </Priority >
</Goal>
e) SoS

A SoS is composed of component systems. To declare a SoS, the following structure has to
be used:
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<S0S>

— <ComponentSystem>

L=

—{ <ComponentSystem>

L

—L]

An example of SoS described in SML is given in annex A.

6.4.2 Environment

This section presents the syntax for the elements of the environment that are entity and rule.

a) Entity

This section describes in SApHESIA language how to declare an entity. The structure is
close to component system one. The associated SML for entity is the following:

<Entity>

—{ <Name>: String

—{ <Functionality>: String

— <Acquaintance>

L] <To>: String

<Intensity>: Float

<To>: String

<Resource>

<Type>: String

<Quantity>: Float

% <Goal>

—{ <Object>: String

—{ <Type>: String
% <Value>: Float |

L <Priority>: Float

4| <Cost>: Float |
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b) Rule

A rule is composed of conditions and when these are fulfilled, effects of these conditions
are applied. Rule can be applied on resources and links of component systems and entities.
A rule RuleExpression is defined as:

RuleExpression = S.R(Re) 0p S’.R(Re)
With:

o Sand S’ are component systems or entity types.
o S.R(Re) the number of resource Re owned by S;
o S'.R(Re) the number of resource Re owned by §’;

& op € {EQ, NEQ, SUP,SUPEQ, INF, INFEQ}.

<Rule>

—{ <Condition>: RuleExpression

— L]
— <Effect>: RuleExpression

—L]

As an example, hereafter a rule generating the resource Signal to the component system
Ground when this one has its resource Rp, greater than 0:

<Rule>
<Condition>
"Ground.R_On” SUP 0
</Condition>
<Effect>
"Ground. Signal © EQ ’"Ground.Signal” + 0.09
</Effect>
</Rule>

Then, at each step of the experiment, Ground component system generates 0.09 Signal re-
source to itself.

6.5 Conclusion

As SoS architecting tools are domain-dependent and/or not available in the public domain,
this chapter proposed a set of tools in order to model and run easily SoS experiment through
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6.5. Conclusion

the SApHESIA model. The GUI generator and our language called SML enables to trans-
late a SApHESIA model to a computable model usable by our tools. The GUI also enables
to change dynamically the SoS composition by adding or removing component systems or
entities. Thanks to the viewer, user can display useful data that enable to validate our SoS
architecting heuristic based on cooperation through different scenarios. The following chap-
ters present experimentations that use these tools to validate our heuristic.
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Instantiation of our SApHESIA
Model to the Missouri Toy
Problem

This chapter presents the Missouri Toy Problem (introduced in chapter 6) that is one of the
tirst SoS example studied in this field. The aim of this chapter is to show that our heuris-
tic based on cooperation can resolve this problem in a totally decentralized way by finding
new architectures without recalculating the entire solution in a dynamic environment (by
triggering component systems failures). By "solution", we mean an architecture that tends
to be the most functionally adequate, efficient and robust. To evaluate these three crite-
ria, we define and use evaluation metrics described in the following sections. Then, the
model is tested and discussed through specific scenarios containing disturbing events such
as component systems failures.

7.1 Presentation of the Missouri Toy Problem

The Missouri Toy Problem is a SoS architecting scenario initially presented by
[DeLaurentis et al., 2012]. The goal of this SoS is to Relay commands and ISR data from ground
station to a Carrier Battle Group via Unmanned Aerial Vehicles (UAVs) and Satellites. The ground
station needs intermediary component systems such as UAVs and satellites because it can-
not send signals directly to the carrier battle group. This problem has been extended by
[Edward Pape 1II, 2016] “for purposes of having a few more systems to choose from” (i.e., to pro-
pose a more complicated problem). The following types of component systems can be inter-
faced with each other:

o the ground station Ground, its functionality is to send a signal to satellites and UAVs;
o the UAV UAYV, its functionality is to relay a signal to UAVs and other satellites;

o the satellite of type A Sat 4, its functionality is to relay a signal to UAVs and other satel-
lites of type A (not to satellites of type B);

o the satellite of type B Satp, its functionality is to relay a signal to UAVs and other satellites
of type B (not to satellites of type A);
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o the carrier battle group Carrier, its functionality is to receive a signal from other compo-
nent systems except the ground station;

Every of them can communicate with each other excepting:

o Ground that cannot exchange with Carrier;

o Sat, that cannot exchange with Satp and vice versa.

Perturbations in the environment can be events such as cyber-attacks, weather issues, jam-
ming of communication links and the availability of component systems.

7.2 Evaluation Criteria and Associated Metrics

This section presents and defines the evaluation criteria and the associated metrics we pro-
pose to evaluate them. Each of our criteria is formally defined in the following section.

7.2.1 Functional Adequacy

We want to propose a decentralized architecting heuristic that leads to a SoS that is func-
tionally adequate (i.e., it achieves the expected overall function from the viewpoint of an
external observer who knows the SoS purpose). To validate its adequacy, we propose a met-
ric that will enable to evaluate the overall behavior of the SoS in relation with what it has
made for (i.e., its functional adequacy): the SoS has been designed to communicate signal
from the Ground station to the Carrier one (each one represented by a component system).
We propose as a metric of functional adequacy the ratio TTS (Total Transmitted Signal) be-
tween the number of Signal resources that are generated by the Ground and the number of
Signal that are effectively received by Carrier:

GS
With:
o GS corresponding to the number of generated Signal by the Ground component system;

o RS corresponding to the number of received Signal by the Carrier component system.

7.2.2 Efficiency

As a reminder, [Edward Pape II, 2016] uses the concept of Key Performance Attributes
(KPAs) to evaluate SoS architecture proposed by its SoS architecting heuristic based on
Based-Wave model (presented in chapter 2). One of this KPA, for the Missouri Toy Prob-
lem, comes from Functional Dependency Network Analysis (FDNA). In few words, FDNA
is a technique used in Logistics to evaluate the impact on the operability (also called per-
formance) of a group of systems where dependencies between each other system exist. In
FDNA, the group of systems is represented through an oriented graph where each node 75
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represents a system S and each oriented link represents a dependence between two systems.
To represent operability, each S node owns a calculated value of operability. Moreover, each
link owns a given and static value vgg representing the strength of dependence of S for S'.

All of these strengths of dependence are represented through a M, (R") matrix where each
coefficient a;; represents the strength of dependence of system i to system j. Operability
of each system is based on the average of the operability of S’s dependencies plus the as-
sociated strengths of dependency. Then, giving the operability of root nodes (i.e., with no
predecessors) the operability of each node can be sequentially computed, starting from the
root nodes, in a breadth-first way: after the roots, nodes directly depending on the root are
analyzed, and so on. A strong limitation of FDNA is the obligation to use acyclic graphs,
because loops lead to infinite sequential computation. In [Edward Pape II, 2016], FDNA en-
ables to define a KPA on the SoS performance where each node represents a component sys-
tem. Then, the operabilities of component systems can be computed and, finally, operability
computation of the Carrier component system gives an indication about the performance of
the proposed SoS architecture (i.e., the more the Carrier operability is high, the more the SoS
architecture is efficient).

We propose to re-use this approach with matrices to model the different efficiencies of
component systems to send signals between each other and deduce the overall SoS effi-
ciency. In SApHESIA model, the pg.,; value represents the performance when the Fs,,
functionality is used by a component system. Then, to be efficient, the SoS has to use the
most efficient component systems (i.e., the ones having the best pg,,;). To evaluate this effi-
ciency, we propose to use a metric that represents global cost of the SoS called Cost. This cost
metric is inversely proportional to the efficiency of the 50S. Indeed, the lower the cost is, the
more efficient the SoS is. To compute Cost, we propose to change the Fs,,; functionality by
adding a new effect with a new resource called Rcpstsend :

Fsena = {{Signal > 1} — {{Signal += —1}, {Rcostsena += 1}, {Signal +=
—1},{SyS, Signal +=1}}, tsend, Psend }

With Sys € {UAV, Saty, Satg, Carrier}. The Fs,,y functionality represents the sending of a
signal between two component systems. It consumes one Signal and generates one Signal
to the component system of type SyS. In this way, Rcpstsend saves the number of times the
component system is used to send a signal. Then, the following cost metric is proposed:

Cost = ZSiGS(Si-COSt + Si-R(RCostSend))

To compare the Cost of the current SoS architecture with the Cost of the most efficient ar-
chitecture (called MinCost), we will compute the ratio between these two values. More
precisely, MinCost is the minimum cost for transmitting all the signals between Ground and
Carrier for a given scenario. Thus, MinCost is calculated for the scenario and compared with
the current cost of the architecture. The resource Rcystseng contains the total ‘cost” a compo-
nent system for sending its signals. This resource is incremented through the functionality
Fseng of each component system. Formally, the ratio is defined as:

:_ Cost
CostRatio = MinCost
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Table 7.1 — Evaluation metrics for the Missouri Toy problem

Functional adequacy | Efficiency | Robustness
TS CostRatio | TS evolution

7.2.3 Robustness

[IEEE, 2010] defines the robustness as "the degree to which a system or a component can
function correctly in the presence of invalid inputs or stressful environmental conditions".
To evaluate robustness of our SoS architecting heuristic, we define events during the sce-
nario representing failures of component systems. A failure disables the component system
to use its functionalities (i.e., it cannot receive, send signals or link with other component
systems). To cope with these failures, the SoS has to self-adapt through the behavior of the
component systems that will find and use other component systems that are able to send sig-
nals. Finally, we propose to evaluate the robustness through the evolution of TTS. Indeed, if
the SoS is not robust, the failure of a component system will stop the adequate functioning
of the SoS, then the transmission of signals to the Carrier will be interrupted. Thus, TTS
will not evolve anymore. Finally table 7.1 summarizes the metrics used for each evaluation
criteria.

7.3 Scenarios Description

This section describes the scenarios by giving the available component systems for the SoS,
the initial values of the different component systems resources and the description of the
scenario.

7.3.1 Available Component Systems and Initialization Values

The SApHESIA model used in these scenarios is exactly the same as proposed in chapter 6.
The SoS is composed of 21 component systems of different types:

o 1 Ground g;

o 5UAV u;,i € [1,5];
o 8Saty a;i € [1,8];

o 6 Satg b;,i € [1,6];

o 1 Carrier c.

The main goal of the SoS is to assure robust transmission from the Ground to the Carrier.
Each type of component system is initialized with the parameters given in table 7.2.
Rsignat = 0 means that any component system owns Signal to send at the beginning of
the simulation. Rgesourcerink i set to 1 for all the component system to avoid too much links
creation between component systems when the functionality Fy;sys is used:
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Table 7.2 — Resources initialization of the Missouri Toy problem component systems

g | uy | uz | ap | az | Other UAV | Other Saty | Satp | ¢

Rsignal 0001010 0 0 0 0
RResourceLink 0 1 1 1 1 1 1 1 1
Rcostsend 1111111 2 2 2 X

Table 7.3 — Parameters of SApHESIA Engine

0.1
0.1

Reinforcement link

Destruction link

FLinkSyS = {{{Sys € ACC]}} — {{LGk, 1}/ {SyS-R(RLinkResource) += _1}1 tLinks pLink}

The consumption of Ry ;ykresource Py this functionality avoids the component systems to
create too many links between each other. The SApHESIA engine is initialized with the
parameters contained in 7.3. Then, each link intensity is decreased of Destructionlink = 0.1
when the component system does not used it in terms of functionality. At the contrary if
the link is used, the intensity of this one is increased of 0.1 (thanks to Reinforcement link).
Concerning the total number of signal to transmit, the rule Rules;q,, (defined in section
4.6.3) generates Signal with a rate of §.R(Rgeneationrate) = 0.09 until cycle 2000. Then, the
total number of signals is equal to 180 (0.09 x 2000).

7.3.2 Minimum Cost Calculation

The table 7.5 gives the different performances of the Fs,,; functionality for each component
system. For example, the UAV 1 has a performance of 0.5 when sending a signal to Satellite
a1. Empty cells correspond to a 0. The values have been chosen to make a path more efficient
that all the other paths. Then, this table enables to calculate the most efficient path for
the 180 signals to transmit, i.e., the one with the highest performances (because composed
of component systems with the highest performance): Ground — uz — a3 — Carrier.
Concerning Rcpstsend, the value for each component system is given in table 7.2. Then, these
value enable to compute MinCost:

MinCost = 180 X Xg,c0pti(Si-Cost + S;.R(R¢ystsend) )

With: Opti = {Ground, uz,as}.

Finally, the numerical application (thanks to table 7.4 and 7.5) gives MinCost
180 x (GT"OuTld.COSt + wu3.Cost + az.Cost + Ground.R(RCostSend) + u3°R(RCostSend) +
a3.R(Rcostsend)) =180 x (1 +1+1+1+1+1) = 1080.

Table 7.4 — Cost of each component system

Cost 1 1 2 1 2 2 1 2 1 2 2 2 2 2 2 2 2 2 2 2 2
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Table 7.5 — Performance pge,q of Fsepg functionality

G uq %3 s iy us aq ap as ay as ag ay ag by by b3 by bs bg C
G 0.7 0.1 0.4 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
up 0.1 0.1 0.1 0.1 0.5 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
Uy 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
us 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.9 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
Uy 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
us 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
ap 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 1
ap 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
az 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 1
ay 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
as 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
ag 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
ay 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
ag 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
by 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
by 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
b3 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
by 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
bs 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
bg 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
C

7.4 Scenario 1: Functional Adequacy, Efficiency and Robustness
Testing

This first Scenario has been defined to evaluate the functional adequacy, efficiency and ro-
bustness of SApHESIA on the Missouri Toy Problem. From cycle 0 to 2000, every component
systems are keeping up and running. At cycle 2000, the failure of the component system a3
occurs. Then, every other component systems will not able to link or send signal to a3. This
event is used to study the robustness of the SoS. If the So0S is able to adapt the path in an
efficient manner, the new path should be Ground — u; — a; — Carrier because these com-
ponent systems have the second best pg,,; (calculated thanks to table 7.5). At the same time
(cycle 2000), the generation of signals will be interrupted. This event is important because
it enables to compare at the end of the simulation the number of generated signals and the
number of received signals (through the metric TTS). At cycle 7000, the simulation is over.

7.5 Scenario 2 Description: Strong Robustness Testing

Scenario 2 has been defined in order to generate more failure events to better test robustness
of the SoS. A component system failure is now generated every 100 cycles to see how the
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functioning of the SoS is impacted. As component systems do not have the same perfor-
mance on Fg,,,4, the order of component system failures has consequences on the evolution
of the SoS functioning. Indeed, if all the component systems with a good performance fail
tirst, the SoS will have more difficulty to recover from failures. Thus, 3 sequences will be
created where the position of the failures of the most efficient component systems (a1, a3,
u1, uz) will be changed. Then, the sub-sequence < ay,a3, 11, u3 > will be respectively, at
the end (scssy), at the middle (s,,04iu,) and at the beginning of the sequence (sjqq4). Ground
and Carrier are not concerned as they are respectively the source and the destination of the
signals; their failures stop directly the sending of Signal:

& Seasy = {uZI Ug,Us,02,04,05,06,47,08, bl/ bZ/ b3/ b4/ b5/ b6/ ai,as,uq, 1/l3}
& Smedium = {uZ/ Uy, Us,0a2,404,05,06,01,03,U1,U3,47,048, bl/ bZ/ b3/ b4/ b5/ bé}
& Shard = {ﬂl, ﬂ3, ul/ u3/ MZI l/[4, l/[5, aZ/ a4/ a5/ a6/ IZ7, a8/ bl/ b2/ b3/ b4/ b5/ b6}

The TTS metric will be used to highlight the inability of the SoS to send a Signal from
Ground to Carrier.

7.6 Results Discussion

7.6.1 Scenario 1

Figure 7.1 shows the simulation results for the scenario 1. The curves CostRatio, Signal,
Criticality and TTS show respectively the evolution of the CostRatio, Signal resource, criti-
cality and TTS of the different component systems. The curve F_Send_UAV1&3 shows the
number of times on the last 500 cycles the Ground has used Fs,,,y on u; and u3. The curve
F_Send shows the total number uses of Fg,,; by the component systems and with which
component systems it was used.

After the first cycles of the simulation, TTS begins to increase (the number of signal

transmitted is growing). Then, the SoS finds its functional adequacy early. Before cycle
2000, figure Fs,,; shows that Ground uses u3 more than u; to send signal, showing that the
most efficient path is used.
After cycle 2000 (corresponding to the failure of az), TTS is always increasing, showing
that the SoS is still running even if a failure has occurred proving a first sight of robustness
of the SoS. TTS is highly increasing after turn 2000 because the generation of signals is
over. Moreover, CostRatio increases even more after cycle 2000 because the failure of a3
leads u3 and u; to find alternative paths that are less efficient than Ground — uz — a3 —
Carrier which is the current most efficient path. The Fg,,; curve shows that finally u; is
preferred to u3 because of this new most efficient path (Ground — u; — a; — Carrier). The
F_Send_UAV1&3 curve confirms that the most used component systems are Ground, u;,
u3, a; and az. Finally, CostRatio < 1.4, shows that even with failures, the SoS finds efficient
alternative paths.

Ground starts by searching other component systems through the perception phase and
creates links to them (to fulfill the Gy, goal). At the beginning, Ground does not choose
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Figure 7.2 — Scenario 2: Evolution of TTS for the three sequences scsy, Simedivm and sparq

always the most efficient component system for it (17 and uz). Once the first links are
created, Ground starts to send signals to other component systems (thanks to the newly
created links). But, the pg,,,s limits the success of sending signals to less efficient component
systems. For example, if Ground chooses u; (ps.ns = 0.1), only 1 sending attempt on 10
is successful. But, during this time, the link self-destructs through the link destruction
mechanism (here LinkDestruction = 0.1). The link is often destructed before a signal is sent
(for less efficient component systems as u5). It happens that Ground success to send signals
to the less efficient component systems, but in this case, Ground does not send another
signal because the criticality of the component system is increasing (through goal Gs;jgar)-
Then, less efficient component systems becomes "overloaded" by signals they transmit at
a very low rate because of their low pg,,4. Finally, most efficient component systems are
mainly used because they succeed to send signals because of their high pg,,s. In this way,
SoS will make emerge the most efficient path.

7.6.2 Scenario 2

Figure 7.2 shows the evolution of TTS for the second scenario dealing with the robustness
testing. Green, orange and red curves are respectively the results for the Sessy, Spedium and
Shard sequences of failures. Firstly, these results show that the order of failures has an im-
portant impact on the global functioning of the SoS as the functionalities of the component
systems have different performances concerning Fg,,;. The TTS evolution shows that the
SoS is no more able to send Signal at cycle 1000 for sy, at cycle 800 s,,04iu, and at cycle
400 for sp,4. A failure appearing every 100 cycles, the SoS is able to cope with a failure
rate of 52% (10 failures), 41% (8 failures) and 21% (4 failures) respectively for Seasy, Siedium
and sy, for a total of 19 component systems. This scenario illustrates the robustness of the
SoS driven by our cooperative heuristic: even with several component system failures, the
SoS is able to find alternative architectures to continue the sending of signals. These alter-
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native architectures are found thanks to the ability of each component system to find new
neighbors.

7.7 Conclusion

In the first scenario, the SoS, through the cooperative behavior of the component systems, is
able to find architectures that are robust, functionally adequate and efficient according to
our metrics. The scenario 2 confirms the robustness of our approach with in the worst case,
a failure rate of 21%. Finally, The comparison of our solution with [Edward Pape II, 2016]
has been difficult because the results are barely legible to compare it properly. The different
curves of its experiments show global tendencies such as the evolution of the KPAs (such as
Affordability and Performance) but the extraction of concrete data such as the best architec-
ture is not possible (see figure 7.3) because of a lack of explanation. But, our decentralized
heuristic has intrinsic advantages. For example, [Edward Pape II, 2016] does not use direct

cooperation between component systems, disabling experiment on virtual and collaborative
SoS.
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CoCaRo: a Resource
Transportation System

This chapter presents the instantiation of SApHESIA to a resource transportation system
called CoCaRo (Color Carrier Robot) as well as obtained experimental results. This system,
partially described in chapter 5 to introduce the concept of criticality in the AMAS approach
has been used to validate two main hypotheses. The first one is that the use of the criti-
cality enables cooperation between agents, improving the effectiveness and the robustness
of an AMAS. The second one is the capability to use SApHESIA to reify an AMAS as a
component system in a SoS. To reach these two hypotheses, three variations of the CoCaRo
system are studied. The first one is the CoCaRo system without any cooperation between
constituent elements. The second one is the CoCaRo system with cooperation through the
exchange of the criticality between elements. Finally the last one is the CoCaRo system us-
ing SApHESIA and cooperation between elements. The first section introduces the CoCaRo
system. Then, the second section describes more in details the three variations of the Co-
CaRo system. Finally, the third one presents the experimentations done and discusses the
obtained results.

8.1 General Description

CoCaRo (Color Carrier Robot) is a resource transportation system by mobile robots. A robot
(that may be red, blue or green) has to find and pick up a box (that also may be red, blue
or green) and to drop it in an area (called the nest) having the same color as the box. Each
robot has an initial amount of energy that it consumes at each movement, but when it drops
a box in a nest, it receives a reward of energy allowing it to remain longer alive. The value
of the reward depends on the color of the dropped box compared to the color of the robot
(i.e., a red robot gets a better reward if it drops a red box). The next sections describe the
environment and the agentification of CoCaRo.

8.1.1 Environment

The environment is composed of three different types of objects:

o The Displacement Grid: it is an object of the plan, made of 50x50 square cells. A cell may
be empty or may contain a robot, a box and/or a nest;
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o the Nest: it is an location in which robots drop boxes. The grid contains three nests (one
blue, one red and one green) that are equidistant from each other in order to prevent
bias related to the proximity of two nests.

o the Boxes that can be carried and dropped into nests by robots. A box can be red, blue
or green. Boxes appear randomly on the grid, at regular time intervals.

8.1.2 CoCaRo as a Multi-Agent System

CoCaRo is composed of a single type of agent, the robot agent. The robot agent has its own
states, attributes, perceptions and actions.

a) Perception

Each robot perceives (under a given perception limit, that will be given for the simulation)
boxes around it. Two variables are used, the first one is used to save the box the robot wants
to carry (the targeted_box variable) and the second one to save the box it is carrying (the
carried_box variable). These two variables are used hereafter in the decision phase of the
robot.

b) Actions and States

A robot agent performs one of the following actions:

o move, to move on the grid according to a Monte Carlo distribution until it finds a box;
o deposit, to drop a box on the grid or on a nest;
o take, to pick up a box from the grid;

o g0, to go to a particular cell on the grid.
A robot agent has four states:

o carried: the agent is carrying a box;

o target: the agent has targeted a box;

o onPosBox: the agent is on the same cell as its targeted box;

o onPosNest: the agent is on the same cell as the nest corresponding to its carried box.

The agent chooses the most appropriate action according to its current state and its percep-
tions. The table 8.1 sums up them.
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States Actions

—target \ —carried move

target go(targeted_box)
target N\ onPosBox take(targeted_box)
carried A —onPosNest | go(nest)

carried A onPosNest | deposit(carried_box)

Table 8.1 — Agent actions

¢) Energy Level

Each robot can move on the grid thanks to an energy level that is given at the beginning of
the simulation and received when it deposits a box in a nest. The energy level decreases of
a value of conso at each time unit. When its energy level reaches zero, the robot cannot be
used anymore: it is "dead". For a robot r;, the energy level at time t is noted Ne,, (t). We call
B the set of boxes in the environment and B,, = {b; € B} the subset of boxes the robot r;
brought back to the different nests between the time 0 and ¢. Then,

N, (t) if0 < N, (t) < Maxye
Ne,,(t) = ¢ Maxy, if Ny, (t) > Maxy,
0 else
with:
o N, (t) = N+ Yp, recy,(bx) — conso x t
o conso, the number of energy level units consumed during one time unit;
o Maxy,, the maximum energy level;
o N;, the initial energy level;

o recy,, the reward function depending on the box color.

These differences of reward enable to simulate a specialization of each group of robots.
Then, red robots are more efficient to bring back red boxes, blue ones to bring back blue
boxes and finally green ones to bring back green boxes.

Consequently, the value of the reward depends on the box color. We call color the func-
tion that returns the color of a robot or a box given in parameter. If the robot r; brings back
a box by of its own color (color(by) = color(r;)), then the reward is higher than for the other

colors:
2% Maxy, if color(by) = color(r;)

recy (by) = { 1

3 * Maxy, else

d) Speed

Each robot has a defined speed that depends on the energy level and is modeled by the
function Speed. Thus, Speed,(t) is a function representing the speed of agent r;. As this
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speed decreases with Neri(t), it enables to represent that a robot is less efficient when its
energy level is low:

if 2« Maxne < Ney,(t) < Maxye

if 2 Maxne < Ney,(t) < 3 x Maxye
if 0 < Ney, (t) < 3 * Maxy,

else

Speed, (t) =

O WIRN— =

For example, if the energy level of r;, Ne. () is lower than % * Maxy,, then it will take 3 time
units for the robot to move to an adjacent cell.

e) Criticality and Anticipated Criticality

As presented before in chapter 5, the criticality indicates the level of difficulty of a robot
agent and is defined according to its energy level (see chapter 5 for more details). In CoCaRo,
the effectiveness of an agent related to its energy level may rapidly decrease. In this context,
the agent is less effective when it has a lower level of energy and therefore deteriorates more
rapidly. The criticality C,, of a robot agent r; is a temporal function calculated as follows:

Ci(t) = Maxy, — Ney,(t)
With:

o Ne,,(t) the perception of its energy level at time ¢;

o Maxy,, the constant related to the goal of maximizing its energy level.

The anticipated criticality of an action a represents the future criticality of an agent if the
next action it performs is the action a. It enables the agent to predict the effect of an action on
its own criticality. Formally, the anticipated criticality of an agent i for an action a is defined
as:

CAi(t,a) = Ci(t) + Ef fi(a)

with C;(t) the criticality of agent i at time ¢t and Ef f;(a) a function giving the effect in term
of criticality if the action a is done. Finally, the anticipated criticality can be calculated for a
sequence of actions A = {ay, 4y, ...,a, } as the following:

CAZ'(t, A) = Ci(t) + Zieﬂl,n]] Effl(ﬂl)
For the robot agent r;, the effects of the different actions of r; is calculated as follow:

conso x dist(bj,r;)  if a = go(bj)
conso x dist(nest,r;) if a = go(nest)
—recy,(b;) if a = deposit(b;)
0 else

Eff"i(a) =
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Where:

o go(b;) (respectively go(nest)) is the action of moving to the box b; (respectively to the
nest nest);

o dist(bj,7;) € R (respectively dist(nest,r;)) is the distance between the box b; (respec-
tively between the nest nest) and the robot r;;

o deposit(bj) is the action of dropping the box b; in the nest of the same color;
o conso is the battery level units consumed during one time unit;

o recy,, the reward function depending on the box color.

If the sequence of actions for bringing back a box b; to the nest is defined as bback(b;) =
{go(b;), take(b;), go(nest), deposit(b;) }, the anticipated criticality of bback(b;) is calculated as
follow:

CAy(t, bback(bj)) = Cy(t) + Effr(go(by)) + Effr(take(bj)) + Effr(go(nest)) +
Eff;,(deposit(b;))
The anticipated criticality allows the robot agent to know the criticality it is going to get

once the box b; is dropped in the nest. Thanks to this function, the agent can choose the most
beneficial box for it (i.e., the box offering the most energy for it).

8.2 Description of the Three Systems: No Cooperation, With Co-
operation, With SApHESIA

The case study of CoCaRo has to show the usefulness of the cooperation algorithm based on
the criticality and the usefulness of SApHESIA to reify an AMAS as a component system. To
reach these aims, three systems have been implemented. Each of these systems is described
in the following sections.

8.2.1 System 1: Non Cooperative Agents

In this system, robot agents do not use any cooperative mechanisms. An agent is looking
for the most interesting box in order to get a maximum amount of energy and therefore to
transport a maximum of boxes. In this system, the agents do not try to exchange boxes even
if it could be advantageous for them.

Decision Algorithm - The decision algorithm is described in the algorithm 8.1 by read-
ing only the black part. To achieve its goal (to maximize its energy level), a robot agent
applies this algorithm using its current criticality and its anticipated criticality. At each turn
of the simulation, the robot computes its anticipated criticality (line 3 or 6) depending on its
state (carrying or targeting a box). After updating its perceptions (line 8), the robot checks if
it has detected a box enabling to get more energy than it would have with the one it carries
(line 9 to 23). If it has found a better box and was carrying a box, it drops it (line 19).
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8.2.2 System 2: Cooperative Agents

In this system, robot agents are cooperative. They can exchange boxes between them ac-
cording to their current and anticipated criticalities.

Decision Algorithm The decision algorithm of a cooperative robot agent is described
in algorithm 8.1 by reading the black and the red parts (the red parts are also surrounded
by comments Begin/End cooperative part). When a robot agent r; detects a box by enabling it
to get more energy (line 11), 7; checks if the box is already owned by a robot agent r; (line
12). If it is the case, the agent r; sends a message to r; which contains the criticality and
the anticipated criticality of 7; for the box by (line 13). These information make the agent
rj to choose either to exchange the box by (if r; does not become too critical because of the
exchange), or to keep it (if 7; becomes too critical because of the exchange). This choice is
made in the function coop_request_processing (line 25) and detailed in the algorithm 8.2 that
runs as follow:

The agent r; carrying the box by considers at each time step ¢, the cooperative request
received at t — 1. As it is cooperative, the agent r; has to determine if the request sender r; is
more critical than it (line 1), in which case r; has to give the box to r;. For that, r; compares the
anticipated criticality of r; with the current criticality of ; and then checks if the exchange
does not cause a criticality increase (line 2) otherwise the exchange is refused (line 7). If the
agent r; determines that the request sender 7; is less critical than it (line 10), r; compares its
own anticipated criticality with its current criticality and then checks if the exchange does
not cause a criticality increase (line 11) otherwise the exchange is refused (line 12). The
functions accept_exchange and refuse_exchange notify the sender of the request if 7; accepts
or refuses the exchange.

The following variables are used in the algorith 8.1

o CAcurrent, the current criticality of 7;;
o temp_C,, the temporary minimal criticality given by boxes around r;;

o wisible_boxes, the boxes perceived by 7;.

8.2.3 System 3 : Instantiation of SApHESIA Model

To validate our architecting cooperative approach for SoS, we decide to instantiate CoCaRo
as a SoS by using SApHESIA model. The main idea is to create 3 "meta"-robots, each repre-
senting a group of robots modeled as a component system of the SApHESIA model. Each
group of robots of the same color is considered as an AMAS and may be reified as a com-
ponent system (red, green and blue) of a SoS. While defining these 3 component systems
(forming a SoS), their goals, functionalities, resources and links have also to be defined.

a) Justifications for Using SApHESIA

At a first glance, it seems that there is no need for SApHESIA in this kind of system. Accord-
ing to the AMAS approach, the cooperation between elements of the system is sufficient to
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With SApHESIA

Algorithme 8.1 : Decision for a cooperative robot agent r;

1 while N,(t) # 0do

2 if carried then
3 ‘ CAcurrent = CA;,(t, bback(carried_box))
4 end
5 if target then
6 ‘ CAcurrent = CAy.(t, bback(targeted_box))
7 end
8 Update visible_boxes ;
9 forall by € visible_boxes do
10 temp_C, := CA,,(t, bback(by)) ;
11 if temp_C, < CAcurrent then
12 /*Begin cooperative part
13 if holder(by) # null then
14 ‘ SendCoopReq(rj, Cy,(t), CA;,(t, bback(by)))
15 end
16 /*End cooperative part
17 else
18 CAcurrent := temP_Ca ;
19 targeted_box := by ;
20 if carried then
21 deposit(carried_box) ;
22 end
23 end
24 end
25 end
26 end
27 /*Begin cooperative part

N
(=)

coop_request_processing();
/*End cooperative part

N
=}

*/

*/

*/

*/

have a functioning MAS (here a MAS that is able to bring back resource to predefined ar-
eas). But, first experimentations (presented in the next sections) will show that sometimes,

a group of robot (red, green or blue) suffers more than the other especially when the color

of the box apparition is not equiprobable. For example, if there is more probability for blue
and green boxes to appear than red boxes, it would be better if the entire group of robots
decides to help another group. The use of a SApHESIA enables to study the influence of the
different groups of robot and to see if it can increase the overall performance of the system.

This main idea is summed up in figure 8.1.
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Algorithme 8.2 : coop_request_processing() of agent r; carrying by

1 if Gy, (t) < Cy,(t) then

2 | if CA,(t, bback(by)) < Cy, () then
3 accept_exchange();

4 deposit(by);

5 end

6 else

7 ‘ refuse_exchange() ;

8 end

9 end

10 else

1 | if CAy (¢ bback(by)) < Cy(t) then
12 ‘ refuse_exchange() ;

13 end

14 else

15 accept_exchange() ;

16 deposit(by);

17 end

18 end

b) SApHESIA Model Definition for CoCaRo

We propose three component systems representing each a group of robots of the same color.
Each of these component systems is able to change the perceptions of its robots concerning
box rewards if and only if another component system needs help. We illustrate our reason-
ing by considering the red component system S,. S, has the functionalities to change the
perceptions about blue and green boxes for red robots. Thus, red robots may consider these
boxes as much important as red ones for themselves. In this way, red robots may take blue
and/or green boxes with the same priority that red ones and then have more chances to
give them to other robots. At the SoS level, it is a way for the red component system to help
green and/or blue ones when they are more critical.

Thereafter are the details of the model for the red component system

S, = {T,, R,, Acgq,, L, F;, Gy, Cost, } with:

o T, = Red;

> R; = {RReds Riues RGreens RTotRobots RDyings RRedRewards RBiueRewards RGreenRewards RMaxReward 15
o Acqr = O

o Ly = {Sp,S¢};

& F = {Fcontact, FHelpBiues FHelpGreen };

& Feontact = {{Rpying > Rrotrovot/2} — {Sp-R(Ryeq) +=1,S4.R(Ryeq) += 1}, ke, pe};

& FHelpBlue = {{RBlue == 1} — {RBlueReward = RMaxReward}r thp, phb}}
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& FHelpGreen = {{RGreen == 1} — {RGreenReward = RMaxRewards thgz phg}})
& Gr - {RDying = 0};
o Cost, = 0.

RRed, Rpiye and Rgyeen are the resources enabling component systems to "send a message"
to other ones through Fcontact- Rrotrovot 1S the total number of red robots. Rpying is the
number of red robots having a low level of energy; it evolves thanks to an environment rule
defined hereafter. Rpyireward i the energy level used for rewarding a red robot bringing
back a red box (defined in the same way as system 1 and 2: % * Maxne). RBiueReward
(respectively Rgreenreward) 1S the energy level used to reward a red robot bringing back a
blue box (respectively a green box) defined in the same way as system 1 and 2: 1 * Maxye.
RMaxReward 1S the maximum level of reward (defined in the same way as system 1 and 2:
% * Maxne). Fcontact is a functionality used when S, has a lot of number of robots with
a low level of energy (Rpying > Rrotrobot/2)- This threshold value is used to detect the
moment when more than 50% of the group has a really low speed and then becomes really
inefficient. In this case, Fcontacr €nables to send a Rge resource to Sy and Sg. Frerppiye and
FHelpGreen are functionalities enabling S, to respectively help S, and Sy by respectively
changing the value of Rpjyereward and Rgreenreward t© Ryvtaxreward- 1f, for example, a Rpyye
resource is received by S, the perceived value of reward of the red robots concerning blue
boxes (Rpuereward) Will change thanks to Fyeipprie. Acqr is empty because is not used in
this SApHESIA model. Each component system has already two links with the two other
component systems. For example, S, has the following set of links L, = {S,, Sg}. Sy is the
component system representing the group of blue robots and S, the group of green robots.
Then, the goal G, represents the fact that each component system tries to avoid robot with
low energy. Finally, to decide if a component system helps others, it simply computes its
criticality thanks to goal G, and uses the cooperative algorithm (presented in chapter 7) to
take its decision. The cost of the different component systems are set to 0 because they are
not used in this simulation.

The green component system is defined as S, = {Tg, Rq, Acqq, Lg, Fg, Gq, Costg} with:
o Ty = Green;
> Rg¢ = {RRed, RBiues Rreens RotRobots RDyings RRedRewards RBlueRewards RGreenRewards RMaxReward }5
o Acqy = O;
> Lg = {S4,5+};
o Fg = {Fcontact, FrelpBiues FrelpRed };
& Feontact = {{RDying > Rrotrobot/2} — {Sp-R(Rgreen) += 1,5, R(Rgreen) += 1}, te, pe}s
& Fretpred = {{Rred¢ == 1} — {RRedReward = RMaxReward }» thrs Phr};

& FHelpBlue = {{RBlue == 1} — {RBlueReward = RMaxReward}/ thb, phb}}
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> Gg = {Rpying = 0};

o Costy = 0.
The blue component system is defined as S, = {Tj, Ry, Acqyp, Ly, Fy, Gy, Costy } with:
o T, = Blue;
&> Ry = {RRred, RBiues Rreens R1otrovots RDyings RRedRewards RBiueRewards RGreenRewards RMaxReward }5
o Acqp = O;
o Ly = {Srr Sg}}
& Fy = {Fcontacts FHelpReds FHelpGreen };

& Fcontact = {{RDying > RTotRobot/Z} - {ST-R(RBlue) +=1, Sg-R(RBlue) += 1}/ te, pc};

& Fhepred = {{Rrea == 1} — {RRredreward = RnMaxReward } };

& FrepGreen = {{RGreen == 1} = {RGreenreward = RMaxReward }- thgs Phg )
& Gp = {Rpying = 0};

o Cost, = 0.

The following entities RedRobot, BlueRobot, GreenRobot of the environment are defined
and used to save to the current level of energy (through the resource Energy) of the robot
and if they have a low energy level (through the resource Dying). Dying = 1 means that the
robot has a low energy level and is used in the rules Ruleg,;, Rulep;,, and Rulege.n, defined
hereafter.

RedRobot = {Tredrovots RRedRobots ACGRedRobots LRedRobots FRedRobotr GRedRobot } With:

& TRredrovot = RedRobot;

& Rpedrobot = {Dying, Energy};
& AcqRredrobot = D;

& LRedrobot = D;

& FRredrobot = ©;

& GRedRobot = Q.

The resource Energy is used to save the current level of energy of the robot. Dying is
used to know if the robot have a low level of energy (used in the rules presented hereafter).

BlueRobot = { Tguerovots RB1ueRobots ACqBlueRobots LBlueRobots FBIueRrobots GBlueRobot } With:

& Tgiuerobot = BlueRobot;
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& RpueRobot = {Dying,Energy};

& ACQBlueRobot - @;
& Lpiyerobot = ©;
& FgiyeRrobot = Q;

& GBlueRobot = Q.

GreenRobot = {TGreenRobotr RGreenRobot/ ACqGreenRobot/ LGreenRobotr FGreenRobotr GGreenRobot}
with:

& TGreenRobot = GreenRobot;

& ReGreenRobot = {Dying, Energy};
& ACQGreenRobot = ®/'

& LGreenRobot = ©;

& FgGreenRobot = &;

& GGreenRobot = Q.

These entities are used in the three following rules to count the number of robots that
have a low energy level:

Ruleg,y = {RedRobot.R(Energy) < Maxy;,/3, RedRobot.R(Dying) == 0} —
{S+.R(Rpying) += 1, RedRobot.R(Dying) += 1}

Ruleg;,, = {BlueRobot.R(Energy) < Maxy,/3, BlueRobot.R(Dying) == 0} —
{Sp.R(Rpying) += 1, BlueRobot.R(Dying) += 1}

Rulegyeen = {GreenRobot.R(Energy) < Maxy,/3, GreenRobot.R(Dying) == 0} —
{S¢.R(Rpying) += 1, GreenRobot.R(Dying) += 1}

If, for example, the robot RedRobot has a low level of energy (RedRobot.R(Energy) <
Maxy, /3) and does not have already its resource Dying equal to 1, then the component
system S, will increment its resource Rpying. With this instantiation, the red component
system is able to send a resource with the functionality Fcontqc to blue and green one. It
happens when at least 50% of the robots have their energy level under Maxy,/3. Then,
when blue and green components (S, and Sg) receive the message (through the resource
RRed), S and S, change the perception of their respective robots concerning the reward of
red boxes. Finally, each blue and green robot starts to bring back in priority red boxes. This
fact naturally increases the probability that a blue or green robot meet a red robot with a low
energy and then exchange their boxes. Finally, 5, and S, can use the same process with their
own Fcouiacr functionality.
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8.3 Experimentations

The three systems have been implemented using GAMA [Drogoul et al., 2013]. GAMA is
a platform to model and simulate large-scale multi-agent systems, easy to use, which inte-
grates analysis and performance visualization tools. Each system is then assessed in terms of
efficiency and robustness using three metrics representing the state of the system over time:
the number of functional robots, the average energy level of the agents and the number of
boxes present in the environment.

8.3.1 Description

The simulations for the 3 systems have the same initial conditions:
o the number of robots is set to 90, 30 for each color;
o the initial energy level (N;) is set to 300;
o the maximum energy level (Maxy;,) is set to 300;
o the energy consumption per time (conso) is set to 1;

o perception and communication scopes of a robot are set to a radius of 3 squares around
its current position;

o the number of boxes appearing in the environment is set to 1 every 3 time units;

o the initial placements of boxes and robots are randomly chosen but are the same for all
simulations.

The two next sections present the obtained results that are discussed in a third section.

8.3.2 Experimentation 1: Equiprobability of Boxes Apparitions

In this experiment, the apparition of a new box in the environment is equiprobable (in term
of color) and enables to model an environment without perturbations and each kind of robot
(red, green and blue) has the same probability to survive during time. This simulation en-
ables to evaluate the performance of the three systems.

In figures 8.2, 8.3 and 8.4 the black curves represent the system without cooperation,
the light gray color curves represent the system with cooperation and the dark gray curves
represent the SoS according to SApHESIA. The figure 8.2 presents the mean energy level of
robots, the figure 8.3, the number of boxes in the environment and figure 8.4, the number of
alive red robots in the environment. The presented results are the average on 10 simulations.

Figures 8.2 and 8.4 show that the mean energy and the number of alive robots of the
cooperative system is 100% higher that the non-cooperative one. Furthermore, the SApH-
ESIA system has globally a higher mean energy and a higher number of alive robots. The
figure 8.3 shows that non-cooperative system has a number of boxes in the environment
that increases with time, contrary to cooperative and SApHESIA one that converge around
30 boxes after cycle 1000.
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8.3.3 Experimentation 2: Wave of Boxes of the Same Color

The creation of box color within the environment is not equiprobable in this second experi-
ment. Indeed, during 500 time units, only one box color is generated. At the end of 500 time
units, another color is generated and so on. This "hostile” environment enables to evaluate
the robustness of the system because it is not intended to work on such a case. Indeed, the
environment generates only a type of box and the robots have different rewards depending
on the box color. Then, some groups of robots have more difficulties than other during a
given period of time.

In figures 8.5, 8.6 and 8.7 the black curves represent the system without cooperation,
the light gray color curves represent the system with cooperation and the dark gray curves
represent the SoS according to SApHESIA. The figure 8.5 presents the mean energy level of
robots, the figure 8.6, the number of boxes in the environment, the figure 8.7, the number of
alive red robots in the environment. The results presented are the average on 10 simulations.
Finally, figures 8.8 and 8.9 represent the average level of energy for each group of robot (red,
green and blue) for respectively the system 1 (with no cooperation) and the system 2 (with
cooperation).

The figure 8.5 shows that the mean energy of the cooperative system is around 50%
higher that the non-cooperative one. Furthermore, the SApHESIA system has globally a
higher mean energy. The figure 8.3 shows that non-cooperative system has a number of
boxes in the environment that increases with time, contrary to cooperative and SApHESIA
ones. The figure 8.6 shows that non-cooperative and cooperative systems have a number of
boxes in the environment that increases with time, but more rapidly for the non-cooperative
one, contrary to SApHESIA one that stabilizes around cycle 2000. The figure 8.7 shows
that the number of red robots in hostile environment is 200% higher (respectively 300%)
for cooperative system (respectively for SApHESIA) than in non-cooperative one. Finally,
figures 8.8 and 8.9 show that in the hostile environment, the non-cooperative system has no
red robots left after cycle 1000 and the cooperative one balances the mean energy levels of
the different groups of robots.

8.3.4 Discussion

Our first hypothesis states that the criticality enables the cooperation between agents and
improves the effectiveness and the robustness of an AMAS: the comparison of the three
systems clearly shows that the exchange of criticality enables the AMAS to improve its ef-
fectiveness and its robustness. Concerning robustness, the underlying mechanism of co-
operation allows a greater number of robots to survive in both experiments ("hostile” and
classic environments) as we can see in figures 8.4 and 8.7. Then, the cooperation enables
the AMAS to adapt itself to different kinds of dynamical environment. Figure 8.8 shows
that the system without cooperation suffers more that the two others in the "hostile” envi-
ronment. Indeed, the number of red robots is equal to 0 after the 1000th cycle. Then, the
non-cooperative system, by losing an entire type of agents, loses its diversity so its capacity
to adapt to future changes in the environment. This is not the case for the cooperative and
the SApHESIA systems: the figure 8.9 shows that the cooperative system tends to balance
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the difference level of energy: it does not lose an entire part of the agents and is then more
able to adapt to future changes in the environment. Concerning the effectiveness of the three
systems, the non-cooperative one has not enough robots left after cycle 4000 (figure 8.3) to
stabilize the number of boxes in the environment contrary to the system with cooperation
and with SApHESIA.

8.4 Conclusion

The study of these three systems through this two experimentations show that cooperation
enables better effectiveness and robustness of the AMAS. Furthermore, the slightly better
results with SApHESIA show that the use of SApHESIA component systems enables coop-
eration at a higher level, which improves the global performance of the system (number of
boxes, energy level and number of alive red robots). These results legitimate the study of co-
operation in SoS and are encouraging regarding the reification of an AMAS to a component
system notably when an inter-AMAS cooperation will be addressed.
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UAYV Obstacle Avoidance System

This chapter presents another instantiation of SApHESIA concerning the formation flying
of Unmanned Aerial Vehicles (UAVs). The aim of this experiment is to compare the ef-
fectiveness and the scalability of our formation heuristics with satisficing games presented
in chapter 2. Satisficing games have been chosen because it is the basis of the collabora-
tive formation which is another SoS architecting heuristic presented in chapter 2. To do
that, the results obtained with our heuristic are presented with regards to results found in
existing literature concerning the same UAV obstacle avoidance experiment presented in
[Stirling and Frost, 2005].

9.1 Experiment Description

In this experiment, several UAVs have to fly through an environment that owns targets (T)
and hazards (H). Each UAV has to avoid the hazards and go through the targets. It cannot
go to the same place than another UAV and has to respect a maximum distance between
itself and other UAVs. The six following points describe the problem in details:

1. The field of action consists of a grid divided into cells such that each target and each
hazard are contained in one and only one cell. No cell may contain both a target and a
hazard;

2. The vehicles move at constant forward velocity but variable lateral velocity in a three-
abreast formation. The forward velocity is 1 cell per time unit. The lateral velocity is
drawn from the set cells per time unit, where negative signifies a move ahead and to
the left, zero a move straight ahead, and positive a move ahead and to the right. Each
cell may be occupied by, at most, one vehicle (i.e., they cannot cross each other);

3. Each vehicle is able to detect all targets and hazards within a static distance of cells in
the forward direction from their current cells, with unlimited lateral detection;

4. If a vehicle enters a cell that contains a target, the group of UAV scores one point;
5. If a vehicle enters a cell that contains a hazard, the group of UAV loses one point;

6. The goal of this problem is to cross the action field (the grid) by avoiding hazards and
cross targets (i.e., to maximize the number of points).
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Figure 9.1 — Examples of UAVs trajectories

Figure 9.1 illustrates an example of this problem with three UAVs on the grid. H and
T represent cells containing respectively Hazard and Target. The three lines represent the
trajectories of 3 UAVs.

9.1.1 UAVs SApHESIA Model

We propose to instantiate this problem with SApHESIA and to solve it with our coopera-
tive decision process. In this way, we propose the following SApHESIA model for the SoS
composed of three UAVs:

SoS = {UAV}, UAV,, UAV;}
Then, each UAV UAV is a component system defined as :

UAV = {T,R, Acq,L,F,G,Cost}

a) UAV Type and Resources

Each UAV has the following type T = UAV and the following set of resources R:

R ={X,Y, ClosestTargetx, ClosestTargety, Closest Hazardx, Closest Hazardy,
ClosestEmptyx, ClosestEmptyy, ClosestTarget, Closest Hazard, Closest Empty, Fiel dO f View}

With:

o X, Y representing its position;
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o ClosestTargetx, ClosestTargety, ClosestHazardyx, ClosestHazardy, ClosestEmptyx,
ClosestEmptyy, representing the coordinates of the closest target, hazard and empty
cells;

o ClosestTarget, ClosestHazard, ClosestEmpty representing the Euclidean distance of the
closest target, hazard and empty cell;

o FieldOfView representing the maximum distance of an UAV to detect targets and haz-
ards.

b) UAV Acquaintances and Links

Each UAV contains the following set of acquaintances Acq = @. Acq is empty because in
this problem, each UAV has already links with other UAVs. Moreover, each UAV contains a
set of links L that represents the two other UAVs. For example, UAV; has the set L1 defined
as:

Ly = {{UAV, 1}, {UAV;,,1}}

¢) UAV Functionalities

Each UAV contains the set of functionalities F:

F = {Fx, , Fx ,Fx,}
With:

o Fx, = {{UAV.X £ X+1} = {X +=1}{Y += 1}, txs, pxs b
o Fx ={{UAV.X #X -1} = {X += -1}, {Y +=1},tx_,px_};
o Fx, = {{@} - {X+=0},{Y +=1},tx,, Px. I

o txy =tx =tx, =1

C Px+ = Px— =PpPx, = L,

The different execution times (time to execute of the functionalities) and performances
(probability of the functionalities to success) tx,tx—, tx,, Px+, Px—, Px, are set to 1 because
in this experiment they cannot fail and have the same time duration. These functionalities
represent respectively a movement to the right, to the left and straight forward. As we can
see in the conditions of Fx, and Fx_, the UAVs cannot collide with each other {UAV.X #
X +1}and {UAV.X # X —1}).

d) UAV Goals and Cost

Each UAV has the set of goals G:
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G = {Guny,, Gry, Gy, Gx}
With:

o Gpu, = {ClosestHazardx # X,1}
o Gp, = {ClosestHazardy # Y,1}
o Gry = {ClosestTargetx = X,2}
o Gr, = {ClosestTargety =Y,2}
o Gg, = {ClosestEmptyx = X,1}
o Gg, = {ClosestEmptyy =Y,1}

& Gx = {UAV.X # X,1}.

These goals represent respectively the fact that an UAV tries to avoid hazard (Gp,, Gg, ), to
reach targets (Gr,, Gr,) and empty cells (Gg,, Gg,). For example, the goal Gy, represents
that the UAV wants its resource X (representing its x coordinate) to have a different value
from its resource ClosestHazardy (representing the x coordinate of the closest hazard per-
ceived by the UAV thanks to the rule Rule.2 presented hereafter). It enables the UAV to
avoid the closest hazard. The goal Gx represents that the UAV wants its resource X to have
a different value from the resource X of the other UAVs (UAV.X). It enables the UAVs to
not be to close from each other. The priority of goals have been set to 1, except for Gr, and
Gr, that have been set to 2. It enables to prioritize the destination of the UAVs by going on
target cells rather than empty cells. The Cost is set to 1 and is unused is this simulation.

e) Environment Model

In this simulation, there are three kinds of entities: Hazard, Target and Empty cells. These
entities are passive (i.e. they do not have functionalities) and static. They only contain their
positions represented by resources. Environment rules enable to model the perceptions of
new targets, hazards and empty cells. For example, the rule 1 enables to detect the closest
target by checking:

o if the distance between the target T and the UAV are under the value FieldO f View with
the following condition \/(UAV.X — T.X)2 + (UAV.Y — T.Y)2 < UAV.FieldOfView;

o if this target T is the closest target known by the UAV by checking if the distance be-
tween the target T and the UAV are under the value ClosestTarget with the following
condition \/(UAV.X — T.X)2 + (UAV.Y — T.Y)2 < UAV.ClosestTarget.

If these conditions are verified, the UAV will save the new target coordinates thanks to
resources ClosestTargetx, ClosestTargety and the Euclidean distance thanks to ClosestTarget.
Finally, the rules 2 and 3 have the same functioning for hazard and empty cells.
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Rule 1: Detect the "closest target"

V(UAV.X — T.X)2+ (UAV.Y — T.Y)2 < UAV.ClosestTarget
VUAV.X — T.X)2+ (UAV.Y — T.Y)2 < UAV.FieldOfView
—

UAV .ClosestTargetx = T.X
UAV .ClosestTargety = T.Y
UAV.ClosestTarget = \/(UAV.X — T.X)2 + (UAV.Y — T.Y)?

Rule.2: Detect the "closest hazard"

V(UAV.X — HX)? + (UAV.Y — H.Y)2 < UAV.ClosestHazard
V(UAV.X — HX)? + (UAV.Y — H.Y)?2 < UAV.FieldOfView
—

UAV.ClosestHazardxy = H.X
UAV .ClosestHazardy = H.Y
UAV.ClosestHazard = \/(UAV.X — H.X)2 + (UAV.Y — H.Y)?

Rule.3: Detect the "closest empty cell"

V(UAV.X — EX)2+ (UAV.Y — E.Y)2 < UAV.ClosestEmpty
V(UAV.X — EX)?2+ (UAV.Y — E.Y)2 < UAV.FieldOfView
—

UAV ClosestEmptyx = E.X
UAV .ClosestEmptyy = E.Y
UAV.ClosestEmpty = /(UAV.X — E.X)2 + (UAV.Y — E.Y)?

9.1.2 Results

To compare the effectiveness of our cooperative approach with [Stirling and Frost, 2005], 100
simulations with 3 UAVs in different environments have been done. To study its scalability
of it, 4 other simulations are presented with respectively 8, 10, 15 and 20 UAVs. We present
an example of a 3-UAVs simulation in figure 9.2 run with SApHESIA tools.

Table 9.1 — Result for 3-UAVs simulations

Cooperative | Satisficing | Optimal
Mean -1.54 1.44 2.95
Std deviation 3.17 4.62 2.58

Table 9.2 — Simulation time for 3, 8, 10, 15 and 20 UAVs simulations

3-UAVs | 8-UAVs | 10-UAVs | 15-UAVs | 20-UAVs
Time (s) | 4.44 8.15 9.91 15.05 18.08

For each simulation, the environment (a grid of 50x10 cells) is created with a probability
of 0.1 for a target and 0.7 for a hazard to appear on each cell. Table 9.1 shows the mean score
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Figure 9.2 — Examples of cooperative UAVs trajectories

such as the standard deviation of 100 simulations for each approach (cooperative and satis-
ficing) compared to the optimal. For each environment, we calculated the optimal trajecto-
ries of the 3 UAVS by searching the maximal score the 3 UAVs can reach for each simulation.
The following parameters have been set for 3-UAVs simulations:

o FieldOfView = 3,

o ClosestTarget = ClosestHazard = ClosestEmpty = 99,
o UAV;.X = —1and UAV1.Y =0,

o UAVL. X =0and UAV,.Y =0,

o UAV3.X =2and UAV3.Y = 0.

We present in table 9.2 the time duration of 3, 8, 10, 15 and 20 UAVs simulations.

9.1.3 Discussion

Obtained results show that even if cooperative approach is competitive, satisficing algo-
rithm is slightly closest to the optimal regarding to the mean score for 3 UAVs. This differ-
ence comes from that our approach is less effective to prevent long-term difficulties.
Nevertheless, simulations with 8, 10, 15 and 20 UAVs show that our approach is scalable:
time duration seems to evolve in O(log(n)) with n the number of UAVs. Indeed, the coop-
eration is a local heuristic approach more simple to implement than satisficing for the three
following reasons:
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o the satisficing approach needs the construction of the praxeic network and designers
need to know all the interdependencies between all component systems before simu-
lating this kind of application and it may be very difficult to represent them;

o computation of satisficing global function is resolved with the Pearl belief propagation
algorithm that does not allowed cycles in praxeic graph [Stirling and Frost, 2005] (i.e.
retro action loop);

o the cooperative approach does not require global function to calculate satisficing solu-
tions, so it does not need to define a praxeic network;

The construction of praxeic network for 8 UAVs (and also for 10, 15 and 20) is complex
because interdependencies between UAVs and possible retro-action loops. For example,
UAV in (-1,1) has influences on (0,0) that has influences on (1,1) that has influences on (-1,1).
These cycles forbid to use the Pearl belief propagation algorithm [Stirling and Frost, 2005]
in order to solve the Bayesian network associated with praxeic network. Finally, in the
satisficing approach, adding a new UAV leads to reconstruct the praxeic network so the
global function. At the opposite, our approach enables to easily add or delete component
system during functioning because it is not based on any graph.

9.2 Conclusion

This experimentation proposes a comparative evaluation of our cooperative approach for
SoS architecting based on SApHESIA. We have instantiated, evaluated our approach to
a UAV flight scenario and compared it to satisficing games used in another collaborative
approach for SoS architecting [Caffall and Michael, 2009]. Simulations done with our ap-
proach shows competitive results with regards to the satisficing approach. Moreover, our
approach goes through several limitations such as the definition and the computation of a
global function during the design phase. Finally, last simulations with more UAVs show that
our approach is easily scalable and enables interdependencies cycles that are really strong
advantages for SoS architecting evolution.
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Interdependence between
two SoS: Combination of
CoCaRo with UAVs

This chapter presents experimentations about reuse and interdependence between existing
SoS. The aim is to validate that two SoS that have been independently built using SApHESIA
can serve each other and then increase their efficiency. The first two sections present the two
distinct SoS: the SoS version of CoCaRo and a slightly modified version of the UAV SoS
presented in chapter 9. The last sections present the experimentation, the results and the
discussion about them.

10.1 First SoS: CoCaRo

In this experimentation, we will reuse the component systems presented in chapter 8. The
robots have been removed from the simulation and are now aggregated in component sys-
tems through functionalities defined in the next sections; so three component systems have
been defined (red, blue and green). As the aim is to study the interdependence between SoS,
the dynamic of exchange between robots are not needed in this simulation. Each component
system consumes a certain rate of energy per time unit and is able to use boxes directly to
create energy. The following sections describe entirely this SoS.

10.1.1 CoCaRo SoS

The SApHESIA model of the CoCaRo SoS is the following;:
SoS = {Red, Green, Blue}

Where Red, Green and Blue are component systems representing a group of robots and
are defined as RG = {T,, R,, Acqg,, L+, F;, G, Cost, } with:

o T, = {Red, Green, Blue};

e Ry = {RTurn/ RRobot REnergy/ RBoxRrates Rec, Rpox, RHighValuer RLowValue}}

o Acgr = {D};
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o L, = {RG};
e k= {FCVeateEnergy/ FGiveBox}r'

o Gy = {GBox/ GEnergy};

o Cost, = 0.

Concerning type T, this one can be equal to Red, Green or Blue representing respectively
the red, green or blue group of robots.
Concerning resources R;, Ry, is used to save the current simulation step and is used in
the rules of the environment presented hereafter. R, represents the number of active
robots in the group. As explain before, a robot is now just a resource that will be used in
a functionality to create energy. By consequence, a robot is not an active entity anymore.
REnergy represents the global energy level of the robots group. It can be seen as the average
level of energy of all robots in the group. Rp,xrate represents the rate of boxes apparition
in the robots group. In CoCaRo, the boxes appear randomly in the environment. Rgc rep-
resents the energy consumption of the robots group by turn. Rp,, represents the number
of available boxes in the robots group. It is used to model the number of boxes that are
normally perceived and brought back by the robots group. Finally, Ryienvatue, RLowvalue are
respectively the high reward value and the low reward value when the component system
uses a box (in CoCaRo, the boxes give different rewards to robot groups depending on their
color). All of these resources are used in functionalities and environment rules presented in
the following sections.

Concerning Acq,, this one starts empty and does not evolve over time because each
group of robots are linked to others. For example, the set of links of Red is L, =
{Green, Blue}. Indeed, in CoCaRo, each robot can exchange boxes or information what-
ever their colors. Moreover, these links already exist in the SApHESIA version of CoCaRo
(see chapter 8).

Concerning functionality F., FcreateEnergy T€pTesents the capacity of the robots group to
change box to energy. The, the component system is able to create energy if it has one
available box and one available robot ({ Rpox = 1}, { Rropor = 1}).

FCreateEnergy = {{RBox 2 1}/ {RRobot 2 1}} — {RBox += _1}1 {REnergy += 1}/ tc/ Pc}

tc and p. are set to 1 as for the other functionalities because in this experiment we consider
that all the functionalities are the same time duration and cannot fail. Fg;yepox represents the
capacity of a robots group to give boxes to another robots group.

FGiveBox = {{RBox = 1} — {{RobotGroup Rpox += —1},tg, pe}}

t, and p, are set to 1.
Concerning goals G,, Gp,x represents the goal of the robots group (to have available boxes
as much as possible). Formally, the goal is defined as G,y = {Rpox > 0}. GEnergy represents
the goal of the robot group to have as much energy as possible. Formally, the goal is defined
as GEpergy = {REnergy > 20}. 20 has been chosen arbitrarily, but a value superior to 0 is
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important because if component system has no more energy, this one is considered as "dead’
and cannot be used anymore. It represents the fact that in CoCaRo, a robot with no more
energy is ‘dead’ (i.e., it cannot be used anymore).

10.1.2 CoCaRo Environment
The SApHESIA model of the environment is the following:

E= {R”leAppﬂritionr RuGreenComsumptionr RuBlueComsumption}

In the CoCaRo environment, there is no entity. The boxes are directly considered as re-
sources. But, to simulate the boxes apparition and the energy consumption, four rules have
been defined. First, the rule Ru pparition €nables to generate new boxes in the component
systems RobotGroup. Basically, at each turn of the simulation, a random number is taken
and if this one is under the resource R apparition, the resource Rpoy is increased. Formally, the
rule is defined as:

RuApparition = {{100 X mndom() < RG-R<RApparition)} — {RG.R(RBM) += 1}}

Where random() is a function giving a random number between 0 and 1. In chapter 8, we
defined an experiment with an "hostile” environment where the boxes that appear have all
the same color during a fixed period of time. It enabled to test the robustness of CoCaRo
by giving, during a fixed period of time, only boxes that are efficient for only one kind of
robots. To reproduce this kind of environment, we add two rules that will change the energy
consumption of each of the robots groups. The aim is to reproduce that each robots group
has, during a fixed period of time, only boxes that are efficient for it. Then, during the first
1000 steps of the simulation, the Red robots group has a high value of energy consumption
(Rec = Ruighvaue) (representing that there is no red boxes in the environment). Then, during
the next 1000 steps of the simulation (step 1000 to 2000), the Green robots group will have
a high value of energy consumption (Rec = Ryignvaiue) and Red will come back to a low
consumption (thanks to the rule Rugeencomsumption)- Finally, during the last 1000 steps of
the simulation (step 2000 to 3000), the Blue robots group will have a high value of energy
consumption (Rec = Ryighvalue) and Green will come back to a low consumption (thanks to
the rule Rupjyecomsumption)- These dynamics are represented through the two following rules:

RuGreenComsumption = {{GFEEH.R(RTWH) == 1000}/ {Green.R(REc) ==
Green-R(RHighVulue)} — {R€d~R(REC) = REd'R(RLowValue)}

RuBlueComsumption = {{Blue'R(RTum) == 2000}/ {Blue'R(REC) == BZME-R(RHighValue)} -
{Green'R(REC) = Green-R(RLowValue)}}

10.2 The Second SoS: UAVs

This section presents the second SoS used in this experimentation inspired from the SoS
presented in chapter 9. This SoS is composed of three component systems UAV's that are
able to convert them to energy such as robots group but also to navigate to boxes.
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10.2.1 UAVs SoS

Formally, the SoS is defined as:
SOSUAV = {UAVl, UAVZ, UAV3}

A component system UAV models a drone that detects, takes and converts box to en-
ergy. The aim of these UAVs is to get a level of energy sufficiently high to keep func-
tioning during time. An UAV is able to give box to other UAVs if needed. The formal
SApPhESIA definition of a component system UAV representing a drone is the following;:
UAV = {T,, Ry, Acqy, Ly, Fy, Gy, Cost, } with:

o T, = UAV;

& Ry = {REnergys RBox, RpistBox }
o Acq, = {D};

o L, that depends on the UAV;
& Fy = {FcreateEnergys FGiveBox };
> Gy = {GBox, GEnergy, GDistBox }5

o Cost, = 0.

Concerning resources, Repergy represents the energy level of the UAV. Rp,, represents the
number of boxes available for the UAV. Finally, to simplify the model of the UAV move-
ment, the use of X and Y coordinates has been replaced by only one resource Rpjsp,, that
represents the distance between a box and the UAV.

Each UAV contains the following set of acquaintances Acq = @. Acq is empty because in
this problem, each UAV has already links with other UAVs. Moreover, each UAV contains a
set of links L that represents the two other UAVs. For example, UAV; has the set L; defined
as:

Luay, = {{UAV},1},{UAV,, 1}}

Concerning functionality, FcreateEnergy Tepresents the capacity of an UAV to change box to
energy.

FCreuteEnergy = {{RBOJC 2 1}/ {RRobot P 1} — {RBox += _1}/ {REnergy += 1}ztc/ Pc}
tc and p. are set to 1. Fgiyepox represents the capacity of an UAV to give box to another UAV.
FGiveBox = {{RBox = 1} = {UAV, Rppx += —1}, te, pg}

te and pg are set to 1. FyroveroBox Tepresents the capacity to go to a box. If the UAV has 0 box
and is not on the box ({ Rpox = 0}, { Rpistpox # 0}), it will go to the box.
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FMoveToBox = {{RBox - O}/ {RDistBox 7'é 0} — {RDistBox += _1}1tH1/ pm}

tm and py, are set to 1. Fry.pox represents the capacity to take a box. If the UAV has 0 box
and is on the box ({Rpox = 0}, { Rpistpox = 0}), it will take the box.

FTukeBox = {{RDist = O}/ {RBox = 0} — {RBox += 1}/ tt, pt}

t; and p; are set to 1.

Concerning goals, Gpyy represents the goal of the UAV to have as much as possible
available boxes. Formally, the goal is defined as Gpoy = {Rpox > 0}. GEnergy Tepresents
the goal of the UAV to have as much as possible energy. Formally, the goal is defined as
GEnergy = {REnergy > 0}. Finally, Gpjstpox represents the goal of the UAV to minimize its
distance to a box. Formally, the goal is defined as Gpjstpox = {Rpistpox == 0}.

10.2.2 UAVs Environment

In this environment, boxes are entities. = Such an entity is defined as Box =
{Tb, Rb, ACE]b, Lb, Pb, Gb} with:

> Ry = {Rvaitavility };

> Acgy = {O;
o Ly = {0}
o F = {0}
> Gy = {0}

A box is a simple entity where R ugilapility represents the availability of the box for the UAVs.
This resource is used as a threshold to simulate the detection of a box by an UAV in rule
RulepetectBox- Formally, the rule is defined as:

RupetectBox = {100 x random() < Box-Rb(RAvailability) — UAV.Ry(RpistBox) =
Box.Ry (R pvaitabitity) }

Then, if the condition 100 x random() < Box.Ry(R availabitity) is verified, then the UAV has
detected this box and save its distance in its resource Rp;s;Box-

10.3 Experimentations

This section describes the experimentations concerning the CoCaRo SoS, the UAV SoS and

the union of the two SoS, particularly the values of the initial parameters, the number of
component systems and their initial links.
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Table 10.1 - Initialization of the three robots groups

Green Blue Red
RRobot 20 20 20
REnergy 60 60 60
RpoxRate 1 1 1
Rege Riowvaiue | Rrowvalue RHighValue
Rpox 0 0 0
Ry 0 0 0

10.3.1 CoCaRo SoS Experimentation

In this version of CoCaRo, the robots are not active entities; their actions (bringing back
boxes and convert boxes into energy) are modeled with the functionality FcreateEnergy- The
aim of this first CoCaRo SoS experimentation is to show that the dynamics of this system
(without active robots) is the same than the system CoCaRo with cooperation presented in
chapter 8 (with active robots).

a) Description

For the CoCaRo SoS, three component systems RobotGroup have been instantiated: Green,
Red, Blue. Each of them has been initialized with the different values that are summed up
in the table 10.1. In this table, Rpopvame = 0.015 and Ryjghvae = 0.04. This value has
been chosen arbitrarily. The idea is to begin with the Red robots group with a high value
of energy consumption and validate that the two other robots groups will help it by giving
extra boxes.

b) Results

First, figure 10.1 shows (through the graph Rgy.rgy) that the dynamics of the environment
impacts the functioning of each robots group during time. For example, from cycle 0 to cycle
1000, the REpergy resource is lower for the Red component system because of the initialisation
of Rec to RyighEnergy- This is the same reasoning for Green and Blue respectively between
cycle 1000 and 2000 and between cycle 2000 and 3000. Secondly, the dynamics of the system
CoCaRo with cooperation presented in chapter 8 is always present. Indeed, each robots
group tends to balance the mean level of energy of each other. This fact can be seen with the
REnergy and criticality graph. Even if a robots group is more constrained by the environment,
the two others, thanks to the cooperation algorithm, are able to help it. Thirdly, figure 10.1
shows that all the robots groups finish the simulation by having a very low level of energy.

10.3.2 UAVs SoS Experimentation

The aim of this UAV SoS experimentation is to present the global functioning of an indepen-
dent SoS using the cooperation mechanism. UAVs can cooperate each other by using the
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Table 10.2 — Initialization of the three UAVs

UAV1 | UAV2 | UAV3
Renergy | 60 60 60
RBoxRate 1 1 1
Rrc 0.08 0.015 | 0.015
RBox 0 0 0

FGiveBox functionality. For the UAV SoS, three component systems UAV have been instanti-
ated: UAV1, UAVZ and UAV3.

a) Description

Each of the component system UAV has been initialized with the different values that are
summed up in the table 10.2. The value have been chosen arbitrarily. Then, UAV; is a less
effective than the others. This lack of effectiveness enables to add some diversities in the SoS
and validate that the cooperation algorithm is functioning in this SoS.

b) Results

Figure 10.2 shows the results of the experimentation for the UAV SoS. The level of energy
of UAV1 decreases quicker than the others (because of the higher value of Rgc). Because of
the goal GEnergy, @ quick increase of the UAV1 criticality from cycle 0 to cycle 650 is visible.
But, after cycle around 650, the cooperation algorithm makes UAV2 and UAV3 help UAV1
by giving boxes. The result of this cooperative behavior is the increase of the criticality of
UAV?2 and UAV3, because they do not use their boxes for creating energy anymore. But,
a stabilization of the level of energy of UAV1 is visible from cycle around 650. Then, the
levels of energy of UAV2 and UAV 3 are decreasing until cycle 5000 because these two UAVs
continue to help UAV1 to survive. Finally, after cycle 5000 the criticality and the energy level
are balanced and stable for the three component systems. The final stabilization comes once
again from cooperation algorithm. Indeed, as UAV'1 shows that it has the same level of
criticality than other, it starts to bring back boxes too and share it with others UAVs. Finally,
we validate that in this case the UAV SoS is able to adapt itself through the cooperation.

10.3.3 CoCaRo + UAVs SoS

This final experimentation validates that two interdependent SoS are able to reach a better
functioning in term of performance by using cooperation. To do that, the two previous
SoS are slightly modified to create dependencies in terms of functionalities. The aim is to
design the SoS composed of RobotGroup more efficient concerning the transformation of
boxes into energy and the SoS composed of UAV more efficient concerning the detection
and the transport of the boxes. Then, this experiment will show if the two SoS,thanks to our
cooperative heuristic, are able to naturally take advantage of this interdependence.

154 Teddy Bouziat



10.3. Experimentations

wngp

)S 00St ODOF DOSE ODOE OOSZ OODE OOST OOOT O0O0S

sL'T

00’z
=
05’z
GL'T

oo'e

xod o

005 9 005 & 005+ 000 F 0O 9 005G 0005 00Sb 000+ DOSE O00E DOSE O s o
0 0
RN :
ot
st
0z
sz
= »
0 ,B 2
5
H Z
se & £
£ a R
= -
or
5
05
09
00S9 0009 00SS 000S 0OSE 000 00SE 000E 00ST OOOT 00S O
0o'n
00
]
£0°0
v0'0
s0°0
el
I g
g =
S 8
2 z
54

xog ¥

xoqisia™ ¥

w3t visaHdvs [

155

Figure 10.2 — Results of the simulations of UAVs SoS




Interdependence between two SoS: Combination of CoCaRo with UAVs

a) Description

These two SoS are close to the two described in the previous sections:
o 3 UAVs have been instantiated in the SoS SoSy 4y = {UAV;, UAV,, UAV;};
o 3 robots groups have been instantiated in the SoSgc = {Red, Green, Blue}.

The UAV component system has been modified to create interdependences between UAV
and RobotGoup. An UAV is then defined as UAV = {T,, R, Acqy, Ly, Fu, Gy, Cost,, } with:

o T, = UAV;

& Ry = {REnergy, RBox, RpistBox, RDistTorG, RDistToBox }

o Acq, = {D};

o L, that depends on the UAV;

& Fu - {FCreuteEnergy/ FGiveBox/ FMoveToBom FTakeBox/ FMowToRG/ FDrop};
& Gu = {GBox/ GEnergyr GDistBox}}

o Cost, = 0.

Rpisttorc and Rpisitopox have been added in order to respectively represent the distance
to a RobotGroup and the distance to a Box. Concerning functionalities, the UAV is now
able to share boxes with a RobotGroup thanks to four new functionalities FyptoveToBox FrakeBox,
FimoverorG @and Fprop. FroveToBox €nables to an UAV to go to a Box by decreasing the resource
RpistToox- FrakeBox €nables an UAV to take a box when Rpjs1,p0x is equal to 0. FujovetorG
enables to an UAV to go to a RobotGoup by decreasing the resource Rpjs;rorc. Then, when
RpistTorG is equal to 0, Fpy,p enables UAV to give a box to RobotGroup. To create dependen-
cies in both ways (i.e., interdependencies), the use of Fp,,, also rewards the UAV by giving
extra Rgpergy- Fprop has been designed to make RobotGroup more efficient to transform boxes

into energy. In this way;, it is more efficient for the two SoS that the UAV's bring back boxes
to the RobotGroups. Formally, the four added functionalities are defined as:

FumoveToox = {{RpistToBox 7 0}, {RBox == 0} = {Rpistrorc += —1}, tyups P}
FrakeBox = {{RpistoBox == 0}, {Rpox == 0} — {UAV, Rpox += 1}, tw, p1y}
Fymoverorc = {{Rpistrorc 7# 0}, {Rpox = 1} — {Rpisirorc += —1}, tm, pm}

Fprop = {{RpistrorG = 0}, {Rpox = 1} — {UAV, Rpox += —1},{RG, Rpox += 1}, ta, pa}

tubs Pmbs tevs Pros tms Pm, tg and py are set to 1. The environment is composed of the union
of the two previous environments:

E= {RuleApparitionr RuGreenComsumptionr RuBlueComsumption/ BOJCES}

Where Rulespparitions RuGreenComsumption @0d Rupjyecomsumption are the rules presented in the
CoCaRo SoS experiment (see section 10.1.2) and Boxes are a set of entities of type Box pre-
sented in the UAV's experiment (see section 10.2.2) .
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10.4. Conclusion

b) Results

Figure 10.3 shows the results of 8000 cycles of simulation. We see that the Rgyerg, of the
RobotGroups tends to be balanced between each different RobotGroups (as the previous Co-
CaRo SoS simulation). But contrary to the previous simulation with the CoCaRo SoS, this
resource is stable at an earlier stage of the simulation and is increasing after the cycle 1000.
This is due to a high criticality of the RobotGroups at the beginning of the simulation leading
the UAVs to give extra boxes thanks to their new functionality Fp,,, and their cooperative
behavior. As a result, the three RobotGroups are able to function during the 8000 cycles of
simulation. Furthermore, thanks to the extra energy given by the Fp,,, functionality, the
UAVs have a level of energy (represented also by Rey.rqy) that is equivalent to the one in the
experiment with the UAV SoS alone. Finally, the less efficient component systems (that are
the UAV; and the Red robots group, because they have been define with a higher Rgc than
others) are helped more than the other thanks to the cooperation mechanism. Indeed, their
level of energy are equivalent to the others.

10.4 Conclusion

In this chapter, two SoS have been instantiated independently and have been modified to
create interdependencies between each other. Our experiments have shown that the two
SoS tend to find naturally the best way to solve the constraints of the environment. In the
last experiment, the UAV's have brought back boxes to RobotGroups, thanks to their coop-
erative behavior. Indeed, UAV's have also increased their energy because giving boxes to
RobotGroup rewards them with extra energy. Then, the two SoS have naturally found their
interdependencies and a way to solve them. Our cooperative heuristic through the criticality
comparison enables to solve in generic way interdependencies problems without re-design
them such as [Lemouzy, 2011] has to do. In a more generic way, we think that the criticality
comparison can be a solution to solve interdependencies of systems.

Nevertheless, the goals definitions of the different component system has to be made
with attention. For example, some tests have been made by changing RobotGroup goals
about REyergy by the following : Geuergy = { REnergy > 0} instead of Geuergy = {REnergy > 20}.
In this case, the criticality is really high only when Rgj.rqyiscloseto0, then, other component
systems start to help only when Rgy.,qyiscloseto0 so the cooperation between the UAVs and
the robots groups starts too late to be useful.

157



Combination of CoCaRo with UAVs

Interdependence between two SoS
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Figure 10.3 — Results of the simulations of UAVs and CoCaRo SoS
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Self-Adaptation of the
Criticality

This final chapter proposes to improve the cooperative algorithm proposed in chapter 5. We
propose a new algorithm called the criticality adaptation algorithm used at the component
system level to solve problems concerning the use of the criticality when trying to unify
two or more SoS. This algorithm is evaluated through an experiment dealing with product
manufacturing.

11.1 The Problem of the Criticality Adaptation in the AMAS ap-
proach

The problem of the criticality adaptation in the AMAS approach appears because the prob-
lems to solve are becoming more and more complex and because of a strongly dynamic
environment in which the system evolves (mainly because unexpected events may occur
during its functioning) [Lemouzy, 2011]. In this case, several systems (possibly designed by
different designers) may have to interact to solve a particular problem. It leads to the need
of putting together two or more AMAS that have been independently designed but are in-
terdependent. But, the AMAS approach does not deal with how to manage interactions
between agents coming from different AMAS, notably concerning the use of the criticality.
Indeed, the criticality of an AMAS A can have a different meaning than the criticality of an
AMAS B. Indeed, as the two AMAS have been independently designed, there is no reason
that, for example, the value of criticality 0.7 has the same meaning in term of difficulty for A
and for B. This issue is called the normalization of the criticalities. [Lemouzy, 2011] pointed
out that, creating a second AMAS in an environment where a first AMAS is already existing
can lead to re-design (at least in part) the criticality of the first AMAS. This task is and will
be more and more fastidious because of the increasing complexity of the AMAS designed.
That is why [Lemouzy, 2011] argues that the criticality of an agent has to adapt itself when
it has to work with agents coming from other AMAS.
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Figure 11.1 — Example of criticality comparison issue between two SoS

11.2 The Problem of the Criticality in SApHESIA

During first tests of the cooperative algorithm on several SoS, issues appear concerning the
criticality comparison between different SoS. Indeed, if the SoS are independently designed
and put together, the criticalities of some component systems (of a first SoS) may be always
upper than others (of a second SoS). It comes from the fact that SoS are defined by different
designers and then the criticality in each SoS is not computed in the same way. For example,
a criticality of a SoS can takes its values in [0,0.5[ and the other in [0.5,1[. In this case and
because of our cooperative algorithm, some component systems may always help others
(because of a higher predefined criticality) without fulfilling their own goals. Figure 11.1
shows this issue. the component A of SoS 4 is always giving resource R; to B of SoSp because
Vt,Ca(t) < Cp(t). The combination of several SoS can be then counter-productive in such
cases, making a SoS (where component systems of a SoS work fine when working between
them) that never reaches its adequate functionality. Finally, these heterogeneous intervals
lead to a problem of normalization.

11.3 Proposition

Let S be a set of SoS and SoS 4, SoSg € S two different SoS. A criticality comparison prob-
lem occurs when the range of criticality of A € S0Sj4 is always lower than the one of a
component system B of another SoSg, leading A to always uses functionalities that help
component systems of SoSp without fulfilling its own goals. To avoid this problem, we pro-
pose to give to A the capacity to compute new criticalities for component systems of SoSp
that are modified when A detects a criticality comparison problem.

For all B € SoSg, this new criticality of B is called the adapted criticality of B for A
and is noted Cg, 4 (t). This adapted criticality is used instead of the standard criticality of B
(Cg(t)) in the cooperative algorithm defined in chapter 5.

To know when modifying the adapted criticality of B for A, the occurrence of a critical-
ity comparison problem with SoSp is defined as the occurrence of these two propositions
detected by A simultaneously:
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11.3. Proposition

1. A cannot fulfill its own goals;

2. A helps during a long period of time the component systems coming from SoSg .

We propose to define formally, VB € SoSg, the adapted criticality of B for A Cg/4(t)
such as CB/A(t) = 0Sp55/A X CB(t> with:

o tges,/4 €)0,1] is the adaptive coefficient that decreases when A detects phenomena (1)
and (2) with a component system of SoSg;

o Cp(t) is the criticality of B.
The aim of this algorithm is :

o to decrease ag,5,,4 when a criticality comparison problem with SoSg occurs;

o toincrease ag,s,,4 when no criticality comparison problem with SoSp occurs;

In this way, if A helps too often component systems of SoS;, without fulfilling its own goals,
A decreases wg,s,, 4 then decreases Cp, 4 (t) until this one comes to an equivalent level to its
own criticality, enabling A to help itself again.

Finally, we propose an algorithm that generalizes this behavior of A for all SoS € S.
Let SoS € S a SoS, each component system s € SoS is able to compute a set of adaptive
coefficients Alpha® = {asps, /s, X508, /5/ s X508, /s } Where tg,s, /5 is the adaptive coefficient of
s computed when a criticality comparison problem with SoS; occurs.

Algorithm description: Each component system A is able to compute a set of coeffi-
cients Alpha?t = {&s08,/ 4, X508,/ As s X505, /4 } implemented thanks to a dictionary (called
alphaTable in the algorithm 11.1). The keys of this dictionary are the name of the SoS and
the values are the different ag,s, coefficients. ag,s, /4 is decreased if A detects the phenomena
(1) and (2) with component systems of SoS;.

To detect that A cannot fulfill its own goals (1), A starts by computing a variable FI that
represents its distances to its own goals. Formally, FI is the sum of the integral on [t — A, ¢]
of the difference between its current states (representing by its resources) and its different
goals (from line 4 to 6). The more FI is high the more the component system cannot fulfill its
own goals. This computation is represented by the blue area on figure 11.2. FI is calculated
on a shifted window of size A, avoiding to use too old values that are not representative
anymore. This delta is a parameter that can be chosen by the designer.

To detect that A has helped during a long period of time the component systems coming
from SoS; (2), the second part of the computation of «g,s.,4 (made from line 7 to 9) saves in
a dictionary of past interactions (called pastInteractions) the number of times A has used a
functionality that helps the component systems of SoS;. Then, the more pastInteraction con-
tains a high value for SoS; (given by pastInteractions[S;.getSoS()], S; being the last helped
component system of S0S;), the more it has helped SoS;.
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Figure 11.2 — Alpha extraction for a goal g = {R == Obj}

Finally, the ag,s,/ 4 coefficient is computed (line 10) as the inverse of FI and the number
of past interactions pastInteractions[S;.getSoS()]. Then, when A uses its cooperative algo-
rithm 5.1 in chapter 5, it can uses ag,s,/4 to compute Cg,,4(t) with the criticality given by
a component system S; from SoS; and then avoiding to help infinitely component systems
that have always a higher criticality.

Algorithme 11.1 : Criticality adaptation algorithm

1 /*Update the a coefficients for criticality adaptation*/
2 updateAlphas(s As ComponentSystem, alphaTable As Dictionary<String, Float>,
pastInteractions As Dictionary<String, Float>):

3 for (a € alphaTable) do

4 forg € Gdo

5 ‘ FI += ftt_A(g.Qu — S.R(g.Re)(t));

6 end

7 | if (s.getSoS() == alphaTable.getKey()) then

8 ‘ pastInteractions[s.getSoS()] + + ;

9 end

10 | alphaTable(s.getSoS()) = FI~! x pastInteractions[s.getSoS()] ™" ;

11 end

11.4 Experiment Description

We propose the following experiment with two SoS (505 4 and SoSg) composed of 3 compo-
nent systems (figure 11.3). In figure 11.3, yellow boxes represent resources and black arrows
represent links between component systems. In this experiment, SoS, is composed of 3
component systems A1, Ay, Az that are linked together to transform RawMaterial resources
to Final Product resources. RawMaterial is generated from the environment (thanks to the
rule Ruggy). Ap through the functionality Fpyoguctachined transforms it to Machined Product
and produces it as much as possible (thanks to goal { MachinedProduct > 0,1}). Then A,
transforms MachinedProduct through the functionality Fpy,qyctpainted to Painted Product and
produces it as much as possible (thanks to goal { PaintedProduct > 0,1}). 1 represents the
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11.4. Experiment Description

Raw material

Machined Machined Machined
product product product

Raw Painted
material product

Raw Painted
material product

Painted
product

Final product

Figure 11.3 — Example with two SoS

priority of the goal. The more the priority is high, the more the goal has an importance in the
criticality computation (see section 5.3). Finally A3 transforms Painted Product through the
tunctionality Fpyogyctrina in Final Product resource and tries to produce 5 units of it thanks to
the goal { Final Product == 5,1}. As shown in figure 11.3, the SoS SoSp has exactly the same
functioning with By, B, and B3, except that Bz has to produce 10 Final Product (through the
goal {Final Product == 10,1}).

To show the problem of criticality adaptation, two links between SoS4 and SoSg have
been added: a link from Aj; to B, and from A3 to Bs. A, is able to give extra Painted Product
to By (through Fs,,gpainted) and Asz is able to give extra PaintedProduct to Bz. Finally, to
cause a criticality comparison problem in this experiment, the component systems of the
S0S 4 have an additional goal Gpjstordcriticatity = {Ro, == 1,1} that is always reached for
component systems of SoS, (because Va € S0S4,a.r(Rp,) == 1). Then, the criticality of
component system of SoS 4 is always lower than the component systems of SoSp.

Finally two rules are defined in the environment Rug,, to produce RawMaterial and
Rupinaiproduct to model a consumption of Final Product by the environment. The full SApH-
ESIA description of the problem is the following:

Al - {TAll RAll ACqul LA]I FA]I GAll COStAl }
With:

& TA1 = Al

& Rga, = {{RawMaterial,0}, { MachinedProduct,0}, {Ro,,1}}
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o Acqp, =D
(>4 LAl = {Az}
& FAl = {FPmductMuchined/ FSendMuchined}

o Ga, = {{MachinedProduct > 0,1}, GDistordCriticality}}

o Costy, =1
With:

& FproductMachined =
{{RawMaterial > 1} — {{RawMaterial += —1},{MachinedProduct +=1}},ty, pm}

& FsendMachined =
{{MachinedProduct > 1} — {{MachinedProduct +=

—1},{SyS.R(MachinedProduct) +=1}},ts, ps}

Ay = {Th,, Ra, Acqay,, Ly, Fay Gay, Costa, }
With:

o Ty, = Ar

o Ry, = {{MachinedProduct,0},{ Painted Product,0},{Ron, 1} }

o Acqa, =D

o La, = {4}, A3}

& Fa, = {Fsendpainted, FProductPainted }

> Ga, = {{MachinedProduct > 0,1}, { PaintedProduct > 0,1},GDist0rdcmimlity}}

o Costp, =1
With:

& FproductPainted =
{{MachinedProduct > 1} — {{MachinedProduct += —1},{PaintedProduct +=

1}},1‘;:, Pp}

& Fsendpainted =
{{PaintedProduct > 1} — {{PaintedProduct += —1}, {SyS.R(PaintedProduct) +=

1}} s, ps}
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11.4. Experiment Description

Az = {Ta,,Ra,, Acqa,, La,, Fa,, Ga,, Costa, }
With:

o Ty, = Az

& Ry, = {{PaintedProduct,0}, {Final Product,0},{Ron, 1} }

o Acqa, =D

& La, = {A1,Bs}

& Fay = {FproductFinat, FsendFinat }

o Ga, = {{PaintedProduct > 0,1}, {Final Product == 5,1}, Gpjstorcriticatity } }

o Costy, =1
With:

& FproductFinal =
{{PaintedProduct > 1} — {{PaintedProduct += —1},{FinalProduct +=1}},t,,pp}

& FsendFinal =
{{FinalProduct > 1} — {{FinalProduct += —1},{SyS.R(FinalProduct) +=

L tr prt

By = {Ts,, Rp,, Acqp,, Lp,, Fg,, Gg,, Costp, }
With:
o Tp = By
o Rp, = {{RawMaterial,0},{ MachinedProduct,0},{Ro,,0}}
o Acqp, =@
o Lp, = {By}

& F31 = {FProductMachinedr FSendMachined}

& GBl - {{RawMaterial > O/ 1}/ GDistordCriticulity}}

o Costp, =1

By = {Ts,, Rp,, Acqs,, Ls,, F,, Gg,, Costg, }
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With:
o Tp, = B
o Rp, = {{MachinedProduct,0}, { Painted Product,0}, {Ro,,0}}
o Acqp, =@
o Lp, = {Bs}

& FBZ = {FSendPuintedz FProductPainted}

o Gp, = {{MachinedProduct > 0,1}, { Painted Product > 0,1}, Gpjstorcriticatity } }

o Costp, =1

Bs = {Ts,, Rp,, Acqg,, Ls,, F,, Gp,, Costp, }

With:
o Tp, = B3
o Rp, = {{PaintedProduct,0}, {Final Product,0},{Ro,,0}}
o Acqp, = @
o Lp, ={Bi}

& FBs = {FSendFinul/ FProductFinal}

o Gg, = {{PaintedProduct > 0,1}, {Final Product == 10,1}, GDistordC,itimlity}}

o Costp, =1

Ruggy = {@} — {A1.R(RawMaterial )+ = 0.05}, { B1.R(RawMaterial )+ = 0.05}
Rurpinaiproduct = {@} — {As.R(Final Product)— = 0.1}, { B3.R(Final Product)— = 0.1}

The values of generation and consumption (0.05 and 0.1) in these two rules have been
chosen arbitrarily.
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11.5. Results

11.5 Results

Figure 11.4 shows the different curves given by 1000 cycles of simulations. The Criticality
curves shows that the criticality of component systems of SoS 4 is always lower than SoSg.
A consequence is that the component A; gives all its Painted Product to B, and Az gives all
its Final Product to Bz through the different functionalities Fs,,  (cf. Fs.,q curve). Then, from
cycle 0 to 300, Az cannot fulfill its goal of producing 5 units of Final Product (cf. FinalProduct
curve). But, around cycle 100, the coefficient concerning the SoSp is decreasing for A, and
for Az (cf. Coeff from SoS A to SoS B curve). As a result, the criticality of B, and Bs
decreases until cycle 400. Then, A, starts giving Painted Product to Az and A3 stops giving
FinalProduct to B3, enabling A3 to fulfill its goals and then the SoS,4 to function with the
presence of the SoSp.

11.6 Discussion

At the beginning of the simulation, A, has a lower criticality than B,. Then, as soon as A, has
produced one PaintedResource, A, gives it to By thanks to Fsenipainted because its cooperative
algorithm informs it that the criticality of B, will decrease if it gives Painted Resource to By
(because B, owns the goal { Painted Product > 0,1}). But, each time Fs, painteq is used by Ay,
the criticality adaptation algorithm increments the pastInteractions|B,.getSoS()] (line 8 of
the algorithm). Moreover, as A, gives all its Painted Product, its goal { Painted Product > 0,1}
is not fulfilled. Then, the FI variable (computed thanks to the for loop from the line 4 to 6),
containing the distance between the current state and the goals of Aj, is high. As a result
of the increment of the pastInteractions[By.getSoS()] and a high value of FI, the adaptive
coefficient xg,s5,, 4, (computed in line 10) becomes to decrease, then the adapted criticality
of A for By Cp, /4, () = sps,/4, X Cp(t) becomes to decrease (cf. the curve Coeff from SoS
A to SoS B.

X305,/ A, decreases over time until stabilizing around cycle 300. The coefficient is stabiliz-
ing because the value of aAyg,s, decreases until Cy,(t) > Cg, /4, () (cf. the curve Adapted
criticality from Aj;). Then, A, becomes more critical than B, (even if Cg, () > Ca,(t)), en-
abling A; to help itself by keeping Painted Product and then giving them to A3, enabling A3
to produce Final Product (cf. the curve FinalProduct).

Once A3 starts to have Final Product (around cycle 100), the same dynamic appears be-
tween A3 and Bj: A3 begins to give FinalProduct to B3, decreases its ag,s,/4, and finally
produces more Final Product around cycle 400.

We also notice that the two adaptive coefficients agys,/4, of Ay and ag,s,/4, of A3 con-
verge to the same value.
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Figure 11.4 — Results of the experiment with the criticality adaptation
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11.7. Proof of the Uniqueness of the Normalization

11.7 Proof of the Uniqueness of the Normalization

Our experimentation shows that the coefficients ag,s,, 4, of A> and ag,s,,4, of A3 converge
to the same value. It also shows that learning these coefficients takes time and requires that
Aj and Az exchange with component systems of SoSg, thus reducing the efficiency of both
Az and A3z. That is why we propose to prove that these coefficients «g,s,, 4, are the same
for all the component systems of S0S 4 communicating with component systems of S0Sp. In
other terms, we are going to prove that the coefficient of normalization from SoS4 for SoSp
is unique. This proof is composed of 3 parts:

o the first is dedicated to show that the decision of a component system is invariant with
the range of criticalities of the SoS;

o the second is the fact that non-normalization of the different ranges between several
SoS prevent the cooperation between them;

o the third is the proof of the uniqueness of the coefficient of criticality normalization
between two SoS.

The first part of the proof is to show that the decision of a component system S from a
SoS is invariant when multiplying its criticality range by a constant.
Let [0,C MAX sos] be the interval of the criticality of SoS. As the criticality is a metric superior
to zero, then CMAX¢ o > 0. As the decision is based on the leximin of the cooperation table
computed with algorithm 5.1 (see chapter 5 for more details) the decision of the component
system S is based on the order of the criticalities of its neighborhood. If the whole table
is multiplied by the same constant, the order is not changed, thus the decision of S is not
changed. We can then conclude that the decision of a component system is invariant with
the criticality range of the SoS.

Secondly, the non-normalization of the different criticality ranges between SoS prevents
them to cooperate.
As an example, let A be a component system of SoS4 and let B be a component system
of SoSp. To lighten the notation we note C4 the criticality of A (instead of C,(t), even if
Ca depends of the time). Let [0, CMAX g 4010, CcMAX sos;] be respectively the intervals of
criticalities of SoS4 and SoSp. As, in the general case CMAX o L F CMAX Sosy, let suppose
that CMAXSOSA < CMAXSOSB. Let {va,,...,va,} € S0S4 be the neighborhood of A in SoS4
and {vg,, ..., v, } € SoSp the neighborhood of A but in SoSp. As CMAXSOSA < CMAxgosB, it
can happen that (as we have seen in the previous experimentation) the order of criticalities
are the following {Cy, < .. < Cy,, < Cyy < ... < Gy, }. In this case, A cannot help its
own neighborhood but always helps the component systems of B. Then the S0S4 cannot
properly cooperate with SoSg when the ranges are not normalized.

Now we are going to prove that the coefficient of normalization is unique. To always be
able to compare the criticality of A in SoS 4 with the one of B of SoSg, the adapted criticality
of B for A (noted Cp;4 = tsp5,/4 X Cp with cMAX /A its maximum) has to be normalized
such as:

MAX _ ~MAX
CM %65, =C B/A
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MAX _ MAX
& CM %605, = &ge5,74 X CM %505,

MAX
CY 505,

& KSeSp/A = 7cMAXSGSB

MAX
C SoS 4

Then, the only value possible is asy5,/4 = A,
05B

In this way, all the criticality values of SoSg are comparable with the ones coming from

SoS4. Furthermore, as the criticalities of SoSg are only multiplied by a constant value

CMAX g o . e 1
(Xs055/A = W) it does not change the order of the criticalities and then does not change
05

the decision of the component system. So, the value of the coefficient for adapting the criti-
cality from a SoS to another is unique. The advantage of this uniqueness is the possibility to
share a learned coefficient between the component systems of the same SoS.

11.8 Conclusion

This final experiment chapter presents an extension of our cooperative algorithm that is
a new algorithm that enables component systems to adapt their criticality when working
with other SoS. Indeed, the criticality of a SoS may be computed in a different way than the
criticality of another SoS because they have been independently designed. This experiment
shows that in this case, our algorithm of criticality adaptation enables two SoS to work in the
same environment together by the self-normalization of the criticality of their component
systems. Moreover, we prove that the coefficient of normalization can be shared between
the component systems of a same SoS to save time on the learning phase of the coefficient.
As previously said, this problematic also appears in the AMAS approach. This proof is
applicable to the AMAS approach by replacing a component system by an agent and a SoS
by an AMAS.
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The System of Systems research area is a widely open one. As a new and trans-domain
research area, a lot of efforts have been made to find the generic characteristics and
definitions of the notion of SoS. It is common to define a SoS as a subclass of a complex
system where the component systems (the parts of the SoS) have specific characteristics
such as managerial and operational independence. As a complex system, a SoS evolves in a
dynamic environment where unpredictable events may occur and be harmful for the SoS.
To cope with this problematic, SoS has to self-architect in a dynamic manner.

Contributions

After summarizing literature on generic SoS characteristics and definitions, we have pro-
posed a working definition that takes into account the most common generic accepted char-
acteristics of SoS as well as the notion of dynamic environment. Finally two generic SoS
models are presented with a focus on their limitations concerning the interactions between
component systems, the environment model and their global expressiveness. That is why
the first contribution of this thesis is a new SoS generic model suiting our working definition
of a SoS. It enables to model the Maier’s criteria such as the managerial and the operational
independence of the components and their geographical distribution. The notions of envi-
ronment and interactions between component systems have been extended from existing
SoS models. The dynamics of the environment is taken into account through active entities
and the rules that have effects on interactions of component systems.

We presented two SoS architecting heuristics and showed that they do not respect some
of the core principles proposed by [Azani, 2008] such as the open interface and the self-
government principles. As the simulation of SoS is also an important field of research, we
have explained the main paradigms and tools used to simulate SoS such as DEVS and ABS.
We also presented the AMAS approach, used to create multi-agents systems where the over-
all functionality emerges from the self-organization of its parts driven by their cooperation.
The AMAS approach can be an interesting paradigm to implement a new SoS architecting
heuristic that respects the open interface and the self-government principles. That is why
we have proposed a SoS architecting heuristic implemented through an algorithm that uses
cooperation as a social behavior to enable self-organization of the component systems of
the SoS. The cooperation is implemented through the concept of criticality that we have
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formalized to propose a reusable metric beyond the scope of the SoS. As a bottom-up ap-
proach, our heuristic is decentralized (does not need a central management entity) and en-
ables to architect virtual and collaborative SoS. It is also open, (i.e., component systems can
be added/removed at runtime) enabling to respect the open interface principle of SoS.

The third contribution concerns architecting tools to simulate generic SoS. We propose
SML, an XML language defined to easily declare SoS through XML files. Furthermore, vi-
sualization tools have been developed to analyze resources and criticality evolution during
experiments.

As we have searched but did not find any case studies with real and usable data to eval-
uate our work, we have evaluated our propositions through four experimentations found
in literature or made by ourselves. The first experimentation concerns the Missouri Toy
problem that is a communication transportation problem. It has been chosen because it has
been already studied and it is a good starting point for testing our heuristic concerning its
robustness and its capacity to be functionally adequate. The results show that our heuristic
is robust, functionally adequate and open.

The second experimentation concerns CoCaRo, a resources transportation system we
have defined to validate two contributions. The first relates to the metric of criticality en-
abling cooperation between agents. The second one uses SApHESIA to define an agent
(which is a component system) representing an overall AMAS in order to enable to several
AMAS to work together and improve their performances. The results show that the critical-
ity enables cooperation between agents and improves the global performance of the system
and its robustness. Moreover, the use of SApHESIA also improves the performance of the
system.

The third experimentation concerns the instantiation of a UAV fleet within a hostile envi-
ronment. It enables the comparison of our heuristic with satisficing games regarding to the
overall performance of the system. The results of our experiments show that our approach
is competitive with satisficing games in term of performance. Furthermore, experiments
with numerous component systems validate our complexity analysis by showing that the
computational cost of our approach is linear with the number of component systems.

The fourth experimentation relates to the capacity of our approach to reuse and combine
existing SoS that are independently designed but interdependent. The results show that the
notion of criticality between two SoS enables in a natural way their combination.

The final experiment proposes an improvement of our heuristic: component systems
from different SoS may have to adapt their criticalities if these latter do not have the same
scale if they detect issues concerning the comparison of the criticality. The results show
that our algorithm of criticality adaptation enables the coupling of two SoS even if their
respective criticalities have different scales.

Finally, all of the results show that our approach is a generic SoS architecting heuristic
that respects the set of principles for efficient SoS Architecting defined by [Azani, 2008] such
as the self-government and open interface principles. Its total decentralization enables to
find alternative architectures for virtual and collaborative SoS.
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Perspectives

Even if our work showed interesting results, it is only a tiny part, a modest contribution
with regards to what it remains to do in the vast SoS research area.

Concerning short-terms perspectives, testing our approach with more component sys-
tems will enable to validate that our heuristic can scale-up. Because of the number, the
complexity and the heterogeneity of the systems involved, domains such as smart cities
and factories of the future could be future case studies. Furthermore, implementing other
heuristics than the cooperation in SApHESIA would enable to compare our results for the
same experiments.

Concerning mid-terms perspectives, we think that this work on the SoS field could be
extended to the AMAS approach. It would be interesting to reify every component system
of a SoS into an AMAS agent in order to transform a SoS into an AMAS. In this way, the
component system model could be a basis to a formal model of an AMAS agent. Indeed, the
AMAS approach has been instantiated in several domains and is mature to be generalized
and formalized. It could enable to propose a generic algorithm of cooperation such as the
one we propose in this thesis.

Concerning long-term perspectives, to collaborate with SoS experts to define more com-
plex examples with real data and real case studies is possible. Thanks to the simplicity
and the ability of our heuristic to find architecture solution with loops and non-linearity,
our heuristic could be the first step of a more global process of SoS design. The use of our
SApHESIA tools could enable SoS designers to do high level simulations of SoS and then
proposing first solutions of architecture.
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Abbreviations

ABS Agent-Based Simulation

AMAS Adaptive Multi-Agent System

DoD Department of Defense

FIE Fuzzy Inference Engine

FIS Fuzzy Inference System

INCOSE International Council on Systems Engineering
KPA Key Performance Attribute

NCS Non-Cooperative Situation

SAHS SoS Architecting Heuristic Simulation
SApHESIA SoS Architecting HEuriStlc based on Agents
SAR Search And Rescue

SE Systems Engineering

SML SApHESIA Modeling Language

SoS System of Systems

SoSE Systems of Systems Engineering

UAV Unmanned Aerial Vehicle
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Annex 1

This annex proposes examples of SML. The SML is a XML language used to declare SApH-
ESIA models in XML files that are used as inputs of our simulation tools. The syntax of the
SML is formally described in the chapter 6.

System

As an example, let’s take Sat 43, a component system of type Sat 4 of the Missouri toy model.
In this example, the generic SApHESIA model for Sat 43 is:

SatAS = {TSﬂtA3RSﬂtA3I ACqSﬂtAsl LSﬂtA3/ FSﬂtA3/ GSﬂtA3/ COStSﬂtA3}

With:

& TSutA3 = SATA

> Rgat,, = {{Signal,20}}

o Acqsat,, = {UAVy, UAV3, Carrier}

& LSatA3 = {UAV3,1}

& Fsat,y = {Frinksatas Fsend }

& Gsatyy = {GLinks Gsend }

o Costgg,, = 100

Then, its translation in SML is the following:

<System>
<Name> SatA3 </Name>
<Type> SatA </Type>

<Resource>
<Type> Signal </Type>
<Quantity> 20 </Quantity>
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</Resource>

<Acquaintance>
<To> UAV3 </To>
<To> UAV1 </To>
<To> Carrier </To>
</Acquaintance>

<Link>
<Intensity> 1 </Intensity>
<To> UAV3 </To>

</Link>

<Functionality > F_LinkSatA </Functionality>
<Functionality > F_Send </Functionality>

<Goal>
<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>
<Goal>
<Object> Link </Object>
<Type> EQ </Type>
<Value> 2 </Value>
<Priority> 1 </Priority>
</Goal>

<Cost> 100 </Cost>
</System>

Functionality

As a example, we propose the functionality Fs,,s used in the Missouri Toy problem:
Fseng = {{Signal > 1} —
{Signal += —1}, {Rcostsena += 1}, {Signal += —1},{SyS, Signal += 1}, tsend, Psend }
The functionality Fs,,s consumes one resource Signal and create one resource Signal to

a component system of type UAV, SatA, SatB, Carrier, it has a probability of 0.7 to success
and takes one unit of time to proceed.

<Functionality >
<Name> F_Send </Name>
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<Condition>
<Type> Resource </Type>
<Name> Signal </Name>
<Quantity> 1 </Quantity>
<ResourceOp> == </ResourceOp>

</Condition>

<Effect>
<Type> Resource </Type>
<Name> Signal </Name>
<Quantity> —1 </Quantity>

</Effect>

<Effect>
<Type> Resource </Type>
<Name> Signal </Name>
<Quantity> 1 </Quantity>
<To> UAV, SatA, SatB, Carrier </To>

</Effect>

<Time> 1 </Time>

<Performance> 0.7 </Performance>

</Functionality>

Goals

<Type>: String

<Object>: String

For example, if a goal of is to get zero resource of type Signal, it has to be declared as:

<Goal>

</Goal>

Rule

<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>

As an example, hereafter a rule generating the resource Signal to the component system
Ground when this one has its resource Rp,, superior to 0:

<Rule>
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<Condition>
"Ground .R_On” SUP 0
</Condition>
<Effect>
"Ground. Signal © EQ ’"Ground.Signal” + 0.09
</Effect>

</Rule>

SML file of Missouri Toy Model

The SML file for the simulation of the Toy Problem presented in chapter 7. This file contains:

o two functionalities Fj;,xsaea and Fippink;
o four component systems are also presented: Carrier, Ground, UAV; and Sat 4

o two rules Ruler,, and Rulegeneratesignal-

<505>
<Functionality >
<Name> F_Send </Name>
<Performance> PerfSend </Performance>
<Time> 1</Time>
<Name> Signal </Name>
<Quantity> 1 </Quantity>
<Type> Resource </Type>
</Condition>
<Effect>
<Name> Signal </Name>
<Quantity> —1 </Quantity>
<Type> Resource </Type>
</Effect>
<Effect>
<Name> Signal </Name>
<Quantity> 1 </Quantity>
<Type> Resource </Type>
<To> SyS </To>
</Effect>
</Functionality>

<Functionality >
<Name> F_UnLink </Name>
<Performance> 1 </Performance>
<Time> 1 </Time>
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<Condition>
<Name> SyS </Name>
<Quantity> 1 </Quantity>
<Type> Link </Type>

</Condition>

<Effect>
<Name> Link </Name>
<Quantity> —1 </Quantity>
<Type> Link </Type>

</Effect>

<Effect>
<Name> R_Link </Name>
<Quantity> —1 </Quantity>
<Type> Resource </Type>

</Effect>

<Effect>
<Name> R_LinkResource </Name>
<Quantity> 1 </Quantity>
<Type> Resource </Type>
<To> SyS </To>

</Effect>

</Functionality>

<Functionality >
<Name> F_LinkSatA</Name>
<Performance> 1 </Performance>
<Time> 1 </Time>
<Condition>
<Name> SatA </Name>
<Quantity> 1 </Quantity>
<Type> System </Type>
</Condition>
<Effect>
<Name> Link </Name>
<Quantity> 1 </Quantity>
<Type> Link </Type>
</Effect>
<Effect>
<Name> R_Link </Name>
<Quantity> 1 </Quantity>
<Type> Resource </Type>
</Effect>
<Effect>
<Name> R_LinkResource </Name>
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<Quantity> —1 </Quantity>
<Type> Resource </Type>
<To> SatA </To>
</Effect>

</Functionality>

<System>

<Name> Carrier </Name>
<Type> Carrier </Type>
<Cost> 1 </Cost>
<Resource>
<Type> Signal </Type>
<Quantity> 0 </Quantity>
</Resource>
<Resource>
<Type> R_Cost </Type>
<Quantity> 0 </Quantity>
</Resource>
<Resource>
<Type> R_LinkResource </Type>
<Quantity> 5 </Quantity>
</Resource>
<Goal>
<Object> Signal </Object>
<Type> SUP </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>

</System>

<System>

<Name> Ground </Name>
<Type> Ground </Type>
<Id>1 </Id>
<Id>1 </Id>

<Functionality > F_Send </Functionality>
<Functionality > F_LinkUAV </Functionality>
<Functionality > F_LinkSatA </Functionality>
<Functionality > F_LinkSatB </Functionality>
<Functionality > F_UnLink </Functionality>
<Resource>

<Type> Signal </Type>
<Quantity> 0 </Quantity>
</Resource>
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<Resource>
<Type> R_CostSend </Type>
<Quantity> 1 </Quantity>
</Resource>
<Resource>
<Type> PerfSend </Type>
<Quantity> 0.1 </Quantity>
</Resource>
<Resource>
<Type> PerfSendUAV1 </Type>
<Quantity> 0.7 </Quantity>
</Resource>
<Resource>
<Type> PerfSendUAV3 </Type>
<Quantity> 0.7 </Quantity>
</Resource>
<Resource>
<Type> Turn </Type>
<Quantity> 0 </Quantity>
</Resource>
<Resource>
<Type> R_GenerationRate </Type>
<Quantity> 0.3 </Quantity>
</Resource>
<Resource>
<Type> R_FinalTurn </Type>
<Quantity> 2000 </Quantity>
</Resource>
<Goal>
<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>
<Goal>
<Object> Link </Object>
<Type> SUP </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>

</System>

<System>

<Name> UAV1 </Name>
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<Type> UAV </Type>
<Cost> 1 </Cost>
<Functionality > F_Send </Functionality>

<Functionality > F_LinkUAV </Functionality>
<Functionality > F_LinkSatA </Functionality>
<Functionality > F_LinkSatB </Functionality>
<Functionality > F_LinkCarrier </Functionality>
<Functionality > F_UnLink </Functionality>

<Resource>
<Type> Signal </Type>
<Quantity> 0 </Quantity>
</Resource>
<Resource>
<Type> R_CostSend </Type>
<Quantity> 1 </Quantity>
</Resource>
<Resource>
<Type> R_LinkResource </Type>
<Quantity> 5 </Quantity>
</Resource>
<Resource>
<Type> PerfSend </Type>
<Quantity> 0.1 </Quantity>
</Resource>
<Resource>
<Type> PerfSendAl </Type>
<Quantity> 0.5 </Quantity>
</Resource>
<Goal>
<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>
<Goal>
<Object> R_Link </Object>
<Type> SUP </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>

</System>

<System>

<Name> SatAl </Name>
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<Type> SatA </Type>
<Cost> 1 </Cost>

<Functionality > F_Send </Functionality>
<Functionality > F_LinkUAV </Functionality>
<Functionality > F_LinkSatA </Functionality>
<Functionality > F_LinkCarrier </Functionality>
<Functionality > F_UnLink </Functionality>
<Resource>

<Type> Signal </Type>
<Quantity> 0 </Quantity>
</Resource>
<Resource>
<Type> R_CostSend </Type>
<Quantity> 1 </Quantity>
</Resource>
<Resource>
<Type> R_LinkResource </Type>
<Quantity> 5 </Quantity>
</Resource>
<Resource>
<Type> PerfSend </Type>
<Quantity> 0.1 </Quantity>
</Resource>
<Resource>
<Type> PerfSendCarrier </Type>
<Quantity> 1 </Quantity>
</Resource>
<Goal>
<Object> Signal </Object>
<Type> EQ </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>
<Goal>
<Object> R_Link </Object>
<Type> SUP </Type>
<Value> 0 </Value>
<Priority> 1 </Priority>
</Goal>
</System>

<Environment>
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<Rule>
<Condition>
"Ground . Turn’ INF ’Ground.R_FinalTurn’
</Condition>

<Effect>
"Ground . Signal © = 'Ground.Signal’ + ’Ground.R_GenerationRate ’
</Effect>
</Rule>

<Rule>
<Condition>
True
</Condition>
<Effect>
"Ground . Turn’ = ’'Ground.Turn’ + 1
</Effect>
</Rule>

</Environment>

</S0S>

192 Teddy Bouziat



Annex B

This annex presents the curves concerning the different functions of criticalities for a goal g:
¢ = {Reop Qu,Pr}
where:

o Reis a type of resource;
o Qu € R is the quantity of resource of type Re the component system wants to own;

o Op € {=,#,<,>,<, >} is the comparison operator in order to compare Qu to the cur-
rent quantity of Re;

o Pr € INT is the priority of the goal enabling to model the relative importance of a goal.
The higher the priority is, the more important the goal is.

As a reminder, the following functions are used for the calculation of the criticality of the
goal g at time t Cy(t):

1

(1):1- o< By (1)

1
@

Ce(t) = atan((x x A 1
S PR ORS

11
@ atan((«a xﬁg(t)) +5

(1): if g.0p € {=}: the goal g is to reach a given quantity Qu of resource Re;

(2): if g.0p € {#}: the goal g is to be as far as possible from a given quantity Qu for the
resource Re;

(3): if g.0p € {<,=<}: the goal g is to be inferior or equal to a given quantity Qu for the
resource Re;

(4): if g.0p € {>,=>} the goal g is to be superior or equal to a given quantity Qu for the
resource Re .

With :
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(01 - exp(-0.03%(x-20)"2)

Figure 11.5 — Example of a goal criticality: reach a value (3.0p € {=})

o> Ag(t) = §.Qu — S.R(g.Re)(t) is the difference between the given quantity Qu and the
current amount of resource Re of S;

o S.R(g.Re)(t) is the current amount of resource Re of component system S at time ;

o wais a coefficient value that influences the shape of the curve.

Figures 11.5,11.6, 11.7 and 11.8 present four examples of goal criticality functions. Nu-
merical values are the following:

o ¢.Qu = 20;

o a = 0.01 for the red dotted curve (figure 11.5), « = 0.03 for the others.

The shape of these functions can be changed according to the variation of the parameter
«. It enables to control how the goal value is important to reach or to avoid. For exam-
ple, the fact to choose a higher a parameter for the red function will lead to a component
system which tends to stay really critical even if it is close to its goal. The variation of this
parameter in the goal criticality function is not studied in this document. Nevertheless, an
example for two values of « is given on figure 11.5. The red functions (figure 11.5) represent
decreasing criticality when reaching objective (¢.Op € {=}). The blue function (figure 11.6)
represents increasing criticality when reaching an unwanted value g.0p € {#}. The light
green one (figure 11.7) represents decreasing criticality when a resource being lower than a
given threshold g.Op € {>,=>}. The dark green one (figure 11.8) represents decreasing
criticality when a resource being greater than a given threshold g.0p € {>,=>}.
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Criticality

fx)=exp(-0.03*(x-20)"2)|

Figure 11.6 — Example of a goal criticality: avoid a value (§.0p € {#})

Criticality

f(x)=1- (atan(1.5*(20-x)) + Pir’2)/’pi‘

Figure 11.7 — Example of a goal criticality: to be inferior or equal to a value (3.0p € {<,=<

D

[fx)=(atan(1.5%(20-x)) + Pi/2)/pi

Figure 11.8 — Example of a goal criticality: Be superior or equal to a value (.0p € {>,=>1})

195






Bibliography

[Acheson et al., 2012] Acheson, P., Pape, L., Dagli, C., Kilicay-Ergin, N., Columbi, J., and
Haris, K. (2012). Understanding system of systems development using an agent- based
wave model. Procedia Computer Science, 12:21 — 30.

[Archibald et al., 2006a] Archibald, J. K., Hill, J. C., Johnson, F. R., and Stirling, W. C. (2006a).
Satisficing negotiations. Trans. Sys. Man Cyber Part C, 36(1):4-18.

[Archibald et al., 2006b] Archibald, J. K., Hill, J. C., Johnson, F. R., and Stirling, W. C.
(2006b). Satisficing negotiations. IEEE Transactions on Systems, Man, and Cybernetics, Part
C (Applications and Reviews), 36(1):4-18.

[Ashby, 1956] Ashby, W. R. (1956). An introduction to cybernetics. London, UK : Chpaman &
Hall.

[Axelsson, 2015] Axelsson, J. (2015). A systematic mapping of the research literature on
system-of-systems engineering. In 10th System of Systems Engineering Conference (SoSE),
pages 18-23.

[Azani, 2008] Azani, C. (2008). An Open Systems Approach to System of Systems Engineering,
pages 21-43. John Wiley and Sons, Inc.

[Baldwin and Sauser, 2009] Baldwin, W. and Sauser, B. (2009). Modeling the characteristics
of system of systems. IEEE International Conference on System of Systems Engineering (SoSE).

[Baldwin et al., 2015] Baldwin, W. C., Sauser, B. J., and Boardman, J. (2015). Revisiting the
meaning of of as a theory for collaborative system of systems. IEEE Systems Journal,
PP(99):1-12.

[Banks et al., 2005] Banks, J., Carson, ]J., Nelson, B., and D.M., N. (2005). Discrete-event Sys-
tem Simulation (Fourth Edition). Prentice-Hall international series in industrial and systems
engineering. Prentice Hall.

[Behdani, 2012] Behdani, B. (2012). Evaluation of paradigms for modeling supply chains as
complex socio-technical systems. In Proceedings of the Winter Simulation Conference, WSC
12, pages 413:1-413:15. Winter Simulation Conference.

[Benites Gongalves, 2016] Benites Gongalves, M. (2016). Supporting architectural design of ac-
knowledged Software-intensive Systems- of-Systems. Phd thesis, Université de Bretagne Sud.

197



Bibliography

[Bessadi et al., 2016] Bessadi, A. K., Jamont, J.-P., Occello, M., Ben Yelles, C. B., and Koudil,
M. (2016). About cooperation of multiagent collective products: An approach in the con-
text of cyber-physical systems. In 2016 IEEE RIVF International Conference on Computing
& Communication Technologies, Research, Innovation, and Vision for the Future (RIVF), pages
19-24, Hanoi, Vietnam. IEEE.

[Bjelkemyr et al., 2007] Bjelkemyr, M., Semere, D., and Lindberg, B. (2007). An engineering
systems perspective on system of systems methodology. In Systems Conference, 2007 1st
Annual IEEE, pages 1-7.

[BKCASE Editorial Board, 2014] BKCASE Editorial Board (2014). Guide to the Systems En-
gineering Body of Knowledge. Guide to the Systems Engineering Body of Knowledge (SEBoK),
page 945.

[Boardman and Sauser, 2006] Boardman, J. and Sauser, B. (2006). System of systems - the
meaning of of. In 2006 IEEE/SMC International Conference on System of Systems Engineering,
pages 118-123.

[Boes, 2014] Boes, J. (2014). Apprentissage du contrdle de systemes complexes par I'auto-
organisation coopérative d’'un systéeme multi-agent. Phd thesis, Université de Toulouse,
Toulouse, France.

[Bonabeau, 2002] Bonabeau, E. (2002). Agent-based modeling: methods and techniques
for simulating human systems. Proceedings of the National Academy of Sciences, 99(suppl.
3):7280-7287.

[Boulding, 1956] Boulding, K. E. (1956). General systems theory—the skeleton of science.
Management Science, 2(3):197-208.

[Bouziat et al., 2016] Bouziat, T., Camps, V., and Combettes, S. (2016). Cooperation in Adap-
tive Multi-Agent Systems through System of Systems modeling. In Global Conference on
Artificial Intelligence (GCAI), volume 41, pages 214-226.

[Bouziat et al., 2017] Bouziat, T., Combettes, S., Camps, V., and Boes, J. (2017). Cooperative
Multi-Agent Approach for Computational Systems of Systems Architecting. In Interna-
tional Conference on Agents and Artificial Intelligence (ICAART). SciTePress.

[Bouziat et al., 2014] Bouziat, T., Combettes, S., Camps, V., and Glize, P. (2014). La criticité
comme moteur de la coopération dans les systemes multi-agents adaptatifs. In Journées
Francophones sur les Systemes Multi-Agents (JFSMA), pages 149-158. Cepadues Editions.

[Caffall and Michael, 2009] Caffall, D. and Michael, J. (2009). System of Systems Collabora-
tive Formation. Systems Journal, 3(3):385-401.

[Camps, 1998] Camps, V. (1998). Vers une théorie de I'auto-organisation dans les systémes
multi-agents basée sur la coopération : application a la recherche d'information dans un systeme
d’information répartie. Phd thesis, Université Paul Sabatier, Toulouse, France.

[Capera, 2005] Capera, D. (2005). Systemes multi-agents adaptatifs pour la résolution de prob-
lemes: Application a la conception de mécanismes. Phd thesis, Université Paul Sabatier,
Toulouse, France.

198 Teddy Bouziat



Bibliography

[Capera et al., 2003] Capera, D., George, J., Gleizes, M., and Glize, P. (2003). The AMAS
theory for complex problem solving based on self-organizing cooperative agents. Pro-
ceedings of the Workshop on Enabling Technologies: Infrastructure for Collaborative Enterprises,
WETICE, 2003-January:383-388.

[CARLOCK and FENTON, 2001] CARLOCK, P. G. and FENTON, R. E. (2001). System of
systems (sos) enterprise systems engineering for information-intensive organizations.
Systems engineering, 4(4):242-261.

[Ceccarelli et al., 2015] Ceccarelli, A., Mori, M., Lollini, P., and Bondavalli, A. (2015). Intro-
ducing meta-requirements for describing system of systems. In IEEE 16th International
Symposium on High Assurance Systems Engineering, pages 150-157.

[Crossley and Professor, 2004] Crossley, W. A. and Professor, A. (2004). System of systems:
An introduction of purdue university schools of engineering’s signature area," paper pre-
sented at the engineering systems symposium.

[Dagli and Acheson, 2012] Dagli, C. H. and Acheson, P. (2012). Fuzzy assessor using type 1
and type 2 fuzzy sets. Procedia Computer Science, 8:159 — 164.

[Dahmann et al., 2009] Dahmann, D. J., Baldwin, K. J., and Rebovich, G. (2009). Systems of
systems and net-centric enterprise systems. 7th Annual Conference on SyStems Engineering
Research.

[De Wolf and Holvoet, 2005] De Wolf, T. and Holvoet, T. (2005). Emergence Versus Self-
Organisation: Different Concepts but Promising When Combined, pages 1-15. Springer, Berlin,
Heidelberg.

[DeLaurentis et al., 2012] DeLaurentis, D. A., Marais, K., Davendralingam, N., Yeob Han,
S., Uday, P, Fang, Z., and Guariniello, C. (2012). Assessing the Impact of Development
Disruptions and Dependencies in Analysis of Alternatives of System-of-Systems. TechRe-
port SERC-2012-TR-035, Purdue University, West Lafayette,IN.

[Di Marzo Serugendo et al., 2011] Di Marzo Serugendo, G., Gleizes, M.-P., and Karageor-
gos, A. (2011). Self-organising Software: From Natural to Artificial Adaptation. Springer
Publishing Company, Incorporated, 1st edition.

[DoD, 2006] DoD (2006). System of systems systems engineering guide: Considerations
for systems engineering in a system of systems environment. Techreport, Department of
Defense.

[Drogoul et al., 2013] Drogoul, A., Amouroux, E., Caillou, P., Gaudou, B., Grignard, A.,
Marilleau, N., Taillandier, P., Vavasseur, M., Vo, D. A., and Zucker, J.-D. (2013). Gama:
multi-level and complex environment for agent-based models and simulations (demon-
stration). In International Joint Conference on Autonomous Agents and Multiagent Systems -
AAMAS 2013, pages 1361-1362. IFAAMAS.

[Edward Pape II, 2016] Edward Pape II, L. (2016). A domain independent method to assess sys-
tem of system meta-architectures using domain specific fuzzy information. PhD thesis, Missouri
University of Science and Technology.

199



Bibliography

[Ferber, 1995] Ferber, J. (1995). Les Systemes multi-agents: vers une intelligence collective. 1.1.A.
Informatique intelligence artificielle. InterEditions.

[Georgé, 2004] Georgé, J.-P. (2004). L'émergence. Rapport de recherche 2003-12-R, IRIT,
Université Paul Sabatier, Toulouse.

[Gilbert, 2008] Gilbert, N. (2008). Agent-Based Models. Sage Publications, London.

[Glize, 2001] Glize, P. (2001). L’Adaptation des Systemes a Fonctionnalite Emergente par Auto-
Organisation Cooperative. Habilitation a diriger des recherches, Université Paul Sabatier,
Toulouse, France.

[Gongalves et al., 2014] Gongalves, M. B., Cavalcante, E., Batista, T., Oquendo, F., and Naka-
gawa, E. Y. (2014). Towards a conceptual model for software-intensive system-of-systems.
In 2014 IEEE International Conference on Systems, Man, and Cybernetics (SMC), pages 1605-
1610.

[Gorod et al., 2008] Gorod, A., Sauser, B., and Boardman, J. (2008). System-of-systems en-
gineering management: A review of modern history and a path forward. IEEE Systems
Journal, 2(4):484—499.

[Guivarch, 2014] Guivarch, V. (2014). Prise en compte de la dynamique du contexte pour les
systemes ambiants par systémes multi-agents adaptatifs. Phd thesis, Université de Toulouse,
Toulouse, France.

[Henshaw et al., 2013] Henshaw, M., Siemieniuch, C., Sinclair, M., Barot, V., Henson, S.,
Ncube, C., Lim, S., Dogan, H., Jamshidi, M., and Delaurentis, D. (2013). The Systems of
Systems Engineering Strategic Research Agenda Systems of Systems Engineering. (2).

[Hill et al., 2005] Hill, J. C., Johnson, E. R., Archibald, J. K., Frost, R. L., and Stirling, W. C.
(2005). A cooperative multi-agent approach to free flight. In Proceedings of the Fourth
International Joint Conference on Autonomous Agents and Multiagent Systems, AAMAS ’05,
pages 1083-1090. ACM.

[Hu et al., 2005] Hu, X., Zeigler, B. P, and Mittal, S. (2005). Variable structure in devs
component-based modeling and simulation. Simulation, 81(2):91-102.

[IEEE, 2010] IEEE (2010). Systems and software engineering — vocabulary. ISO/IEC/IEEE
24765:2010(E), pages 1-418.

[Jackson, 2003] Jackson, M. O. (2003). Mechanism Theory. Oxford UK.

[Jamshidi, 2008a] Jamshidi, M. (2008a). System of systems engineering - new challenges for
the 21st century. IEEE Aerospace and Electronic Systems Magazine, 23(5):4-19.

[Jamshidi, 2008b] Jamshidi, M. (2008b). Systems of Systems Engineering: Principles and Appli-
cations. CRC Press.

[Johnson, 2001] Johnson, S. (2001). Emergence: the connected lives of ants, brains, cities, and
software. Scribner.

200 Teddy Bouziat



Bibliography

addoum, adaoum, L. . timisation sous contraintes de problemes distribués
[Kadd 2011] Kadd E. (2011). Optimisati ] de proble distribué
par auto-organisation coopérative. Phd thesis, Université de Toulouse, Toulouse, France.

[Lemouzy, 2011] Lemouzy, S. (2011). Systemes interactifs auto-adaptatifs par systemes multi-
agents auto-organisateurs : application a la personnalisation de l'acces a l'information. Phd
thesis, Université de Toulouse, Toulouse, France.

[Lukasik, 1998] Lukasik, S. J. (1998). Systems, systems of systems, and the education of
engineers. Artificial intelligence for engineering design analysis and manufacturing, 12(1):55-
60.

[Maier, 1998] Maier, M. (1998). Architecting principles for systems-of-systems. Systems En-
gineering, 1(4):267-284.

[Manthorpe, 1996] Manthorpe, W. H. J. (1996). The emerging joint system of systems: A
systems engineering challenge and opportunity for apl. John Hopkins APL Tech Dig, pages
305-310.

[Mittal et al., 2014] Mittal, S., Doyle, M. J., and Portrey, A. M. (2014). Human in the Loop in
System of Systems (S0S) Modeling and Simulation, pages 415-451. John Wiley & Sons, Inc.

[Mittal and Luis Risco Matin, 2013] Mittal, S. and Luis Risco Matin, J. (2013). Netcentric Sys-
tem of Systems Engineering with DEV'S Unified Process). CRC press.

[Morin, 1977] Morin, E. (1977). La méthode: La Nature de la nature (t.1). Editions du Seuil,
Paris.

[Mour et al., 2013] Mour, A., Kenley, C. R., Davendralingam, N., and DeLaurentis, D.
(2013). Agent-based modeling for systems of systems. INCOSE International Symposium,
23(1):973-987.

[Mrissa et al., 2015] Mrissa, M., Médini, L., Jamont, J.-P., Le Sommer, N., and Laplace, ]J.
(2015). An Avatar Architecture for the Web of Things. Internet Computing, IEEE, pages
30-38.

[Myerson, 1983] Myerson, R. (1983). Mechanism design by an informed principal. Econo-
metrica, 51(6):1767-97.

[Paredis et al., 2013] Paredis, C.]., Bishop, C., Bodner, D., Acheson, P., Dagli, C., and Kilicay-
Ergin, N. (2013). Model based systems engineering for system of systems using agent-
based modeling. Procedia Computer Science, 16:11 —19.

[Paz et al., 2016] Paz, J. E. D., Bajo, J., Rodriguez, S., Villarrubia, G., and Corchado, ]J. M.
(2016). Intelligent system for lighting control in smart cities. Information Sciences, 372:241—
255.

[Picard, 2004] Picard, G. (2004). Methodology for developing adaptive multi-agent systems and
designing software with emergent functionality. Phd thesis, Université Paul Sabatier Toulouse
1.

201



Bibliography

[Rincon et al., 2016] Rincon, J. A., Bajo, J., Fernandez, A., Julian, V., and Carrascosa, C.
(2016). Using emotions for the development of human-agent societies. Frontiers of In-
formation Technology & Electronic Engineering, 17(4):325-337.

[R.S,2000] R.S, P. (2000). Systems of systems integration (sosi) - a smart way of acquiring
army c412ws systems. In Proceedings of the Summer Computer Simulation Conference, pages
134-139.

[Russell and Norvig, 2002] Russell, S. J. and Norvig, P. (2002). Artificial Intelligence: A Mod-
ern Approach. Prentice Hall series in artificial intelligence. Prentice Hall, second edition.

[Saaty, 1980] Saaty, T. (1980). The Analytic Hierarchy Process, Planning, Piority Setting, Resource
Allocation. McGraw-Hill, New york.

[Selberg and Austin, 2008] Selberg, S. and Austin, M. (2008). Toward an evolutionary sys-
tem of systems architecture. 18th Annual International Symposium of the International Coun-
cil on Systems Engineering, INCOSE 2008, 4(1):2394-2407.

[Simon, 1956] Simon, H. A. (1956). Rational choice and the structure of the environment.
Psychological Review, 63(2):129-138.

[Squazzoni, 2012] Squazzoni, F. (2012). What is Agent-Based Computational Sociology all
About?, pages 1-32. John Wiley & Sons, Ltd.

[Stirling, 2005] Stirling, W. (2005). Social utility functions - part i: theory. IEEE Transactions
on Systems, Man, and Cybernetics, Part C (Applications and Reviews), 35(4):522-532.

[Stirling and Frost, 2005] Stirling, W. and Frost, R. (2005). Social utility functions - part ii:
applications. IEEE Transactions on Systems, Man, and Cybernetics, Part C (Applications and
Reviews), 35(4):533-543.

[Tainter, 1988] Tainter, J. A. (1988). The Collapse of Complex Societies. Cambridge University
Press.

[Wang et al., 2014] Wang, R., Agarwal, S., and Dagli, C. H. (2014). Executable system of
systems architecture using opm in conjunction with colored petri net: A module for flex-
ible intelligent and learning architectures for system of systems. INCOSE International
Symposium, 24(s1):581-596.

[Weyns et al., 2005] Weyns, D., Van Dyke Parunak, H., Michel, E, Holvoet, T., and Ferber,
J. (2005). Environments for multiagent systems state-of-the-art and research challenges.
In Proceedings of the First International Conference on Environments for Multi-Agent Systems,
E4MAS’04, pages 1-47, Berlin, Heidelberg. Springer-Verlag.

[Zeigler et al., 2000] Zeigler, B., Praehofer, H., and Kim, T. (2000). Theory of Modeling and
Simulation: Integrating Discrete Event and Continuous Complex Dynamic Systems. Academic
Press.

202 Teddy Bouziat



